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Thank you for purchasing the MX100 Data Acquisition Unit.

This user’s manual contains useful information about the functions and operating
procedures of the MX100 Standard Software and lists the handling precautions of the
software. To ensure correct use, please read this manual thoroughly before beginning
operation.

After reading the manual, keep it in a convenient location for quick reference whenever a
question arises during operation.

The following five manuals relating to the MX100 Data Acquisition Unit (hereinafter the
“MX100”) are provided in addition to this one. Read them along with this manual.

The MX100 Data Acquisition Unit User’s Manual (IM MX100-01E), MX100 Data
Acquisition Unit Operation Guide (IM MX100-02E), and this manual (IM MX180-01E) are
all available on the MX100 Manual CD-ROM.

Manual Title Manual No. Description

MX100 Data Acquisition Unit User's  IM MX100-01E Describes the functions, installation, wiring

Manual procedures, handling precautions, and
other information about MX100.

MX100 Data Acquisition Unit IM MX100-02E Describes concisely the handling of the

Operation Guide MX100 and the basic operations of the
MX100 Standard Software.

Precautions on the Use of the IM MX100-71E Summarizes the usage precautions of the

MX100/MW100 Data Acquisition Unit MX100/MW100.

MX100/MW100 Data Acquisition Unit IM MX100-72E Describes concisely the installation and

Installation and Connection Guide wiring procedures of the MX100/MW100.

Control of pollution caused by IM MX100-91C Describes control of pollution caused by

MX100/MW100 products the product.

¢ This manual describes the MX100 Standard Software, release number “R3.01.”
You can check the release number by choosing About from the Help menu of
the Standard Software.

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the software’s performance and functions. The figures
given in this manual may differ from those that actually appear on your screen.

» Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

» This user’s manual does not cover the handling and operating procedures of
Windows.

» Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

+ DAQMASTER is a registered trademark of Yokogawa Electric Corporation.

* Microsoft and Windows are registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

+ Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

» The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and ™).

» 1st Edition:  May, 2003
« 2nd Edition: November, 2004
+ 3rd Edition:  February, 2008

All Rights Reserved, Copyright © 2003 Yokogawa Electric Corporation
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE

Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric
Corporation (hereinafter called “Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa
Software Program”).

By opening this package or plastic wrapping (hereinafter called “Package”) enclosing the Yokogawa Software Program, you acknowledge that you
understand and agree to the “Terms and Conditions of the Software License” (hereinafter called “Terms and Conditions”) which is written in the
documentation and separately attached. Accordingly, the Terms and Conditions bind you.

The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or
those third parties from whom sublicensed software in the Yokogawa Software Program is licensed.

Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions
before you open the Package and/or install it in or onto a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT OPEN THE PACKAGE, AND MUST IMMEDIATELY RETURN IT TO
YOKOGAWA OR ITS DESIGNATED PARTY.

Terms and Conditions of the Software License

Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program
(hereinafter caflled the “Licensed Software”) to the Licensee on the conditions that the Licensee agrees to the terms and conditions stipulated in
Article 1 hereof.

You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the
“Agreement”) based on the use intended for the Licensed Software.

Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event
shall Yokogawa intend to sell or transfer the Licensed Software to the Licensee.

Licensed Software Name: MX100 Standard Software (Model MX180)

Number of License: 1

Article 1 (Scope Covered by these Terms and Conditions)
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the

Licensee consents to agree to the terms and conditions stipulated herein.
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology,
algorithms, and know-how such as a factor, invariant or process contained therein.

Article 2 (Grant of License)
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the

license fee separately agreed upon by both parties.

2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitied to copy, change, sell, distribute, transfer, or sublicense the
Licensed Software.

2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes. The Licensee shall secure
or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.

2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may
translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed Software.
Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed Software.

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants
Yokogawa the rights. In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed Software.

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall the Licensee remove or attempt to remove such
copy protection.

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may
include any software program from affiliates of Yokogawa made or coded by themselves.) In the case that Yokogawa is granted permission
to sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions than those
stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in writing separately.

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software,
including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for

the purpose of the following events:
a) Operation of any aviation, vessel, or support of those operations from the ground;,
b) Operation of nuclear products and/or facilities;,
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or
d) Operation of medical instrumentation directly utilized for humankind or the human body.

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility
for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility,
to solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses,
damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims arising out of and
related to the above-said claims and damages.

Article 4 (Warranty)
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as

damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed
Software on condition that the defective Licensed Software shall be returned to Yokogawa'’s specified authorized service facility within seven
(7) days after opening the Package at the Licensee’s expense. As the Licensed Software is provided to the Licensee on an “as is” basis when
delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation, data on computer
programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms
and conditions that apply shall be those established by the provider of the third party software.
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Terms and Conditions of the Software License

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”).

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted
renovation or improvement of the Licensed Software.

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE,
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD
PARTY SOFTWARE TO YOKOGAWA.

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any
failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the
Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in warranty,
contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or arising out of
the use of the Licensed Software.

Article 5 (Infringement)
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed
Software, the Licensee shall notify Yokogawa in writing to that effect without delay.

5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate
with the claiming party. Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s
defense and negotiation. If and when such a claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the
preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s cost and expense and be
responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1.

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at
Yokogawa’s cost and expense.

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use
the Licensed Software;

b) To replace the Licensed Software with an alternative one which avoids the infringement; or

c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa
shall indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee.
THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY
SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT
LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)

6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided
to the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this
Agreement. However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage,
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue, loss
of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s business,
substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of Licensee or
other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the
extent of this Article 6, Yokogawa'’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee
which Yokogawa has received. Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement
if the Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic specifications or functional
specifications, without Yokogawa'’s prior written consent.

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless
Yokogawa is notified of the claim within one (1) year of its occurrence.

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between
the Licensee and its customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other
than those where Yokogawa permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa'’s thirty (30) days prior written notice
to the Licensee.

Article 9 (Injunction for Use)

During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems
that the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other
condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to
perform this Agreement. However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably
through negotiation between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one
of the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for
settlement of the dispute.

Article 12 (Governing Law)

This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely
and irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the
Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null
and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.
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Chapter 1

Before Using the Software

1.1

Functional Explanation of the MX100 Standard
Software

Functional Overview

The software can be used when the PC and the MX100 are connected in a one-to-one
configuration. To connect multiple MX100s to a PC, you need to use MXLOGGER, a
software program sold separately.

PC
MX100 Standard
Software
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MX100

MX100

|:|]E=' Ethernet port
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T .
Input/Output module  Main module

The MX100 Standard Software consists of the three software programs described below.
e Integration Monitor
Enables you to connect or disconnect the MX100, configure acquisition conditions and
display conditions of the measured data, set up computations, monitor measured and
computed data, save measured and computed data, and carry out other operations.

Jl=TE)
n A
W xovneny | Acquisiti R ST
] e Edt Ve Acauston Ackon_ e
Semen R
B st concten Ty ) B o L] B |
onmecor
ke ® = Mx100 Sta N —lof x|
12302891 O FredTin —
2 o Owe | Display
——————| [ Stop Concition|
@ cotrun|| w1
O it | o [t | i
) Fusdvor r
b o owa | MONIOr ity e ewe
O wan
B B oot [ Growpt |
Folder B o2 [
Ewes oo [J|| dl0me
B omos [
T Fwos o011 [
Mwos  oom2 [
Fossn || [Bvor oo [
v oms [
R @w oms [
Comment Ewio  oms [
Ewi oo [
Ressdy. e “
L E e—
ey
Ready 1 ) B

IM MX180-01E

11

alem)pog ay} Buisn alojeg H



1.1 Functional Explanation of the MX100 Standard Software

Integration Monitor

Viewer

Enables you to display measured and computed data that has been saved, read
values and perform statistical computation over an area using cursors, and convert
the measured and computed data into various file formats such as Excel.

6, ota =T
W) ie GOt Yen indon Comert ornston b lsix]
EH BB aea o EEEBE|S 2

Calibrator
Enables you to calibrate the MX100 input/output modules.

=

Fie View Help

P acires tHos e ] ] [

Mode!
el No

MAC Adiress

The main operations are carried out using the six windows shown below. If the MX100 is
not connected, the windows other than the Connection window cannot be displayed.

Connection screen

You can search for MX100s in the same segment, and connect to the target MX100.
You can also assign a machine name, IP address, subnet mask, and default gateway
to the detected MX100. Once a connection is established, the connection is made
automatically to the same MX100 the next time the Integration Monitor is started.

System setup screen

You can change the A/D integration time and check the main module information.
When the attached input/output module is changed, you can update the module
configuration information.

You can check the network setup information of the connected MX100.

You can format the CF card or check the free space on the CF card of the connected
MX100.

Acquisition setup screen

You can set the monitor interval of the measured data and the record start/stop
conditions. You can also set the save destination, file name, file division, and comment
of the recorded data.
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1.1 Functional Explanation of the MX100 Standard Software

Viewer

Calibrator

¢ Channel setup screen

For each measurement channel you can set: the input type, measurement range,
measurement span, and other measurement conditions; whether or not to assign

the channel for measurement/recording; the alarm output conditions, and the initial
balancing of the strain input modules. You can also set computations such as the four
arithmetical operations using the measured data (computation channel setting), set
the signal to be output from the digital output module (DO channel setting), set the
signal to be output from the analog output module (AO channel settings), and set the
signal to be output from the PWM output module (PWM channel settings).

Display setup screen

For each display group, you can set the channel to be displayed, display scale, display
zone, trip point (the value of interest in the waveform display), display color, and other
parameters.

Monitor screen

You can display the waveforms and numeric values of the measured/computed data,
change the display method, start/stop the recording of the measured/computed data,
pause the monitor, manually control the digital output, analog output, and PWM
output, and perform other operations. When the monitor is paused, you can display
the past data and read computed/measured values using cursors.

In addition to the operations described above, you can also save the setup data (project),
print a list of settings, and perform other operations from the menu.

You can load the measured/computed data that was saved in the past and carry out the
following operations.

Synchronization

When the data file is opened, the measurement time is corrected based on the time
information of the PC.

Waveform display/numeric display

Alarm/mark list display

Change the display conditions (group assignments, scale, trip point, display color and
other parameters)

Read values using cursors

Perform statistical computation over an area

Display and add marks

Print the waveform display and numeric value display

Save or load display conditions

Display the file information

Convert data formats (ASCII, Excel, and Lotus)

Printing data (waveforms, numeric values, alarm/mark list, cursor values, statistics
over an area, and computed values)

Use and save templates

You can connect to the MX100, display the modules that can be calibrated, and carry out
calibration of each measurement range and output range.
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1.2

System Requirements

OS (Operating System)

Run the software under any of the following operating systems.

*  Windows 2000 Professional SP4

* Windows XP Home Edition SP2

* Windows XP Professional SP2 (excluding Windows XP Professional x64 Edition)
* Windows Vista Home Premium (excluding the 64-bit edition)

» Windows Vista Business (excluding the 64-bit edition)

The language displayed by the software under different language versions of the OS are
as follows.

OS Language Software Display Language
English or other English
Japanese Japanese or English

PC

A PC that runs one of the OS above, and that meets the following CPU and memory
requirements.
* When Using Windows 2000 or Windows XP
CPU: Pentium I, 400 MHz or higher (Pentium Ill, 1 GHz or higher recommended)
Memory: 256 MB or more (512 MB or more recommended)
* When Using Windows Vista
CPU: Pentium 4, 3.0 GHz or higher
Memory: 1 GB or more (2 GB or more recommended)

Free Hard Disk Space and RPM
Free space: 50 MB or more (1 GB or more recommended)
RPM: 7200 rpm or faster recommended

Input Devices (Mouse, Keyboard, Etc.)
Input devices supported by the OS.

Display

* When Using Windows 2000 or Windows XP
A display supported by the OS capable of displaying in 1024 x 768 dpi resolution or
higher, and 65536 colors or more. (1280 x 1024 or higher recommended)

* When Using Windows Vista
A video card recommended for the OS, and a display supported by the OS with 1024
x 768 dot resolution or higher and capable of displaying 65536 colors or more.
(1280 x 1024 or higher recommended)

Ethernet Port
An Ethernet port compatible with the OS (10BASE-T or 100BASE-TX) required.
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1.3 Setup Procedures of the MX100 Standard
Software

The following procedures are for installing the software on Windows 2000 Professional.

1. Start Windows.
Log onto Windows as an administrator. (Otherwise, you will not be able to install the
software.) Also log on as an administrator when using Windows XP or Windows Vista.

When Auto Run Is Enabled

2. Insert the CD-ROM in the CD-ROM drive.
A screen for selecting the language opens.

3. Select the language you want to use.
The setup program automatically starts. Proceed to step 4.
When Auto Run Is Disabled

2. Double-click the CD-ROM icon from My Computer to open the CD-ROM drive
window.

3. Double-click the SETUP.EXE file in the DISK1 folder under English. The setup
program starts.

‘welcome to the k100 Standard Software Setup program.  This
program will ingtall k100 Standard Software on your computer.

It iz strongly recommended that pou exit all \Windows programs
befare nanning this Setup program.

Click. Cancel to quit Setup and then close any programs you have
running. Click Nexst to continue with the Setup program,

‘WARMIMG: Thiz program iz pratected by copyright law and
intemational reaties.

Unauthorized reproduction or distribution of this program, or any
partion of it, may result in severe civil and criminal penalties, and
will be prosecuted to the marimumn extent possible under law.

Irstallhield

< Back I Mext I Cancel |

4. Click Next. Read the Software License Agreement that appears. If you agree to
the terms, click Yes.

5. In the next dialog box, enter the name, company, and serial number, and click
Next.
The serial number is written on the label that is attached to the front of the case for the
MX100 Standard Software Setup CD-ROM.

User Information

Type paur name below. Y'au must alzo type the name of the
company you work far and the product serial number.

Mame: I

Company: thq

Serial [t

IrstallShield

< Back I Mest > I Cancel
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1.3 Setup Procedures of the MX100 Standard Software

6. After entering the destination, click the Next.
The default destination is C:\MX100 Standard. Change the destination as necessary.

IrnztallShield

Choose Destination Location ﬂ

Setup will inztall =100 Standard Software in the following
directory.

Toinstall to this directory, click Mest.

To install to a different directory, click Browse and select another
directory.

*f'ou can choose not to install k100 Standard S oftware by
clicking Cancel to exit Setup.

C:Abx<100 Standard Browse... |

" Drestination Directary

< Back I Mest > I Cancel |

7. Click Next to start the installation.

Select Program Folder

IrnztallShield

Setup will add program icons ta the Program Folder listed below.
“Y'ou may type a new folder name, or select one from the existing
Folders list. Click Mest to continue.

Program Folders:

Administrative Tools

DAQLOGGER

Light Meazurement D ata Management

L Operation Support System [L<055)

Microsoft Office Tools

Mational Instruments LI

< Back I Mest > I Cancel |

8. Click Finish to finish the installation.

Setup Complete

IrnztallShield

Setup has finished installing the application on your computer.

*r'ou may launch the application by selecting the icons installed.

Click Finizh to complete Setup.

< Back I Finizh I

1-6

IM MX180-01E



1.3 Setup Procedures of the MX100 Standard Software

Explanation

Installation Result

When the software program is installed properly, the folder MX100 Standard is created
in the specified directory (C:\ by default). MX100 Standard is registered in the program
list and MX100 Standard (referred to as the Integration Monitor in this operation guide),
MX100 Viewer, and MX100 Calibration are registered under it.

& MX100 Standard

J File  Edit View Favorites Tools  Help
J s Back v = - | Qhsearch [ Folders @“ﬁ Iz = @ | -

Address I@ IM:100 Standard

Mame # | Size | Type | Modified |
100 Calibration 1KE Shortcut 5/6/2003 7:53 PM
1KE Shortcut 5/6/2003 7:53 PM
1KE Shortcut 5/6/2003 7:53 PM

(5L M2100 Viewer

Nofte

* The Data, Work, and Conv folders are created within the MX100 Standard folder. Recording
files are saved in the Data folder. The Work folder is used as a temporary folder for saving
files created by the MX100 Standard Software, and must not be deleted.

* The Conv folder is created by the Historical Viewer. It is used as a temporary folder for
storing files used for file conversion, and must not be deleted.

IM MX180-01E
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1.4 Starting and Exiting Software Programs

Procedure

Starting the Software Programs

As shown in the figure below, click the Start button, point to Programs, point to MX100
Standard, and choose MX100 Standard (referred to as the Integration Monitor in this
manual), MX100 Viewer, or MX100 Calibration.

Microsoft PowerPoink
W Microsoft word
Acrobat Distiller 5.0
Adobe Acrobat 5.0
3 TA ISI Analysis 2

Mew Office Document

Open Office Document

N [ mx100 Calibration
ER m2100 Standard

Documents (), Mx100 Yiewer

Settings
Search

Help

I i start

| @ Search Results

e R -R=le)

| EggMx100 Standard

Exiting the Software
From the File menu, choose Exit.
The following figure shows an example of the Integration Monitor (MX100 Standard)

’ﬁ Edit Miew Acquisition Action H
Mew Chrl+M
Open... Chrl+O
Save Chrl+5
Save As...

Irnpork Tag...

Import Math Expression. ..
Import Math Constant. ..

Launch Data Wiswer

Print... Chrl+P
Print Preview
Prink Setup...

Recent File

EET—

Nofte
When exiting the MX100 Viewer, a dialog box confirming whether to save the display settings
opens if the display settings have been changed.

1-8
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Chapter 2  Integration Monitor

2.1 Connecting and Disconnecting the MX100

Before carrying out the procedure below, turn ON the power to the relevant MX100 and
connect the MX100. When connecting the MX100 for the first time, the MX100 and the
PC must be connected locally in a one-to-one configuration.

Notfte

Connecting the MX100 and the PC to a mission-critical network before an appropriate IP address
is assigned to the MX100 may adversely affect other connected devices on the network.

Connecting to an MX100 That Has Not Been Configured for the Network

1. Start the Integration Monitor according to the procedure given in section 1.4.
The Connection screen opens.
=lolx|

File Edt Wiew Acouistion Action Help

Ded|)Be|&)?

W/ 0ononon Connection
Connection Currently no Ms are connected.
CIRAES
IP Adldress, or Host Name | [ connect | [Disconnect |
[ t100s nearby
Search Edit netwark selup.
Please choose an MY from the search resulls.
Connect
Ready GlE & i3 2008101729 16:47.03

2. Click the Search button.
If an MX100 is found, icons appear in the frame containing the Search button for MX100s in
the same network segment.

@ px100 Standard i (=] 4|
File Edt Wiew Acouistion Action Help

Ded|)Be|&)?

W/ 0ononon Connection
Connection Currently no Ms are connected.
CIRAES
IP Adldress, or Host Name | [ connect | [Disconnect |

[ t100s nearby

| == | MX100 machine name [ Etrciwer e, |
g B8 B8
122222221 | (22222222 )——— Instrument number (NO.) written on the
. (F W=D name plate of the main module

| r:lame of PC connected to the MX100
Icon indicating connection by other software
Displays the icon of the MX100 in the same network segment

Nofte

* If multiple MX100s are connected in the same network segment, multiple icons appear
together with the corresponding instrument numbers (NO.).

»  When using Windows XP or Windows Vista with the firewall enabled, recognition is
sometimes not successful even when clicking the Search button. To solve the problem,
see appendix 1. (The same problem may also occur if your anti-virus software is using a
firewall.)

IM MX180-01E 21
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2.1 Connecting and Disconnecting the MX100

3. Click the MX100 icon that appeared.

In the box containing the Edit Network setup button, the icon and the initial network

information of the selected MX100 appear.

Even if you click the Connect button in this condition (with the initial IP address), connection

cannot be made.

& Mx100 Standard

File Edit Yiew Acquisition Action Help

=1olx]

Ded s 2@ 6%

¥ 0000000

Connection

Currently no Mis are connected.

W

P Address, or Host Name

[ conneet | [pizeonmect |

[ mx100s nearby

connestion ]

[CSeareh |
! E W¥100-Ho2
122222221 122222222
VI ‘l pe-01
|
Clicking here causes the
7-segment LED of the
corresponding MX100 to
display --CALL--

H Edit nstwork setup. |

C Default network information

Machine Name . |
P Address
Subnet Mask :

[12711.147
| 2552552550

Default Gateway : |0.0.0.0

EE TARTIT
Wersion R3.01
Serial Mo 122229021
Opirs: DS

MAC Address

00:00:54:64:81:93

Click the MX100 icon el
Software | deply || Canesl
Reacly o= i | 3‘ 2008101729 17.28:58

4. Click the Edit Network setup button.

The Machine Name, IP address, Subnet Mask, and Default Gateway items turn into text

boxes.

5. Refer to the explanations in this section and enter the required information in the

boxes.
The Apply and Cancel buttons appear.

6. Click Apply.

In the box containing the Edit Network setup button, the icon and the network information of
the MX100 disappear. At this moment, the 7-segment LED that has been configured turns

off for an instant.

Eclt nefwvork setup, L Click Edil network selup
! here !
Machine Name Machine Name: | M¥100-No1
P Address [ P Address 192881 1
Subnet Mask [255.255.255.0 Subnet Mask 255 255,255 0
Defautt Gateway . (0000 | — Detautt Gateway: |0.0.00
oclel 100 el W10 -
ersion: R300 ersion R201
erial Ko 1222020 erial o 122222221 ]
ptions: D3 plions: s
AC Address: 000064845193 AC Rdoess: 000064848183
ser ser
ottware aftware
I Appty | | cancel | ety || cancat

Click the Edit Network setup button to
change the display to input boxes
for the machine name

Enter the necessary information using
characters. Enter up to 64 characters

Edit network setup

Pleage chooge M from the search results.

[
When you click the Apply button
the icon and network information
disappear.

If the network setup does not work, the following screen appears.
* Invalid IP address setting + Invalid Subnet mask  * Invalid default

* Failed to change

* Failed to change

the combination of the IP address
and subnet mask is appropriate.

setting gateway setting settings settings
[Estraworsein |
H R 1P aderess is invalid 9 Subnet mask is invalid K Cateway address is invalid # Failzd to update R Search MHA00s nearby agsin.
Check whether the IP address Check whether the Check whether the Check if the MX100 is Repeat steps 2 through 6
setting is appropriate and whether  subnet mask setting  default gateway connected by another

is appropriate.

setting is appropriate. program or if the power

to the MX100 is OFF.

2-2
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2.1 Connecting and Disconnecting the MX100

7. Click the MX100 icon in the box containing the Search button.
In the box containing the Edit Network setup button, the icon and the network information of
the configured MX100 appear.

ST

File Edt Wew Acqusition Action Help

DEHE =R e 5
~—
[1']
1 «Q
Connection Currertly no M¥s are connected o
=
W o
P Asidress, or Host Name | [ conneet | [Disconnect | S
[ m100s nearhy g
]
S
-
waonho  [EE waon-vez  [EE o
122222221 122222222 i =
Machine Name © X1 00-Nod
| A o IP Address - 1921684 1
| . . Subnet Mask 2552552540
Click here Displayed with the Defaut Gateway: 0000
changes applied Wiodek T oD
Version R301
Serisl Mo 1222227
Options: s
MAC Address: O0:0064:84:61:93
User :
Software Connect
Ready [1=! B # Z005/01£30 103545

8. Click the Connect button in the box containing the Edit Network setup button.
If the MX100 is connected, the Monitor screen appears and measurement begins.

Ecfit network setup.
weioo-hot [ weioo-o2 [ !
122222221 122222222

Machine Mame: M100-Mol

A et IP Acress : 19241681
Subnet Mask 255,255.254.0
Defaut Gateway . 0.0.0.0
Model W¥100
Version R301
Serial Mo, 122222221
Options. s
MAC Address|  DD00.6484:1:93
User:

Software _ Click here

Monitor screen
=1l

File Edt WYew Acqustion Action Help

DeH|sBe|&|2

; ¢ ®E 0 ™ Q a2 lsl ) o] ow/ o)
M on |t0 r Record Stop Pause Mark Relay ACK
Group 1 ‘
J0msee @ & QIR NI ' B B o F || 1o CEC I e STk

Timme [Fim:

Readly o ] 2 B o= 200901/30120345
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2.1 Connecting and Disconnecting the MX100

Connecting to an MX100 That Has Been Configured for the Network

1.

Note

.

Start the Integration Monitor.

If the MX100 that was connected when the program was started the previous time is still
connected, a connection is automatically established with that MX100, the Monitor screen
opens, and measurement starts. To connect to another MX100, click Connection located at
the top section of the Monitor screen to show the Connection screen and click Disconnect.

In the IP Address or Host Name box on the Connection screen, enter the IP
address of the MX100 to which you wish to connect.

To connect using a host name, the host name must be registered in a DNS server (see the
explanation in this section) and the DNS server must be connected to the network.

Click the Connect button to the right of the IP Address or Host Name text box.
The Monitor screen opens.

= vxton sanaa REET

File Edt Wew Acqusition Action Help

DeE|sBe|&)2

i 0000000

Connection Currertly no Mis are connected

[

N
P Asidress, or Host Name [1192.133 14 1] chE&ct || Disconnect |
S

[ 1005 nearhy

L Enter the IP address of the desired MX100
and click the Connect button.

If the connection cannot be made for some reason such as when the MX100 is already
connected by another software program, the dialog box indicating that it is connecting
remains on the screen. If the MX100 that you are trying to connect to is in the same
segment, click Abort in the dialog box and then click Search to see if the MX100 is actually
connected to the network or if it is connected by another software program.

Connecting to 182 16811

Qo000

Cancel

If you changed the module configurations on the MX100 that you had connected before, a
dialog box with the message “Some detected modules do not match the current software
configuration. Rebuild based on the current MX hardware setup?” appears. If this happens,
carry out the procedure in the next section, 2.2, “Configuring the System, Setting the Write
Mode of the CF Card, and Formatting the CF Card.”

warning =

WS139
! 3y Some detected modules do not match the current software configuration. Rebuild based on the current MX hardware sstup?

If there is a record file that has not been finalized (data writing has not been completed) in
the previous connection, the finalization of the record file is carried out immediately after
startup. If this occurs, the progress of the finalization is displayed on the status bar (see
“Setting the Status Bar Display on the View Menu” in section 2.6).

IM MX180-01E



2.1 Connecting and Disconnecting the MX100

Changing the Network Configuration

1. With the MX100 icon and network information displayed in the box containing the
Edit Network setup button on the Connection screen, click the Edit Network setup

The Machine Name, IP address, Subnet Mask, and Default Gateway items turn into text

button.

boxes.
2.

boxes.

The Apply and Cancel buttons appear.
3. Click Apply.

Click Cancel to return to the original settings.

CIickI here

Iﬂ [t ndmbizaim, ] |

Machine Maime WK1 00-Mord

IP Address © 19216811
Subnet Mask 2552552550
Detautt Gateway . 0.0.0.0
Mincet X100
“ersion R301
Serial D : 122272271
MAC Address 0000 64.84.81:93
User :

Software

[ comnect |

A yellow mark is displayed if there is
a connected uselerlsoftware.

[ Edinetwork setup._| |

Machine Name: [M100-o1

IP Address © 19218811

SubnetMask: 2852552550 |
Defaut Gateway : [0.00.0
Mlel i
Version R301

Serial D : 122272271

MAC Address 0000 64.84.81:93
User :

Software

[ apoy || cancel |

* When the MX100 you wish to
configure is connected by
another software program

* When you attempt to change
the IP address while the
connection is established

[ttt |

# Failed to upciste

* When the message “Search
MX100s nearby again” appears.

| Eoit network setup. |

® Search Mx100s nearby again.

Refer to the explanations in this section and enter the required information in the

ﬁ [Eamtworissn ] |
Machine Maime WK1 00-Mord

IP Address © 19216811

Subnet Mask 2552552550

Detautt Gateway . 0.0.0.0

Mincet X100

“ersion R301

Serial D : 122272271

MAC Address 0000 64.84.81:93

User : ‘i po-02

Software M Calibration Software
| [ Cornect

|
Network setup cannot be changed
when there is another connected
software program

—<—{ When network setup does not work,

the following screen appears.

-

« Invalid IP address setting

* Invalid Subnet mask setting

it |

Check whether the IP address
setting is appropriate and whether
the combination of the IP address
and subnet mask is appropriate.

I address s invalid

\

B [itosweeiooti 1‘

Check whether the subnet mask
setting is appropriate.

3 Subnet mask is invalid

* Invalid default gateway setting

H [t |

Check whether the default gateway
setting is appropriate.

® Galeway address is invalid

Note

Enter network settings to avoid conflicts with other PCs. If network settings or searches are
performed on multiple PCs simultaneously, the operation may fail.

IM MX180-01E
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2.1 Connecting and Disconnecting the MX100

Disconnecting the MX100

1. Click Connection to show the Connection screen.

2. Click the Disconnect button to the right of the IP Address or Host Name text box.

: M¥100 Standard

ol x|
File Edit Wiew Acqusiion Action Help
= B8 7

®! 0000000

Monitor  Display  Channel

Connection The following M is connected
]

IP Addresz, or Host Mame

| [ cannest ||Dic0£§ecl
[ 1005 nearhy

When the connection is dropped, a message “Currently no MXs are connected”
appears at the top section of the screen. To reconnect, click Connect.

: Mx100 Standard

=101
File Edi Wew Acquisition Action Help

DeW & bR 6 ¢

W 0000000

Connection Curtently ne Wis are conneced.
(] w

P Address, or Host Name 18216811

| CDH:EH [Disconnect
[ t100s nearby

Creating a New Project and Connecting
Creating a New Project

Carry out the procedure below to discard current settings and create new setup data
(project).

1. From the File menu, click New.

A dialog box with the message “Cancel the current settings and create a new project?”
appears. To save the current setup data before creating a new project, click No and save
the setup data (project) (see “Saving Setup Data (Project)” in section 2.12).

2. Click Yes.

The Connection screen opens. If you click New while the MX100 is connected,
communication with the connected MX100 is disconnected.

& M¥100 Standard

warning ]
File Edit Wiew Acquisition Action H

) W5133
—_ . Cancel the current settings and creats a new projact?
Open... Chri+O
Save s 7 .

Save As..,

2 MX100 Standard

_iol x|
Fie Edit View Acquisition Action Help

D | 2 8|7
W 0000000 Connestion
Connection Curvertly no MXs sre cannected

[ e

IP Address, or Host Maime

| [ connect | [Disconnect

[ #1005 neary

Connecting after Creating a New Project

3. On the Connection screen, connect to the MX100.
(See “Connecting to an MX100 That Has Not Been Configured for the Network,” or
“Connecting to an MX100 That Has Been Configured for the Network,” in this section.)

2-6
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2.1 Connecting and Disconnecting the MX100

Explanation

Machine Name
To distinguish individual MX100s, you can enter a name that is easy to identify using up
to sixty-four characters (not required).

IP Address

Enter a new IP address to assign to the MX100. The default address is 127.1.1.XX (where
XX is a unique number for the device). This address cannot be used even when the

PC and the MX100 are connected in a one-to-one configuration. You must change to a
different address such as 192.168.1.XX (where XX is a value between 1 and 254). When
connecting the PC locally, do not set the PC to obtain the IP address automatically. Enter
the IP address manually to an address other than the one that is to be assigned to the
MX100 (192.168.1.100 if 192.168.1.1 was assigned to the MX100, for example).

Note

» To connect to the MX100 by entering a host name in the IP Address or Host Name box, the
host name (name used on the TCP/IP network) must be registered in a DNS server and the
DNS server must be connected to the network. However, the MX100 Standard Software
does not have a function for registering host names on the DNS server. For the procedure of

registering host names, consult your network administrator.

» Toinitialize all settings including the IP address to the their factory default values, see
“Initializing the Settings” in section 2.6 of the MX700 Data Acquisition Unit User’s Manual (IM
MX100-01E).

Subnet Mask

Enter the mask value used when determining the subnet network address from the IP
address. The default value is 255.255.255.0. When connecting to the PC locally in a one-
to-one configuration, this value does not need to be changed. In this case, set the subnet
mask on the PC to 255.255.255.0 as well.

Nofte

Huge TCP/IP networks such as the Internet are often divided up into smaller networks called

sub networks. The subnet mask is a 32 bit value that specifies the number of bits of the IP
address used to identify the network address. The portion other than the network address is
the host address that identifies individual computers on the network. Consult your network
administrator for the subnet mask value. You may not need to set the value.

Default Gateway

Set the IP address of the gateway (default gateway) used to communicate with other
networks. The default value is 0.0.0.0. When connecting to the PC locally in a one-to-one
configuration, this value does not need to be changed. In this case, you do not have to
set the default gateway on the PC.

Nofte

The default gateway is a router or computer that is used when accessing a computer outside its
own network. Consult your network administrator for the IP address of the default gateway.

IM MX180-01E
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2.1 Connecting and Disconnecting the MX100

Model
Displays MX100.

Option
Displays /DS or None.

Version

Firmware version number of the main module.

The version number shows the style number (before the decimal point) and revision
number (after the decimal point).

Serial ID
The instrument number (NO.) marked on the name plate of the main module.

MAC Address

Displays the MAC address that is assigned when the MX100 is shipped from the factory
(unique ID number for identifying the Ethernet card). The MAC address is marked on the
name plate on the main module.

Connected Users
Displays the computer name of the PC that is connected to the MX100. This item is blank
if there is no PC connected to it.

Software
Displays the name of the software program that is connected to the MX100. This item is
blank if there is no software program connected to it.

+ MX100 Standard: Integration Monitor of the MX100 Standard Software

* MX100 Calibrator: Calibrator of the MX100 Standard Software or
MXLOGGER (sold separately)

+ MXLOGGER: MXLOGGER (sold separately)

+ AP Software applications can be created using the MX100/

DARWIN API (sold separately)

2-8
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2.2 Configuring the System, Setting the Write Mode
of the CF Card, and Formatting the CF Card

Procedure

Reconfiguring the System
If you change the attachment positions or type of the input/output modules you must
carry out the procedure below.

Nofte

« If you change the MX100 input/output modules, a message, “Some detected modules do
not match the current software configuration. Rebuild based on the current MX hardware
setup?” appears when you start the Integration Monitor. Current configuration refers to the
module configuration (attachment positions and types of modules) that is detected by the
software. To match the current configuration with the actual module configuration (referred
to as reconfiguring the system), click Yes. If you reconfigure, the settings (measurement
conditions, etc.) of the modified modules are initialized. The reconfigured module
configuration can be confirmed on the System screen that appears by clicking System. If
you Click No, the connection is made without reconfiguration, and the module settings are
left unchanged.

e Turn OFF the power to the MX100 when attaching or detaching input/output modules.

1. Click System to show the System setup screen.

i x

File Edt Wiew Acouistion Action Help

Ded|)Be|&)?

® 0000000 Monitor  Display  Channel | Acdu

The following M¥ is connected.

Click here

2. Click the Actual Configuration tab followed by the Retrieve current configuration
button.
An X mark is displayed on the changed modules.

% MX100 Standard o =] 5
File Edt Yew Acquision Action Help
= B|E |7
i 000:00:00 Channel
System Click here
(W] Uit Setup (M) Module Arrangement
H Moidel M 00 Current Configuration
, etaen ekl LRecnnfigure based on actual contig. | 7
Serial Mo 12222224 Sl
s S || | L@ meerrounros
Temperature Unit e [+ ‘ L | mxttoUnvato
ADRLCEIONTIG [ata [=] L E mx115-005-H10
REspaiRe Creck: [ cheek | El mx1zsucho
3 The madule contiguration I currently different from the hix
Click here Changed modules
[ Module Arrangement W] Mool Arrancgment
Current Configuration ‘ Actusl Cdnfiguration | Mx100 Current Curlﬂglwalmn | Actual Configuration
4 — 30t | Retrieve current configuration |
—_— 122222221 '
| L I nwixi10-Uny-HO4 120123456 jD_S ‘ L[ mect10.UnvHOd 120123458
L H wisDosHio 12c303m —— [l Mx115-D05-HID
L B m10unv-io k | ——— B Wb i0Uvio 120303371
L——— E] mx125mucmi0 | chect | El M1 25-Mec-min
The x mark appears at slots where the module has been changed, and which are not operating
correctly.

IM MX180-01E 2-9
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2.2 Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card

3. Click the Current Configuration tab followed by the Reconfigure based on actual
config. button.

A dialog box with the message “Module settings which do not match the current software
configuration will be initialized.” appears.

Click here Click here

[ [vociule Arrangement (W] Module Arrangement

Current Configuration |I #ctual Configuration Currert Configuration | Actusl Cdnfiourafion |

| Retrieve currert configurtion. | W[ Reconfigure based on actual config. |
3

[ mctounv-Ho4 120123456 L@ werto-uny-Hos
L— | M115-005-H10

——— B mooUeMio 120303571
El t125-kc-in

El mx125-mec-wiin

Note

If the x mark remains even after reconfiguring the system numerous times, see the corrective
action described for “The connected input/output module is not detected” in section 5.1.

4. Click the OK button.
The current module configuration is matched to the actual configuration.

[ Mocule Arrangement

Curent Conficurationn | Actusl Configuration |

warnina £ ) (s e

WS5135
! Y Module settings which do nat match the current software configuration will be intialized, | —— |
Cancel

&1 t0110-Uiv-Hod

Kl 10i115-D05-H10

| 2 ELETTEYIL]

El 1x125-0KC-m10

Current module configuration

Setting the A/D Integration Time
1. Click System to show the System setup screen.
2. From the A/D Integration Time list box, select AUTO, 50 Hz, or 60 Hz.

=1

File Edt Wiew Acouistion Action Help

Ded|) B0 2

Manitor
System
[ Urit Setup (M Mocule Arrangement
Madel w100 Currert G on | actelc on |
Serial No 122222221

Dtion DS | ‘ L@ wstnonn Ho

Temperaturs Unit e [+ ‘
AID Integration Tims o -

Response Check

—— [ mx110-Unv-io
—— B mx115024-H10
El tx120-va0mos
Bl tx112-B35-m04
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2.2 Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card

MX100 Response Check

1. Click System to show the System setup screen.

2. Click the Execute button to the right of Response Check.
The 7-segment LED on the main module of the connected MX100 displays “--CALL--"

= vxton sanama Il

File Edt WYew Acqustion Action Help

DeH|sBe|&)2

0 Monitar

System
[ Unit Setup [ Module Arrangement
E Model MO0 Current Configurafion | Actual Configuration |
W Ra0t ’ e
a0 i | ” [ Retrieve current configuration. |
Serial Mo 122222221 | |
g e i1l ‘ L@ matounvros  12cizsase
empercture e c [=] —— [ MEOUNYMID 120123457
AID Integration Time ao v - E m15D024-H10
Response Check Excoute. | E] M120va0ME 120123056
7 B mxi12-B35M04 120123859
W Metwork Information . A mu2sMKemn
Click here 8
Mecaineame MHDOHGY [ Compact Flash Information | Upeete |
P Address 192.188.1 1
Status Exists(Usable)
Subnet Mask 255.255.255.0
MaX Size 488 MByte
Defaull Galeway 0000
Free Area 452 MByte
Part Mo 34318
Wirite Made Cyolic Mode
MAC Address 00.00:64:34:81 93 e
Format Execite
Ready 0El [l & B on 20080130 14,30.05

Setting the Write Mode and Formatting the CF Card

1. Click System to show the System setup screen.
2. Click the Update button to the right of Compact Flash Information.
The most recent status of the CF card that is inserted in the card slot is displayed.

Setting the Write Mode

3. To save the file repeatedly by deleting the old file when the there is no more free
space on the CF card, select the Cyclic Mode check box under Compact Flash
Information > Write mode.

To stop the save operation when there is no more free space, clear the check box.

Format

3. Click the Execute button to the right of Format under Compact Flash Information.
A confirmation message “Format Compact Flash?” appears.

Machine Name MRt [ Compact Flash Information — Displays the
I Acress L LT I
[ Status Exists(Usable) latest status
Subnet Mask 255255 255.0
e Size 438 Meyte
Detaut Gateway 0000 of the CF card
Free Area 452 MByte
Fart ho 34316
MAC Addd 00:00:64:54:61:93 e ade el Mo
ress (006484 61
(o — Formats the
Readly 0E (e £ Bh=c= 200801/30 14:3305 CF card

4. Click the OK button.
The message “Format was successful.” appears.

g Y x
W5136 i M5161
!3 Format Compact Flash? - J,) Format was successful.

Cancel
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2.2 Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card

Explanation

While the CF card is being formatted, the 7-segment LED of the main module
displays the following.

Items That Can Be Confirmed on the System Screen

Unit Setup

You can check the model, version, serial ID, option, temperature unit, and the A/D

integration time.

Module Arrangement

If you click the Current Configuration tab, the attachment conditions (attachment

positions and types) of the input/modules identified by the software are displayed.

If you click the Actual Configuration tab, the attachment conditions of the actual input/

output modules are displayed.

Network Information

You can check the machine name, IP address, subnet mask, default gateway, port

number, and MAC address.

Compact Flash Information

You can check the status, maximum size, and free area of the CF card inserted in the

card slot.

The CF card status indicates the following:

None: The CF card is not inserted in the slot.

Exists (Usable): The CF card is inserted in the slot and usable.

Exists (Unusable): The card is inserted in the slot but unusable due to reasons such
as an unformatted card, unsupported file system, or broken card.

Check the module information
Check the unit setup (system reconfiguration is possible)

& px100 Standard (=] 4
File Edt Wiew Acduistion Action Help

Ded|) o2

CR Montor Cisplay  Channel Aceuisi
System
[ Urit Setup (M Mocule Arrdroement
E Model MO0 Current Corffiguration | Actual Configuration |

W 301 ! o
oieion i | Refrieve current configuration. |
Serial Mo 122222221 | § i D
Diiion DS [ ‘ L@ oo ros  i2c1zdss
TeMmparatLe Unk ¢ [=] I MUIOUNID 120123457
A Integration Time AUTO \T|

—— B mx115024-H10
El mazovacmos 120123458
- B Mx112B35MI4 120123459

Response Check Execite |

(W] network Information ———————— B mzsmrcmin
Mactinetiame MHE0NG! [B cCompact Flash Infarmation | Upste |
P Address 1821681 1 =
Stetus Exists(Usahle)

Subnet Mask 2552552550
MAX Size 488 MByte

Default Gateway 0non
Free Area 452 MByte

Port Mo 34316
Wirite Mode Cyclic Mode

MAC Address 00:00:64:54:81:93 A
Format Execute

Ready o &l i Erd B == 2008/01/30 14:38:05
Check the network information Check the CF card information
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2.2 Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card

Setting the A/D Integral Time
When the measurement interval is one of the setting values in the table below, the A/D
integral time setting of the input module becomes active. The default setting is AUTO.
« AUTO
Automatically sets the A/D integral time to 50 Hz or 60 Hz according to the frequency
of the power supplied to the main module.
e 50 Hz
Sets the integral time to 20 ms.
* 60 Hz
Sets the integral time to 16.67 ms.

Measurement
Input Module Type Interval Setting
4-CH, High-Speed Universal Input Module (MX110-UNV-HO04) 50 ms
10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10) 500 ms
30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30) 1s
6-CH, Medium-Speed Four-Wire RTD Resistance Input Module 500 ms
(MX110-V4R-MO06)
4-CH, Medium-Speed Strain Input Module 200 ms

(MX112-B12-M04, MX112-B35-M04, and MX112-NDI-M04)

*  For the A/D integral times when setting other measurement intervals, see chapter 4,
“Specification” in the MX7100 Data Acquisition Unit User’s Manual’ (IM MX100-01E).

Setting the Write Mode of the CF Card

If the connection between the software and the MX100 is dropped while the measured/
computed data is being recorded (see section 2.7), the measured data is saved (backed
up ) to the CF card on the main module. If the Cyclic Mode check box is selected and
measured data is saved in backup mode, the data continues to be saved by deleting
the oldest data file when there is no more free space on the CF card. If the check box is
cleared, data saving stops when there is no more free space on the CF card.

IM MX180-01E
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2.3

Setting the Acquisition Conditions of the

Measured/Computed Data

Procedure

Setting the Monitor Interval and Record Interval of Measured Data

1.

Click Acquisition to show the Acquisition setup screen.

& Mx100 Standard

File Edt View Acquistion Action Help
DEd L Be a7

Acquisition Click here
Drag and drop the input module icon within the Measurement Group 1,
Measurement Group 2, or Measurement Group 3 frame.

Drag the input module with the same monitor interval to the same measurement group. Drag
the input modules that are not to make measurements to the Unused Modules frame. Only
the Monitor interval list boxes and the Rec. interval boxes of the measurement groups that
contain input modules are activated.

Drag and drop the icon of the input

Acquisition
module to a measurement group.

W Start Conditon
@ onRecord

[ msth Clesr on Start W rrtervsl Groups

() Ficed Time Unused Madules:

i ] : ————— .

[ Stop Condtion | Interval Group 1 @ 2
@ Continuous m

() FiedTime | 2000

I (8 Moritor Interval | =] @ res el %]

() Fixed Period I
Interval Group 2

) Math
W Fie £ —=

Folder W00 StandardiData |[E] (B Moritor Interval | v | @ rRec imerval x|

C: Fres Area 162 GByte intervel Groun 3

. N | -
File Name: | dta |

ekl Diate ekl Time f .

o o @ Moritor interval | | @ Rec.nterval x|

File Divigion @ MNone
Interval Graugp 4 (Math)

() Fixed Period

s {3 moritor Interval 100 msec @ Rec.marval x 1

Select the monitor interval (measurement interval) from the Monitor Interval list
box.

Enter the record interval (integer multiplication factor) in the Rec. Interval text box.

Select the monitor interval of each interval group
The selectable monitor interval varies depending on the types of
modules assigned to the same group and the measurement range.

Acquisition
[ Start Condton [] math Clear on Start W Interval Groups
@ onRecord T T T T T I
() Fied Tine A 1 [l I Unused Modules ‘
) Math e —
. . T
[ Stop Coneiton Interval Group 1 O]
@ Continuous | (5
Fixed Ti 11 =1 5] EEIEER v
1) reiedane — =l —[@ Monitor Interval | 100 meec vIt. Rec. Interval % 1 ]—
() Fixed Period = = = = —
Interval Group 2 (2] 5[0 ]
() Math
[ Fie - —
Folder M1 00 Standard Deta [D —[g Monitor Interval |200 mses |+ Iﬂ Rec. Interval x 1 ]—
C: Free Area 16.2 GByte Iterval Group 3 [ [
File Name | data |
Acd Dete Add Time = "
o o —[g Manitor Interval | - Iﬂ Rec. Interval =
Fille Divigion @ Mone
Interval Group 4 (Math)
() Fixed Period
ety 3 Manitor Interval 100 meec @ Rec. Interval x| 1

Set using an integer multiple of the monitor interval for each interval group (up to128).
The recording to the data file is carried out at (monitor interval x multiplication factor).
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2.3 Setting the Acquisition Conditions of the Measured/Computed Data

Setting the Record Interval of Computed Data

1. Click Acquisition to show the Acquisition setup screen.

2. Enter the record interval (integer multiplication factor) in the Rec. Interval text box.

W 0000000
Acquisition
[M Start Conditan [ mth Clesr on Start [ Interval Groups
(@ On Record
O reeatme [ zooa [ ap[is] [] =] = Unused Modules
() Math s =
W] Ston Coneltion Interval Group 1
@ Continuous
Fisced T) T r
8yt e i (3 Moritor Interval 100 msec |+ | (@ Rec. nterval
() FixedPerind | 0[] O[] N - i ; " )
Interval Group 2 (2] 5]
() Math
i 8
117 1
(] Fie 5
Folder M1 00 StandardiData [r_—‘ (3 Monitor Interval | 200 msec | = | (@ Rec. Interval x 1
C: Free Area 16.2 GByle hrieza i T T T
File Hame [aata
Addd Date Add Time T |
| | @ Moritor Interval | w | @ Recinterval %
File Division @ Mone
Interval Group 4 (Math)
() Fixed Period
Comment I g | [@ Moniter Interval 100 msec] [tl Rec.interval x| 1| ]

|

Set using an integer multiple of the monitor interval
for each computation group (up to128)

The recording to the data file is carried out at

(monitor interval x multiplication factor).

Automatically set to the minimum monitor interval of
the interval group with modules assigned or 100 ms,
whichever is less (cannot be changed).

Setting the Record Start and Stop Conditions and Resetting Computation
1. Click Acquisition to show the Acquisition setup screen.

2. Select On Record, Fixed Time, or Math under Start Condition.
If you select Fixed time, enter the start date/time.

3. Select Manual, Fixed Time, Fixed Period or Math under Stop Condition.
If you select Fixed time, enter the stop date/time.
If you select Fixed period, enter the record time.

Acquisition —— Select the record start condition

[ Start Conciton [[] Math clear on Start I_ Start recording |mmed|ate|y
O onRecore [ Start recording when the specified time is reached

® reeatne | 2ooy] YL T LBl — Start recording when the specified condition (see the
—@? “f‘“w explanation in this section) is met in the equation
p—
) continuous Record continuously (stop by pressing the Stop
) Fixed Time ——L button on the Monitor screen)
@ Fedrerion |00 [01] [00 —_l_ Stop recording when the specified time is reached
O matn 7 Stop after recording the time interval specified here

Stop recording when the specified condition (see the
explanation in this section) is met in the equation

Select the record stop condition

4. To reset the computed results at the same time recording is started, select the
Math Clear on Start check box.

Acquisition
W] start Coniton Math Clear on Starl
(") OnRecord g
@ Ficed Tims 2003 ][ 5| 7| [13] [o] [
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2.3 Setting the Acquisition Conditions of the Measured/Computed Data

Setting the Record File

1. Click Acquisition to show the Acquisition setup screen.

2. Enter the save destination of the file in the Folder box.
If you click the folder icon, the Browse for Folder dialog box opens, and you can select
the save destination folder. To do so, click the New Folder button, enter the folder name to
create a new folder within the save destination folder, and then set it as the save destination.

3. Enter the name of the record file in the File Name box.
To add the record date information to the specified file name, select the Add Date check
box. To add the record time information to the specified file name, select the Add Time check
box. If both check boxes are selected, both the record date and record time information are
added to the specified file name.
If a file with the same name already exists, a hyphen and a four-digit sequence number
starting with 0000 is added to the end of the file name.

4. To record the data by changing the file every specified time interval, choose Fixed
Period under File Division and enter the time.

5. To attach a comment to the file, enter the comment string in the Comment box.

H: M¥100 Standard

Fle Edt Wiew Acqustion Action Help

SEEIEEEAE

Acquisition Browse For Folder dialog box
Browse for Folder 21 x|
(W] Start Conditon [ Math Clear on Start o rete 2 o el
() onRecord :
@ Freamine | 2003}/ s 7 [13] ][] CH\MX100 StandardiData
O wath File save destination B Documents and Settings 2]
HPGLMAN
W stop Conarion To select the save destination kpens
O centinuous i the B! for Fold — MX100 Standard
O meatme [l 20 [EHEIE] rom the Browse for Folder Qo
@ Fised Period dialog box, click the folder i;:rna:‘v:rk
() Math icon. :rnqrar: F\\tas
W Fie Name of the record file B WINNT z
C_ Falder [cwat00 StandaraiData DIAED) L e voKoGAWA B
P—— ey Sele:ct the check box wh_en
v e Y. adding the record date/time  NewFolder..._ | ok | cancel |
C — ) ||_1format|on to the specified {
Feovsen () e file name Click and enter the folder name to create a
® reares @10 M) — The time when data is recorded to  neW folder within the save destination folder
Comment [ | a new file every specified time interval
. .
F—m E—— File comment (up to 127 characters)

Displayed in the file information dialog box*
that appears when printing data on Viewer

* Displayed by choosing Information > File Information in Viewer.

2-16

IM MX180-01E



2.3 Setting the Acquisition Conditions of the Measured/Computed Data

Explanation

Monitor Interval

Sets the measurement interval, monitor update interval, and alarm detection interval.
However, if the specified monitor interval is short, the data monitor update interval may
be slower depending on the PC environment.

If the monitor interval is set greater than or equal to two minutes, the Integration Monitor
acquires data from the MX100 at the specified interval, but the measurement interval and
alarm detection interval on the MX100 are one minute.

The input modules can be divided into three interval groups, and different monitor
intervals can be specified for each interval group.

Note

The shortest interval that you can specify for the monitor interval is the longest of the shortest
measurement intervals of all the input modules assigned to the same measurement group.
For example, if an input module with the shortest measurement interval of 10 ms and an input
module with 100 ms are assigned, 100 ms is the shortest interval that can be specified for the
group.

When saving backup data to the CF card, for monitor intervals of up to one minute, the data
is saved at the monitor interval, and for monitor intervals of two minutes or more, the data is
saved at one-minute intervals.

Record Interval of Measurement Channels
The record interval is the interval at which the data of measurement channels is saved to
a PC hard disk. It is set as an integer multiple of the monitor interval (up to x128).

Monitor Interval and Record Interval of Computation Channels

The monitor interval of computation channels is the minimum monitor interval of the
interval group or 100 ms, whichever is greater. The record interval is set as an integer
multiple of the monitor interval (up to x128).

Note

Computation channels are not saved to the CF card.

Record Start Condition

Select the start condition for saving the data of measurement/computation channels from

the following.

* On Record
Immediately starts recording when the Record button on the Monitor screen is clicked
or Record is chosen from the Acquisition menu.

* Fixed Time
Starts recording at the specified date/time. Set the date/time as “year/month/day/
hours:minutes:seconds” If the specified time has already been passed, the operation
is the same as On Record.

* Math
Starts recording when the StartRec() event function (see “Event Function” under
“Explanation” in section 2.5) is executed on a computation channel. This is valid when
you click the Record button on the Monitor screen (see section 2.7) and the word
“Waiting” is displayed.

IM MX180-01E

217

J10}luoy uonesbajul H



2.3 Setting the Acquisition Conditions of the Measured/Computed Data

Record Stop Condition

Select the condition for stopping the recording from the following:

e Continuous
Immediately stops recording when the Stop button on the Monitor screen is clicked or
Stop is chosen from the Acquisition menu.

* Fixed Time
Stops recording at the specified date/time. Set the date/time as “year/month/day/
hours:minutes:seconds” If the specified time has already been passed, the operation
is the same as Manual.

* Fixed Period
Stops recording after the specified time elapses after the recording is started. Set the
time as “hours:minutes:seconds”

e Math
Stops recording when the StopRec() event function (see “Event Function” under
“Explanation” in section 2.5) is executed on the computation channel.

Save Destination and Name of the Record File

Select the hard disk drive of your PC for the save destination. By default, the save
destination is the Data folder in the MX100 Standard folder where the MX100 Standard
Software is installed.

Nofte

Do not set the save destination to a storage medium other than the hard disk or to a network
drive. Doing so may cause problems in terms of performance.

The default file name is “data” If multiple files are created, the name is “data-XXXX"(where

XXXX is a four-digit sequence number starting with 0000). The extension is .mxd. You

can also add the file creation date and time to the file name as follows.

* When adding both the date and time: data-0224-1316 (recording started at 13 hours
and 16 minutes on February 24)

* When only the date is added: data-20080224 (recording started on February 24,
2008)

* When only the time is added: data-1319 (started recording at 13 hours 16 minutes)

If a file with the same name already exists, a hyphen and a four-digit sequence number

starting with 0000 is added to the end of the file name.

File Division of Record Files

The file can be divided every specified time interval. Set the time as “hours:minutes:
seconds”

Even if file division is not specified, the file is automatically divided when the size of a
single file exceeds approximately 1 GB or when the number of data points of any of the
channels in the file exceeds 2 million.

Number of Characters That Can Be Entered for the Comment of the
Record File
The maximum number of characters that can be entered is 127.

Selecting the Channel to Be Recorded
You can specify recording/no recording on individual channels. The settings are as
follows.
* Measurement channels: 2.4, “Setting the Measurement Conditions (Setting the
Measurement Channels)”
« Computation channels: 2.5, “Setting Computations (Setting the Computation
Channels)”
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2.4 Setting the Measurement Conditions (Setting
the Measurement Channels)

Procedure

Measurement channel tab Click here
1 x| | —oivi1eon of the attached modules

File E[it View Acqusiion Action Help

I

Point to the icon to display information

about the module
Click the icon to select the channels of

ion

15
5] | EINn B DR =
Chiannel ﬂ] l ﬂm m m H the module
Meas. Channel \l Math Channe! DO Channel AQ Channel Group o 2 (gray background and red characters)
i = - = = — |moduie o, 2
R TE P TR Record check box
Min Max Use  Dec.Pairt Min S A—
G R e —— T — = = — — Monitor check box
[ 00002 | TC [ frvper =] 0o 17s0.0 || [ =] [E
{00003 | RTD1 B = T o = = Select the input mode
{00004 | RRICTC) [ [[Type R =] 00 17600 || [ [=] E .
[00041 ] woLT 2y =] -2.0000 20000 || ] =] C i Changesi the Rang.e .S(.m.mg ?1nd
Bilere vor oy = ) 20000 || OO &= C others to its right are initialized
(00013 ] volt — [ffev =] -2.0000 20000 Il 7] -1 T |l
T oo v & S pp— o Select the measuremenlt range
{0005 ] wolT [y =] -2.0000 20000 || O] =] If changed, the Span settlng and
£CaniE] oLt P Ll -zooon 2000 ) [ Ll others to its right are initialized™!
]| toooi7) volt  [ffev =] -2.0000 20000 || [J =]
EmaiE] Sour (gl Elj om0 2000 0 = —— Minimum/Maximum value of span
{00018 | voLt [ flev =] -2.0000 20000 || [ [=] g
togpn @ vor | [lev [ 2000 2.0000 \ C1 [ S The Use check box for Scale™
(EEse=C T " v e ! —w—tl'l—"K =
ER = . = - =] Decimal point position of the scale™
Groug Na. 3Module No. Zhodule Tyte DiChannel count 10 0 B | & Ze B == 200803l

— Maximum/Minimum values of the scale™

I
When making the settings ~ Reset to default3  To copy™ *{ Excluding Tag No. and Tag comment
the same as the first item’ *2 Cannot be used when Mode is set to RRJC
Turn ON/OFF collectively™ *3 Applied to the selected range by dragging the cursor.

Applied to all lines if a range is not selected.

1. Click Channel to show the Channel setup screen.
2. Click Meas. Channel tab.

Setting the Measurement Channels for Recording and Monitoring
3. Select Record check boxes of the channels to record.

4. Select the Monitor check boxes of the channels to monitor.

Setting the Input Mode

5. Select the input mode from the Mode list box.

Setting the Measurement Range

6. Select the measurement range from the Range list box.

Setting the Measurement Span

7. Click the Min box or Max box under Span and enter the minimum or the maximum
value of the span.
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Setting the Scale (Only When Scaling)

8. Select the Use check boxes under Scale to enable changing of the scale.
9. Select the decimal point position from the Point list box for Scale.

10. Click the Min box or Max box under Scale and enter the minimum or the maximum
value of the scale.

11. Click the Unit box and enter the unit of the scaled value.

Setting the Reference Channel for Difference Input (Valid Only When Measuring
the Difference with Respect to the Measured Value of the Reference Channel)

12. Select the Use check box under Difference Input.

13. Select the reference channel for the difference input from the Ref. Ch. list box
under Delta.

Setting the Remote RJC Reference Channel (Valid Only When the Input Mode Is
Set to RRJC (TC)

14. Select the reference channel for the remote RJC from the Ref. Ch. list box under
RRJC.

Nofte

If moving from the Channel screen to the Display Setup or Monitor screen, if the differential

input reference channel or remote RJC reference channel setting is inappropriate the following

message appears.

Yes: Disable measurement channels with inappropriate settings (clear the Monitor check box in
the Channel screen) and move to the Display Setup or Monitor screen

No: Change the settings of the measurement channels with inappropriate settings without
moving to the next screen

Message

fwarning ]

WS134
! ! The current channel sebup conkains invalid use of reference channels,
Some mesurement channels set ko RRIC mode,

Do you wish to continus after disabling the invalid channels?

e Hoy

Setting the Time Constant of the First-Order Lag Filter (Valid Only When the
Input Mode Is Set to Something Other than DI)

15. Select the time constant from the Filter list box.

Setting the Burnout (Valid Only When the Input Mode Is Set to TC)
16. Select the direction in which the measured value is set off the range (+OVER or
—OVER) when a burnout occurs from the Burnout list box.
Setting the RJC (When the Input Mode Is Set to TC)
17. Click the Type box under RJC and select Internal or External.

18. If you select External, click the Volt box under RJC and enter the compensation
voltage.
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

= Mx100 Standard
File Edt Wiew Adouisition | Action Help

Check here to measure the difference input (difference with respect to
the measured value of the reference channel)*

Select the reference channel for difference input*

* Cannot be used when Mode is set to RRJC

Select the remote RJC reference channel (only when the input mode is set to RRJC (TC))

Enter the tag comment (up to 30 characters)
Set the time constant of the first-order lag filter

Unit (up to six characters, only when the Use check box of Scale is selected)
Enter the tag number (up to 15 characters)

(when the input mode is set to something other than DI)

Set the burnout (only when the input mode is
set to something other than DI)

Set the RJC (only when the input mode is

set to something other than DI)
=lgix]

Channel

Meas, Channel |

hannel |

pochantt || aochene| |

Crannel

-

Al

nnection 4]

Dgita RRIC RC A
Record Unit Tag No T4 Comment iter  PBurnout
e |Ref.Ch Ret. Ch Type wot{uv]
{00001 ] (oo [ E~ )(fracoooo ) ffagComment 00001 N6 B
tonooz] | |1 -] ] TayO0onz TagComment o002 o [Fflott [Ffrtema < o
roooo3) |1 =] =] Tag00003 TacComment 00003 o [~] = 4
rooood) | ] [=|foono [~} Tag00004 TagComment 00004 o [F)|ott [Ffrtemat <] 0l
rooot1] |1 =] =] Tag00011 TagComment 00011 o [~] = 4
rooor2] | O =] =] Tagn0012 TagComment 00012 o =] B 4
roomt3] | O =] =] Tagn0013 TagComment 00013 o =] B 4 |
roood) |1 =] =] Tag00014 TagComment 00014 o =] B 4 I
rooots) |1 =] =] Tag00015 TacComment 00015 o [~] = 4
rooote] |1 =] =] Tag00016 TagComment 00016 o =] B 4
rooot7) |1 =] =] Tag00017 TacComment 00017 o [~] = 4
rooote] |1 =] =] Tag00018 TagComment 00018 o =] B 4
rooots] |1 =] =] Tag00013 TacComment 00019 o [~] = 4
[nonnzn] % i EI . ) IEQDDDQE‘ ) [raacomment nnnzn” e [F = 4 ,
= = = = s - = = [ v
< —— o
Ready o= & = == 2008101601556:58

Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and
replace the current tag numbers and tag comments with the imported information.

From the File menu, choose Import Tag. Then, select an MX100 project file (a file with
the .mxp extension) in the Open dialog box to import the tag numbers and tag comments.

|File Edit ¥ew Acquisiion Action H
Ctri+h
cirlio
Ctri+s

New
open...
Save
Save As...

Tmport Math Exprastsgn...

Import Math Constant...

Launch Data Viewer

Print... Chrl+p
Print Preview

Print Setup. ..

1 NewPraject.mxp

Exit

open 2| ]
Look in: | 5 MX100 Standard =] - E e e
Fiename:  ([Frieelrrom D [zeen |
Files of type: [ M>x Prdject file(*.mip) | Carcel
oA

Select the MX100 project file (file with .mxp extension)
you wish to import

Note

When you carry out the procedure above, the tag numbers and tag comments of computation
channels are also imported.

IM MX180-01E

2-21

J10}luoy uonesbajul H



2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Set the type for alarms 1 to 4, the setting value,  Set the initial balance for strain input channels
and the hysteresis (see section 2.9) (only when the input mode is set to STR)

& pyx100 Standard (=] 4|
File Edt Wiew Acquistion Action Hsh

Moritor  Display  Chann
Elm E] Elm EE HE El
i
Meas, Channel | MethChonnel | | DOChonnel | AO Channel |
Alarm Alarm 4 Strain Adtion 4l
Record
Type Valus Hysterssis  Typs Valus Hysterssis  Iniial Balance Resel Status
[ roooz21) e [=] ot [=] I
O oeo2) o [2] o [ e |
O o) o [2] o [ [ e |
O coooze) o [2] o [ [ e |
O toeoss) o [2] o [ [ e |
O cooos) o [5] o [ [ e |
O ooy o [5] o [ [ e |
O cooo) o [2] o [ [ e |
O toeos) o [2] o [ [ e |
O o001 o [5] o [ [ e |
rooodt] ot [+] ot [+] | Execute |[ Execute | Success
[ooodz] ot [+] ot [+] | Execute |[ Execute | Success
roooda] ot [+] ot [+] | Execute |[ Execute | Success
ooona) o [7] ot [ | T e
2 ] ] ] ] 1 r J
= v
[
Ready 0@ il 2 B == 200801730 16:0507

Set the Initial Balance for Strain Input Channels (Only When the Input Mode Is
Set to STR)

19. Under Strain function, click the Execute button under Initial balance or Reset.
The Executing Initial balancing dialog box appears, and Executing is displayed in the Status
box. When execution is complete, the result is displayed in the Status box.

Now balancing...
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Note

* You can execute initial balancing and reset the initial balance value on multiple recording

channels at once by selecting the channels and clicking the collective execution button.

[00030]
[00041 ]
[00042 ]
[00043 ]
[00044 ]

off
off
off
off
off

= T |
&
B
B
1 ¢ [CExecue |[ Execute |-

® ®

v

Ll
L

I
Collective execution ON/OFF button

Drag and drop channels on which to perform initial balancing to select them
Selected channels are displayed with red characters against a gray background

» To execute initial balancing on a strain input module, you must finalize MX100 channel
settings and send them. If invalid channel settings are entered, a dialog box will appear

prompting you to correct the settings.

Message

[warning =

WS35
! " Inorder b balance the strain channels, I necessary for channels ko be set up cotrectly.
The current: channel setup contains invalid use of reference channels,

Some mesurement channels set bo RRIC mode,

Do you wish to continue after disabling the invalid channels?

| tio

Initializing, Copying, and Pasting of Settings on the Display Setup Screen
The procedures are the same as those for Initializing, Copying, and Pasting of Settings
on the Display Setup Screen described in section 2.6.
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Explanation

Input Mode and Measurement Range

On the channels of the input module, select from the modes below according to the input
signal. For details of the measurable range, measurement accuracy, and resolution, see
chapter 4, “Specification” in the MX700 Data Acquisition Unit User’s Manual (IM MX100-
01E).

VOLT (DC voltage)
Select the measurement range from 20 mV, 60 mV, 200 mV, 2 V (default), 6 V, 20 V,
or 100 V.

Note

Current input is possible by attaching a shunt resistor to the input terminal and converting to voltage
input. The shunt resistors in the table below are available for purchase separately. For example, a
250 Q shunt resistor is used to convert the signal in the range of 1 to 5 V for 4 to 20 mA input.

Part Name Model Resistance
Shunt resistor 415920 250 Q £0.1%
(for clamp terminal) 415921 100 Q +0.1%
415922 10Q+0.1%
Shunt resistor 438920 250 0Q+0.1%
(for screw terminal) 438921 100 Q £ 0.1%
438922 100+0.1%

TC (thermocouple), on the Universal Input Module and 30-CH, Medium-Speed
DCVITC/DI Input Module

Select the thermocouple type (referred to as Range in the setup) from Type-R (default),
Type-S, Type-B, Type-K, Type-E, Type-J, Type-T, Type-N, Type-W, Type-L, Type-U, or
KpvsAu7Fe.

RTD1 (resistance temperature detector, measured current: 1 mA), on the 4-CH,
High-Speed Universal Input Module

Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100,
HQ Pt100 (high resolution Pt100), HQ JPt100 (high-resolution JPt100), Ni100:SAMA,
Ni100:DIN, or Ni120.

RTD1 (resistance temperature detector, measured current of 1 mA), on the
10-CH, Medium-Speed Universal Input Module/6-CH, Medium-Speed Four-Wire
RTD Resistance Input Module

Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100,
HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Ni100:SAMA,
Ni100:DIN, Ni120, Pt50, Cu10:GE, Cu10:L&N, Cu10:WEED, Cu10:BAILEY, or J263B.

RTD2 (resistance temperature detector, measured current: 2 mA), on the 4-CH,
High-Speed Universal Input Module

Select the RTD type (referred to as Range in the setup) from Pt100 (default), JPt100,
HQ Pt100 (high-resolution Pt100), HQ JPt100 (high-resolution JPt100), Pt50, Cu10:
GE, Cu10:L&N, Cu10:WEED, Cu10:BAILEY, or J263B.

The RTD2 selection is not available on the 10-CH, Medium-Speed Universal Input
Module and the 6-CH, Medium-Speed Four-Wire RTD Resistance Input Module.

RTDEX (resistance temperature detector, measured current: 0.25 mA), on the
6-CH, Medium-Speed Four-Wire RTD Resistance Input Module

Select the RTD type (referred to as Range in the setup) from Pt500 (default setting) or
Pt1000.

OHM (resistance), on the 6-CH, Medium-Speed Four-Wire RTD Resistance Input
Module

Select a measurement range of 20 ohm (measured current: 1 mA), 200 ohm (measured
current: 1 mA), or 2 kohm (measured current: 0.25 mA).
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

DI (digital input), on the 10-CH, Medium-Speed Digital Input Module

Only the DI (digital input) setting is available for the input type. Select LEVEL (D10)
(voltage input) for -D05, or CONTACT (D10) (non-voltage contact input) for the
measurement range to match the input. For -D24, only LEVEL (24 V) is available.

DI (digital input), on the 4-CH, Medium-Speed Universal Input Module
Select LEVEL (voltage input) or CONTACT (HS) (non-voltage contact input) to match
the input.

DI (digital input), on the 10-CH, Medium-Speed Universal Input Module, 30-CH,
Medium-Speed DCV/TC/DI Input Module, 6-CH, Medium-Speed Four-Wire RTD
Resistance Input Module

Select LEVEL (voltage input) or CONTACT (SC) (non-voltage contact input) to match
the input.

STR (strain), on the 4-CH, Medium-Speed Strain Input Module
Select a measurement range of 2000 uSTR, 20000 uSTR (default), or 200000 uSTR.

RRJC (TC)

RRJC (TC) refers to temperature measurement using a thermocouple. Select a
channel when referring to the temperature of a relay terminal (the temperature input
of the relay terminal is specified at RRJC Ref. Ch.). When the item to be measured

is located at a great distance, you can setup relay terminals near the item to be
measured to make temperature measurements without having to use large quantities
of high-cost thermocouples. Connect the item to be measured and the relay terminal
using a thermocouple; connect the relay terminal and the MX100 using a copper wire.
By connecting one terminal of the MX100 and the relay terminal using a thermocouple
and measuring the temperature of the relay terminal, reference junction compensation
is carried out on the temperature measurement and the temperature measurement on

the item is made.

MX100 Relay terminal (to be furnished by the user)
Thermocouple* | Reference channel
> ]
_E Copper wire Thermocouple*
E ¢ e
2 o
5 Copper wire Thermocouple*
2 >

* Use the same type of thermocouples.

Setting the Measurement Span

Set the minimum and maximum values of the range that is actually measured within the

measurable range.

Setting the Scale
Set this item when linearly scaling the measured values. Set the scale by entering the
maximum and minimum values corresponding to the maximum and minimum values of

the measurement span and selecting the decimal point position of the scaled value (see

the figure below). The selectable range of the scale is —30000 to 30000. The decimal
point position can be set to 4 (X.XXXX), 3 (XX.XXX), 2 (XXX.XX), 1 (XXXX.X), or 0
(XXXXX).In addition, a unit can be assigned to the scaled value.

You can set the unit using up to six characters.

Scale maximum 100

|

Scale minimum 0 — 3 V]
Span minimum Span maximum

IM MX180-01E
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Setting the Reference Channel for Difference Input
Set this item when making the difference between the measured value of the channel
and the measured value of the reference channel the measured value (referred to as
difference computation). The reference channel can be set to a channel that is scaled.
Difference computation can be executed even if the measurement range of its own
channel and that of the reference channel are not the same.
If the decimal point position setting is different between its own channel and the reference
channel, the decimal point position of the measured value of the reference channel is
matched to that of its own channel, and the difference is computed.
Example: When the measured value of the channel set to difference input is 10.00 and
the measured value of the reference channel is 100.0
The computed result is 10.00 — 100.0 = —90.00.
Set the reference channel for difference input to a measurement channel that has the
Monitor check box selected.

Setting the Remote RJC Reference Channel (Valid Only When the Input

Mode Is Set to RRJC (TC)

This item sets the reference channel when the input mode is set to RRJC (TC).

Set the reference channel for remote RJC to a channel that meets the two conditions

below.

» The reference channel is a measurement channel (channel existing on the
measurement channel tab) with the Monitor check box selected.

» The range of the reference channel and that of the corresponding measurement
channel are the same.

Setting the Time Constant of the First-Order Lag Filter (Valid Only When

the Input Mode Is Set to Something Other than DI)

A first-order lag filter is available. Select a time constant N (time until 63.2% of the output
value is reached) from the Filter list box for the case when the measurement interval
(Monitor interval in the settings) is set to 1 s. Time constants when the measurement
interval is set to a value other than 1 s follow the equation below.

Time constant = measurement interval x N (where N = 5, 10, 20, 25, 40, 50, or 100)

The table below lists the relationship.

Measurement Selectable Time Constants (s)

Interval (s)

0.01 0.05 0.1 0.2 0.25 0.4 0.5 1
0.05 0.25 0.5 1 1.25 2 2.5

0.1 0.5 1 2 2.5 4 5 10
0.2 1 2 4 5 8 10 20
0.5 2.5 5 10 12.5 20 25 50

1 5 10 20 25 40 50 100
2 10 20 40 50 80 100 200
5 25 50 100 125 200 250 500
10 50 100 200 250 400 500 1000
20 100 200 400 500 800 1000 2000
30 150 300 600 750 1200 1500 3000
60 300 600 1200 1500 2400 3000 6000

Input
""" 63.2% of the output value

Output curve when
the filter is used

i Time constant in the table above
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Setting the Burnout

When the input mode is set to TC, you can set the burnout detection behavior. If set

to Up, the measured value is fixed to +OVER when a burnout is detected (condition in
which the input signal level exceeds the upper limit of the measurement range). If set to
Down, the measured value is fixed to +OVER (condition in which the input signal level
exceeds the lower limit of the measurement range). To not detect burnouts, select Off
(default).

Setting the RJC

When the input mode is TC, select whether to use the internal reference junction
compensation function of the input module or an external reference junction
compensation function. (This setting is possible when the input mode is set to a mode
other than DI, but the setting takes effect only when the mode is TC.) When using the
external reference junction compensation function, set an appropriate reference junction
compensation voltage (Volt in the setup) in the range of —20000 pV to 20000 pV. For
example, if the reference junction temperature of the external reference compensation is
To°C, set the reference compensation junction voltage to the thermoelectromotive force
of the 0°C reference of To°C.

Initial Balancing of Strain Input Channels (Initial Unbalance Value
Adjustment)

When configuring a bridge circuit with a strain gauge, the bridge circuit will not
necessarily be balanced even if the strain of the circuit under test is zero due to the slight
deviation in resistance of the strain gauge, and the measured value may not be zero (the
value in such cases is called the initial unbalanced value).

Therefore, when taking measurements you must first balance the bridge and, if the strain
is zero, obtain a measured value of zero. This is called initial balancing. (setting the initial
unbalanced value to zero).

Measured value

W Initial balance

Initial unbalanced value ———>¢

— Strain

With the MX100, initial balancing is performed in the 10000y strain range.

Initial balance: The value when the command is executed is set as the initial
unbalanced value, and the measured value is set to zero.

Reset: The value set during initial balancing is reset to zero. The initial
unbalanced value is used as-is for the measured value.

Nofte

If the measuring range is changed, the initial balancing is reset.
After a range change, you must redo initial balancing.
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

The results of initial balancing are as follows.

Status box display Status

----- Not executed

Successful Initial balancing was executed successfully.

Failed Initial balancing failed.

OVER Initial balancing succeeded, but the output value exceeded the upper

limit or fell below the lower limit, and the value was rounded to the
upper limit value or the lower limit value.
Executing Executing initial balancing

Note

If initial balancing fails, ,'_-'_—-, " is displayed in the 7-segment LED on the main module.
Check the installation status of the strain input module and perform the initial balancing again.

If the error occurs even after rebalancing, servicing is required. Please contact your nearest
Yokogawa representative.

Scaling Settings When Using a Strain Gauge Type Sensor

The following is an explanation of scaling settings used when measuring physical
quantities such as load and length with a strain gauge type sensor.

The basic relational expression is as follows.
1 mV/V = 2000 pstrain (Equation 1)

Two examples are given below: 1) when rated input and output are listed in the user’s
manual of the strain gauge type sensor, and 2) when listed with the calibration coefficient.
(hereinafter, “pstrain” will be expressed as “pStr.”)

When Rated Input and Rated Output Are Given
A specific example is given below.

+ Rated input 200N (settoY)

» Rated output 0.985 mV/V (set to K)

In this case, these figures indicate that if a 200 N load is applied, 0.985 mV/V is output.

From the relationship in equation 1, if 200 N is applied,
an output of 0.985 mV/V=0.985%x2000=1970 uSTR is attained.

In other words, for each 1 N, 1970 ySTR/200N= 9.85 uSTR/N is output.
Therefore, the scaling settings are entered as follows.

When Measuring at 50-150 N
Scale minimum: 50  (units: N) (set to Smin)
Scale maximum: 150 (units: N) (set to Smax)
therefore,

Span minimum: 50%9.85mSTR/N = 492.5 uSTR
Span maximum: 150x9.85 =1477.5 uSTR

...can be set.

Thus, the measuring range is 2000 uySTR.
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2.4 Setting the Measurement Conditions (Setting the Measurement Channels)

Generally, the range is as follows.
Using the symbols that have appeared in the explanation thus far, after setting the scale
maximum and minimum, the values are as follows.

Span minimum = [(K(mV/V) x 2000) / Y (unit)] x Smin (USTR)
Span maximum = [(K(mV/V) x 2000) / Y(unit)] x Smax (USTR)

When Listed at the Calibration Coefficient
An example is given with a displacement gauge.

» Rated input 20 mm

» Calibration coefficient 0.003998 mm / (1 pV/V)

Basically, if you can convert the calibration coefficient to the rated output mentioned in
“When Rated Input and Rated Output Are Listed,” the following is a calculation following
the explanation in “When Rated Input and Rated Output Are Given.”

Using equation 1,
1mV/V = 0.001mV/V = 0.001 x 2000 pSTR = 2 uSTR
therefore the rated output with this sensor when 20 mm is input would be

20 mm + 0.003998 mm / 2 ySTR] = 10005 uSTR

In other words, for each 1 mm, an output of
10005 uSTR / 20mm = 500.25 ySTR/mm

can be obtained.

Thereafter in the same manner, if you wish to measure with a scale of 2 mm to 15 mm,
the settings are:

Scale minimum: 2

Scale maximum: 15 (units: mm)
therefore,

Span minimum: 2 x 500.25 ySTR/mm = 1000.5 ySTR

Span maximum: 15 x 500.25 pSTR/mm = 7503.75 uSTR

...would be appropriate settings.

The measuring range becomes 20000 uySTR, making the resolution on the MX100 1
MSTR, therefore we can round as follows.

Span minimum: 1001 ySTR
Span maximum: 7504 uSTR

IM MX180-01E
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2.5 Setting Computations (Setting the Computation

Channels)

Procedure

Math Channel tab

File Edt Wew Acqusitil Action Help

Click here

D H| b Ri||[&2

L

hﬁ-

Channel wwmmmm
Meas Channsl | MathChannel || DOChannel | AGChannel |
e ~ Span & '|Z| Constart &
Dee. Poirt Win e -k Label Value
[ 99001 ] G =N -1o0.0000 100.0000 0.0000 sl
[ga002] s [=]] -100.0000 1000000 Il 00000 I
199003 ] PR | nonna
{9004 s [lff -woooo0 1000000 00000
[ 99005 ] s [=l|f -wooooe 1000000 00000
{9008 ] s [lff -woooo0 1000000 00000
[ 9007 ] s [=l|f -wooooe 1000000 00000
{8008 | J 41000000 100.0000 00000

@ Action Intervallsec] Onpenud[sec] oft- penw| sl
Timerl  Level 4 3600
Timer2  Off 4
Timerd  Off 4
= Z A
L] L]

D Calculate +Oweri-Over a5 the MAKMIN value of a range. Irterval of rate-of-change alarm ‘1 -

Ready 0E il

B =o= 200801/31 091552

1. Click Channel to show the Channel setup screen.
2. Click the Math Channel tab.

Minimize button

Record check box
Monitor check box

Enter the equation

(up to127 characters, not

case sensitive)

Equations that are appropriate are
isplayed in black Equations that are
inappropriate are displayed in peach
Specifies the decimal places for the
minimum/maximum value of span

Used for output channel scaling
and the initial value of the span for
the General Display screen.

Setting the Computation Channels for Recording and Monitoring

3. Select Record check boxes of the channels to record.

4. Select the Monitor check box of the channels to monitor.

Setting the Equation

5. Click the Expression box, and enter the expression.

Setting the Computation Span

6. Specify a number of digits in the Decimal Places list box for Span that is less than

or equal to that of the maximum and minimum values.

7. Click the Min box or Max box next to Span and enter the minimum or the
maximum value of the span.
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2.5 Setting Computations (Setting the Computation Channels)

: M¥100 Standard

File Edt Wew Acqusition Action Help

=10

DEHH@\El&\?

Monitar

[#
Channel E'ﬂ]] "‘ E'ﬂ]]] E"m “E 'ﬂm
Meas. Channel _‘ Math Channel DO Channel A0 Channel
Slarm 1 j =] Constant al
Record Unit Tag Mo. Tag Comment
Type Value Lakbel Valug ‘
{9001} Lz ronrommert oot Mo -1 C __nmel_ Epter the unit of the computed
[99002] Tag99n02 TagComment 99002 offt  [-] 0,0000
{sa003) ragesous TagCamment 39003 ot 2] 00000 value (up to 6 characters)
[ 199004 Tagaan04 TagCommert 99004 ot [=] 00000 i
[ [g2900s)] Tag9900s TagComment 99005 offt  [-] 0,0000 Enter the tag number
[ [agoos] Tagaon0s TagComment 99008 off -] 10,0000 (up to15 characters)
O rgoo07) Tag99007 TagComment 99007 offt  [-] 0,0000
O [EIEIUUB] ragssuus TagComment 99008 Jett [+ 0000 —— Enter the tag comment
-——‘——-h 2l | o
_ =] ] 3 v . e -
Enter the label for identifying
Action Intervaljsec]  On-period [sec]  Off-periodsec] & th tant
Timerl  Level 4 3600 0 0 e CO"§ an )
Tierz ot 1 Appropriate labels are displayed
s = o 1 in black Inappropriate labels are
3 3 3 S displayed in peach
[[] Calculste +vertover as the MAXMIN value of a range Interval of rate-of-change alarm |1 |- ]
Enter the constant value
Ready 0E il = B <o= 2008/01/31 031714

Note

Alarm settings
(see section 2.9)

Sixty computation channels are always shown.

Setting the Unit, Tag Number, and Tag Comment

8. Click the Unit, Tag No., and Tag Comment text box and enter the unit, tag number,
and tag comment, respectively.

Setting the User-Defined Constant

9. Click the Label box under Constant and enter a label for identifying the constant.

10. Click the Value box under Constant and enter the value of the constant.

Importing Equations

You can import saved expressions from a file. From the File menu, choose Import Math
Expression. Then, select an MX100 project file (a file with the .mxp extension) in the
Open dialog box. Only saved expressions can be imported.

. MX100 Standard oeen zlx]
Fie Edi Wew Acqustion Action H Lock i, [ FEA100 Storgerd 5] = @ ok

New Ctrlth

Open... ChrHO Data

Save cirlis wiork

Save hs... Projectdl. mxp

Import Ta. .

Import Math Ex 5

Trport Math Constant

Launch Diata Viewer

Print... P File name:— ({Proisct01 D [ oeen |

Prin Preview _ —— —

Print Setup. .. Files of type: | M Project (e[, mep] =l ancel y

A

1 NewProject.mxp

Exit

you wish to import

Select the MX100 project file (file with .mxp extension)
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2.5 Setting Computations (Setting the Computation Channels)

Importing Tag Numbers and Tag Comments
You can import just the tag numbers and tag comments from the saved setup data and
replace the current tag numbers and tag comments with the imported information. From
the File menu, choose Import Tag. Then, select an MX100 project file (a file with the .mxp
extension) in the Open dialog box to import the tag numbers and tag comments.

Importing User-Defined Constants
On the File menu click Import Tag, then select an MX100 project file (a file with an

|File Edit Wew Acquisiion Action H
New Ctri+h
Open... cirlio
Save Ctri+s

Save As..,

Import Tag. .
Import Math Expression...
Import Math Constart...

Launch Data Viewer

Prit.... kP
Print Freview
Print Setup. ..

1 NewPraject.mxp

Exit

Nofte

2lx|
Lok in: [ (23 Mi<100 Standard JE2 = s s
Data
work
Fie name:  ([Profectll ) [ o ]
Files of type: |24 Fhiect e[ mep) | Cancel |,
ZA

Select the MX100 project file (file with .mxp extension)
you wish to import

When you carry out the procedure above, the tag numbers and tag comments of measurement
channels are also imported.

.mxp extension) in the Open dialog box to import just the saved tag numbers and tag

comments.

- Mx100 Standard

File Edit Wiew Acquisition Action H
Met Chrl+h
Open... 0
Sawe Chrl+s
Save As...
Import Tag. .

Import Math Expression...

Import Math Constant...

Launch Data Viewer

Prit.... kP
Print Freview
Print Setup. ..

1 NewPraject.mxp

Exit

oeen 2| x]
Lok in: | 1 W10 Stardard =] & @ ok E-
File rame: — ([Proect0l D) | Tpen |
Files of type: | W< Rroject (e[, mep] =l Cameel y
A

Select the MX100 project file (file with .mxp extension)

you wish to import
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2.5 Setting Computations (Setting the Computation Channels)

Setting Timers (Only When Using Timers in the Computations)

11. Click Action for a timer and select Edge or Level.
When not using the timer, select Off (default).

12. Click the Interval box, and enter the interval.

13. If Action was set to Edge, click the On-period box and enter the time interval over
which the timer is to be turned ON. If Action was set to Level, click the On-period
or Off-period box and enter the time over which the timer is turned ON or OFF.

Action Intervallsec]  On-period [sec]  Off-periodlsec] &

B
Timer1 Ecge 3600} 0
Timer2 Level 3600} 0 o
Timer3 Ot
o 3 3 3 3 v

[1] calcuiate +cmgri-Over as tihe MM valus of & range.  Interdl of rate-of-changs slarm

R El = & P =o=  2008M01/31 051820
Minimize If Action is set to Level, enter the time interval over which
button the timer is OFF.

If Action is set to Edge or Level, enter the time interval over which
the timer is ON.

Set the timer interval

To use a timer in the computation, select Edge or Level
When not using the timer, select Off (default).

When Calculating *Overrange Values of Measurement Channels as the Maximum
and Minimum Values of the Measurement Range

14. Select the Calculate +Over/-Over as the MAX/MIN value of the measurement
range check box.

| Action Intervallsec]  On-period [sec]  Off-perioefsec] &
Timer1 Edge 4 3800 0
Timer2  Level 4 3600 0 0
Timer  Off 4
- o A

£} £} 3 3 v
Calculate +Over-Over as the MAXMIN value of a range ] Interval of rate-of-change alarm
Reat =] = & P =o=  2008M01/31 051820

Check here to calculate +Over and —-Over as maximum and minimum values of the measurement range

Resetting the Computations
From the Action menu, choose Math Clear.

= Mx100 Standard

File Edt Wiew Acquisiion | Action Help

DS M| 2| Relay ack Ctri+a
Insert a Mark Ctri+M
Mark Configuration ...

Channel

Manual DO 1 Cirk+1

Mess. Chennel | Meth € pianual Do) 2 Cirl42

Warua] D03 Girlt

Fecord Uit anuia] DO Gl
138001 ] w Enable to bransmit
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2.5 Setting Computations (Setting the Computation Channels)

Explanation

Computation Overview

You can enter computation equations using the constants, operators, and functions
described below. The computed results can be displayed and recorded (saved) as
computed data. Computation allows you to determine the average/maximum/minimum
of a specified channel on a specified date/time, or output events (start/stop record, reset
time, etc.) under specified conditions. The number of available computation channels is
60 (channel numbers 99001 to 99060), and the number of characters that can be used in
the equation is 127.

Constants
The following three types of constants can be used.
* User-defined constants
A constant can be assigned to an arbitrary string (name). You can set up to sixty user-
defined constants. Set the Name of the constant using a string (up to ten characters)
that is not used by predefined constants or functions. They are not case-sensitive.
The precision and range of the constant values are the same as the single-precision
floating point format (32 bits, negative values: —3.4028235E+38 to —1.401298E—45,
and positive values: 1.401298E—-45 to 3.4028235E+38).
* Predefined constants
The five strings below are used for predefined constants. They are not case-sensitive.
e NaN: Represents an invalid value or error value. For a description of the
computed result when NaN is used in the computation, see “Notes on
Computation” in this section.
e POver: Represents +Over (positive overrange). The expression POver > x is
satisfied for any arbitrary value x.
e MOver: Represents —Over (negative overrange). The expression MOver < x is
satisfied for any arbitrary value x.
o Pi Represents the ratio of the circumference (3.14...).
o € Represents the base of the natural logarithm (2.718...).
* Numeric constants
Numeric values that are written directly in the equation. They are expressed in the
following form.
[digits][.digits][{d|D|e|E}[digits]]
Example: 1.0d+1 represents 10.0.

Channel Numbers

Channel numbers can be used to specify the <channel> (measurement or computation
channels). The channel number is specified using five digits, the unit number in the
highest two digits and the channel number within the unit in the lowest three digits. On
the MX100 Standard Software, measurement channels are specified using 00001 to
00060 (1 to 60 are also allowed). Measurement channels are specified using 990001 to
99060.

Tag Numbers

Tag numbers can be used to specify the <channel> (measurement or computation
channels). The tag numbers are enclosed in double quotation marks as in “TagNo.00001”
They are case-sensitive.

Note

If the same tag number is specified on multiple channels, proper operation is not guaranteed.
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2.5 Setting Computations (Setting the Computation Channels)

Manual Output, and User Output (DO Channels, AO Channels, and PWM
Channels)

Specify an integer starting with 1. The arguments for the ManualDO() and ManualAO()
functions are as follows.

<ManualDONo.> 1-4

<ManualAONo.> 1

Operators

The operators listed below can be used.

Operator Description Example

+ Unary plus operator +ch(00010)

- Unary minus operator —ch(00010)

! Logical negation operator, 1 when 0 and 0 Ich(00010)
when non-zero

+ Addition ch(00010)+ch(00011)

- Subtraction ch(00010)—ch(00011)

* Multiplication ch(00010)*ch(00011)

/ Division ch(00010)/ch(00011)

% Remainder ch(1)%ch(2)<=1 ? AlarmAck() : 0

< Less than, 1 when the conditionis metand 0  ch(1) > ch(2) ? AlarmAck() : 0
when it is not

> Greater than, 1 when the condition is met and 0 ch(1) < ch(2) ? AlarmAck() : 0
when it is not

<= Less than or equal to, 1 when the conditionis  ch(00010)<=1.0 ? StartRec() : 0
met and 0 when it is not

>= Greater than or equal to, 1 when the condition  ch(00010)>=1.0 ? StartRec() : 0

is met and 0 when it is not
== Equal to, 1 when the condition is met and 0 ch(00010)==1.0 ? StartRec() : 0
when it is not

1= Not equal to, 1 when the condition is met and 0 ch(00010)!=0 ? StartRec() : 0
when it is not

&& Logical product ch(1) && ch(2)==1 ? AlarmAck() : 0
[l Logical sum ch(1) || ch(2)==1 ? AlarmAck() : 0
AR Exclusive OR ch(1) M ch(2)==1 ? AlarmAck() : 0
?: Conditional operator ch(00010)>=1.0 ? StartRec() : 0
(Write @ ? b : c to mean b if a is met and c if not met)
, Order operator Condition?(ResetTimer(), StartRec() : 0

The order of precedence of the operators is as follows.
+ — I (unary operators) < + —*/ % (arithmetic operators) « < > <= >= == |= (relational
operators) < && || M (logical operators) « ? (conditional operator) < ,(order operator)
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2.5 Setting Computations (Setting the Computation Channels)

Reference Functions and TLOG Functions

The function below are used to retrieve measured values and alarm values. The
functions are not case sensitive. For the format used to specify the <channel>, <alarm

level>, and <manual>, see “Procedure” in this section.

Function

Description

Example

ch(<channel>)

Returns the current value of the specified channel
(see “Channel Number” under “Explanation” in this

section)

ch(00001)/ch("Tag")

prech(<channel>)

Returns the previous value of the specified channel
(see “Channel Number” under “Explanation” in this

section)

prech(00001)/
prech("Tag")

alarm(<channel>,
<alarm level>)

Returns the alarm value of the specified channel and
specified alarm level, ON=1, OFF=0

alarm(00001,2)/
alarm("Tag",2)

alarm(<channel>)

Returns the alarm value of the specified channel,

ON=1, OFF=0

alarm(00001)/
alarm("Tag")

alarm()

Returns the alarm value of any channel,

ON=1, OFF=0

alarm()==1"?
StartRec() : 0

tlogmax(<channel>)

Returns the maximum value of the TLOG computation
of the specified channel

tlogmax(00001)/
tlogmax("Tag")

tlogmin(<channel>)

Returns the minimum value of the TLOG computation
of the specified channel

tlogmin(00001)/
tlogmin("Tag")

tlogpp(<channel>)

Returns the (maximum value — minimum value) of
the TLOG computation of the specified channel

tlogpp(00001)/
tlogpp("Tag")

tlogsum(<channel>)

Returns the sum of the TLOG computation of the

specified channel

tlogsum(00001)/
tlogsum("Tag")

tlogave(<channel>)

Returns the average value of the TLOG computation
of the specified channel

tlogave(00001)/
tlogave("Tag")

ManualDO Returns the values being output on the specified ManualDO(1)
(<manual>) ManualDO.

ManualAO Returns the values being output on an user output ManualAO(1)
(<manual>) channel.

*1 The TLOG computation computes the maximum, minimum, maximum-minimum, sum, and
average values of the specified channel. If the TLOG function is present in the equation, the
computation is executed

*2 The reference function or TLOG function returns NaN in the following cases.

*  When the data to be referenced by the CH function or PRECH function does not exist
(when disconnected or immediately after starting the monitor operation)
* When the specified channel does not exist or when the specified alarm level is not 1, 2, 3,

or4.

e |If the MX100 returns an INVALID value

*3 Select the behavior taken when the value of the measurement channel is +Over from the

following:

» Continue the calculation as +Over (behavior when the check box is not selected)
» Continue the calculation by setting +Over to the maximum or minimum value of the

measurement range of the specified channel.

The selection is made using the Calculate +Over/—Over as the MAX/MIN value of a range

check box.

2-36

IM MX180-01E



2.5 Setting Computations (Setting the Computation Channels)

Arithmetic Functions

Below are the arithmetic functions that are available. They are not case-sensitive.

Function

Description

Example

sin(<value>)

Returns the sine of the <value>

sin(ch("TagNo.00001"))

cos(<value>)

Returns the cosine of the <value>

cos(ch("TagNo.00001"))

tan(<value>)

Returns the tangent of the <value>

tan(ch("TagNo.00001"))

asin(<value>)

Inverse sine

asin(ch("TagNo.00001")

acos(<value>)

Inverse cosine

acos(ch("TagNo.00001"))

sinh(<value>)

Hyperbolic sine

sinh(ch("TagNo.00001"))

cosh(<value>)

Hyperbolic cosine

cosh(ch("TagNo.00001"))

tanh(<value>)

Hyperbolic tangent

tanh(ch("TagNo.00001"))

pow(<value 1>, <value 2>)  <value 1> to the power of <value 2> pow(ch(1),ch(2))
sqrt(<value>) Square root sqrt(ch(1))
logE(<value>) Natural logarithm logE(ch(1))
log10(<value>) Common logarithm log10(ch(1))
expE(<value>) e to the power of <value> expE(ch(1))
exp10(<value>) 10 to the power of <value> exp10(ch(1))
abs(<value>) Absolute value abs(ch(1))
max(<value>,......,<value>)  Maximum value among multiple max(ch(1),ch(2),ch(3))
specified values
min(<value>,...,<value>) Minimum value among multiple min(ch(1),ch(2),ch(3))
specified values
pp(<value>,...,<value>) (Maximum — minimum) among multiple pp(ch(1),ch(2),ch(3))
specified values
sum(<value>,...,<value>) Sum of multiple specified values sum(ch(1),ch(2),ch(3))
ave(<value>,...,<value>) Average of multiple specified values ave(ch(1),ch(2),ch(3))
poly(<x>,<a0><a1>,...,<an>) Polynomial with variable parameters poly(ch(1),ch(2),ch(3))
Calculates aOxn+a1xn—1+...+anx0
ceil(<value>) Returns the minimum integer greater ceil(ch(1))
than <value>
floor(<value>) Returns the maximum integer less floor(ch(1))

than <value>

limit(<x>,<a>,)

If x is outside the range defined by a and b,

round the value to a or b.

limit(ch(1),10,20)

rnd()

Returns a random number between 0 and 1

ch(1)*rnd()

IsNaN(<value>)

Returns 1 if \value is NaN or 0 if it is not.

IsNaN(ch(1))
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2.5 Setting Computations (Setting the Computation Channels)

Time Functions

The table below shows the functions related to time. The functions are not case sensitive.
Only integer numeric constants can be written in the function parameters <year>,
<month>, <day>, <hours>, and <minutes> in the table below. The terminology used in

the description in the table are defined below.
Edge:
relative time.

Returns 1.0 for computation immediately after the specified absolute or

Previous edge: Returns 1.0 for computation immediately before the specified absolute or

relative time.
Level:

* Selectable range of parameters

Returns 1.0 during the specified absolute time or relative time.

<years>: 1970 to 2036

<month>: 1to 12 (1: January, 2: February, ..., 12: December)

<day>: 1 to 31

<week day>: 0 to 6 (0: Sunday, 1: Monday, ..., 6: Saturday)

<hours>: 0to 23

<minutes>: 0 to 59
Function Description Example
time(<year>,<month>,<day> <hours>,<minutes>) Edge operation on the date/time time(2003,6,3,9,53) ? StartRec() : 0
bfTime(<year>,<month>,<day>,<hours>,<minutes>)  Previous edge operation bfTime(2003,6,3,9,3) ?

on the date/time

StartRec() : 0

time(<year A>,<month A>,<day A>,<hours A>,
<minutes A>,<year B>,<month B>,<day B>,
<hours B>,<minutes B>)

Level operation between
date/time Aand B

time(2003,6,3,8,53,2003,6,3,9,13) ?
sum(ch(1),ch(2),ch(3)) : 0

monthly(<day>,<hours>,<minutes>) Edge operation every month on

the specified day, hour, and minute.

monthly(3,9,53) ? StartRec() : 0

bfMonthly(<day>,<hours>,<minutes>) Previous edge operation every
month on the specified day,

hour, and minute.

bfMonthly(3,9,53) ? StartRec() : 0

monthly(<day A>,<hours A>,<minutes A>,
<day B>,<hours B>,<minutes B>)

Level operation between the
specified day, hour, and minute of
A to the specified day, hour, and
minute of B every month

monthly(3,9,3,4,9,3) ? StartRec() : 0

weekly(<week day>,<hours>,<minutes>) Edge operation every week on the

specified week day, hour, and minute.

weekly(3,9,53) ? StartRec() : 0

bfweekly(<week day>,<hours>,<minutes>) Previous edge operation every
week on the specified week day,

hour, and minute.

bfWeekly(3,9,53) ? StartRec() : 0

weekly(<week day A>,<hours A>,<minutes A>,
<week day B>,<hours B>,<minutes B>)

Level operation between the

specified week day, hour, and

minute of A to the specified week

day, hour, and minute of B every week.

weekly(10,00,11,05) ?
sum(ch(1),ch(2),ch(3)): 0

daily(<hours>,<minutes>) Edge operation at the specified hour

and minute every day

daily(10,00) ? StartRec() : 0

bfdaily(<hours>,<minutes>) Previous edge operation at the

specified hour and minute every day

dfDaily(10,00) ? StartRec() : 0

daily(<hours A>,<minutes A>,<hours B>,<minutes B>) Level operation between time
Aand B

daily(10,00,11,05) ? sum(ch(1),
ch(2),ch(3)): 0

hourly(<minutes>) Edge operation at the specified

minute every hour

hourly(30) ? StartRec() : 0

bfhourly(<minutes>) Previous edge operation at the

specified minute every hour

bfHourly(30) ? StartRec() : 0

hourly(<minutes A>,<minutes B>) Level operation between

minute A and B every hour

hourly(10,20) ?
sum(ch(1),ch(2),ch(3)): 0

timer(<timerNo>) Returns the status of the specified

timer

timer(1)==1.0 ? StartRec() : 0
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¢ Timer (<timerNo>)

Up to eight timers can be specified. The timer is specified using a number between 1

and 8.

Select the timer operation from the choices below. Select Off to disable the timer.

Edge: Returns 1.0 when performing computation after the ON time elapses after the
beginning of each interval. Specify the interval for detecting the condition and
the ON time in ms.

Level: Returns 1.0 from the time after the ON time elapses until after the OFF time
elapses. Specify the interval for detecting the condition, ON time, and OFF
time.

The selectable range of the interval for detecting the condition is 1 s to 86400000 s =

1000 days. The ON/OFF time is specified using the elapsed time from the beginning

of the interval.

Timer Level Operation

* When ON < OFF

\ Interval \ Interval \
E Returns 1.0 : Returns 1.0 :
' -~ ! -~ !
| | ! | | i | -t
T U 1 T U 1 T
1 ON OFF 1 ON OFF 1
ON setting E<—> E E
OFF setting <——> : ;
* When ON > OFF
\ Interval i Interval \
Returhs 1.0 : ! Returhs 1.0 ; ; Returhs 1.0
] t
. OFF ON | OFF ON |

ON setting <———>

OFF setting :<—>:
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2.5 Setting Computations (Setting the Computation Channels)

Event Functions

A function used to carry out a given operation (event). They are not case-sensitive. They
are mainly used in conjunction with the conditional operator (?). The return values are
indicated below. The event is actually executed after the computation is complete.

» Execution successful: 1.0

» Execution failure: 0.0

* Invalid parameter: NaN

Function Description Example

AlarmAck() Issue an alarm acknowledge ch(1)>ch(2) ? AlarmAck() : 0
ResetMath() Reset the computation ch(00010)>=1.0 ? ResetMath() : 0
ResetTimer() Reset the values of all timers ch(00010)>=1.0 ? ResetTimer() : 0
ResetTimer(<timerNo>) Reset the specified timer ch(00010)>=1.0 ? ResetTimer(1) : 0
ResetTLog() Reset the TLOG computation ch(00010)>=1.0 ? ResetTLog() : 0
StartRec() Start recording ch(00010)>=1.0 ? StartRec() : 0

Valid after carrying out the
record start procedure.
Discarded if the recording is
already stopped (returns 1.0).
SplitRec() Move to the next record file ch(00010)>=1.0 ? SplitRec() : 0
Valid after carrying out the
record start procedure.
StopRec() Stop recording ch (00010) >=0 ? StopRec() : 0
Valid after carrying out the
record start procedure.
Discarded if the recording is
already started (returns 1.0).
Mark("mark") Create a mark. The text inside ch (00010) >=0 ? Mark("mark") : 0
the double quotation marks is
arbitrary.

+ If the spacing between the execution of StopRec() and StartRec() is short, StartRec()
may not be executed. When repeating start/stop frequently, consider using the Split
function.

» The computed result at the time record start is executed is not necessary recorded to
the file.
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Notes on Computation

The equation is not case sensitive. The exception is tag numbers specified on the
Channel setup screen.

The precision and range of computed values are the same as data in single-precision
floating point format.

The sampling interval of the computed channel is 100 ms to 10 min.

Measured value used in computations

The measured value with the closest time is used among the measured values
existing at the time of computation. Resampling of the measured value or interpolation
are not performed while computation is being executed.

Example 1:

If the measured values indicated by O and @ exist and computation indicated by

M is performed, the measured value indicated by @ on each channel is used. If the
measured value does not exist such as in Ch 5, NaN is used as the measured value.

Ch1 : O O O @ O O O O :Dpataattimet
Ch2 :0 O O (] O O O O : Data near time t
Ch3 0 @ : NaN

Ch4 : ® O :Oldestdata
Ch5s : : NaN

Computation : O O O [ |

Measured value used in
the computation of ll
Example 2:
If the disconnection (disconnected after x) is detected, NaN is used as the measured
value of Ch 3.

Ch1 : O O O @ O O O X :Dpataattimet
Ch2 O O O e o O O X :Data near time t
Ch3 HOREED : NaN

Ch4 : ® X :Oldestdata
Ch5s : : NaN
Computation: [1 [ O N t t

Measured value used in
the computation of [l
Alarm values used in computations
Basically handled the same as measured values except the behavior differs in the
following two cases.
* When the alarm value does not exist (Ch 5 in example 1 above)
Always returns 0 (no alarm).
*  When the communication is cut off (Ch 3 in example 2 above)
Always returns the most-recent value.
Syntax error and execution error
» Syntax error
Equations containing items that are inappropriate are indicated in peach when the
equation is being entered. If monitoring is started without correcting the equation,
they are ignored.
» Execution error
Execution errors are detected after starting the execution. Below are the two cases.
NaN is returned as the result in either case.
*  When the reference destination does not exist when monitoring is started
» When the computed result is undefined.
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2.5 Setting Computations (Setting the Computation Channels)

Handling of NaN values
* Inthe case of a TLOG function (tlogmax, tlogmin, tlogpp, tlogsum, and tlogave)
If NaN exists in the channel values, it is handled as though the value did not exist.
* In the case of the IsNan() function
This function can determine whether the value is NaN.
» NaN is ignored for the functions min, max, sum, ave, and pp.
« The value of NaN is considered true for the &&, ||, **, and ! operators.
» For all other computations
Computation is performed taking NaN as a value. Thus, NaN is returned as the
computed result.
» The numeric value display on the Monitor screen displays INVALID.
Handling when the value of a measurement channel is +tOver (exceeding the upper
and lower limits of the measurement range)
If the measured value used in the reference function or TLOG function is +Over,
computation continues in one of two ways. Select the handling method using the

Calculate +Over/-Over as the MAX/MIN value of a range check box.

Continue the computation as +Over.

Continue the calculation by setting +Over to the maximum or minimum value of the
measurement range of the specified channel.

Use the following values as the maximum and minimum value of the measurement

range.
« DC voltage: +10% of the range
Example: 6 V range
+OVER: +6.6 V
—-OVER: 6.6 V

« Temperature: £10°C of the rated measurement range
However, 0 K and 10 K for KpVsAu7Fe and J263B.
 Linear scaling: Maximum and minimum values of the scale corresponding to +10%
of the measurement span
However, £32000 when the scale value exceeds +£32000.
Example 1: When the measurement span is set to £1 V and the scale is set to
+10000 at 2 V range
+OVER: +22000
—-OVER: -22000
Example 2: When the measurement span is set to £2 V and the scale is set to
+30000 at 2 V range
+OVER: +32000
—-OVER: -32000

To suppress +Over from occurring in an arbitrary computation, use the limit function (see
“Arithmetic Functions” under “Explanation” in this section).

Alarms for computation using the Alarm() function

The alarm corresponding to the current value is used for the alarm of a measurement
channel.

The alarm corresponding to the current value is used for the alarm of a computation
channel. However, for computation channels that have not yet computed the current
value, the alarm corresponding to the previous value is used.

Setting the Computation Span
This section provides an explanation of the span of transmission output for the analog
output and PWM output modules.
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Procedure

Procedure

Changing the Display Settings on the Display Setup Screen

Click here
—prrT——— o —mx— Restore the default maximum and minimum
File Edit Wiew Acquisition Action Help va'ues of the entire sca]e
DeE|BE(§ 7 . .
l (& - — Number of channels assigned automatically
s —— | Execute automatic channel assignment
— Switch the display group
Group 1 | G2 | crow3 | Groupa | crows Group 6 | crow? D)
- Group name
Group Name (| Groun 1 D;
rl = — Display ON/OFF
Mo Channel Y-Axis Format e s e e Trip1 Channel select button
[#lam oooot || [4] Linear 4] (20000 200 o 10) 1 20000\ O] i .
Flwoz  ooooe || e = L o s e Turn scale ON/OFF when displaying
[7|wos  oooos || [#] Linear ﬂ 2.0000 2.0000f 1} 100 1 2.oo00| O] multi-axes zone
[r|wms  oooos [ [#] Linear il 2.0000 2.0000f 1} 100 1 2.0000| ] .
[Flaos oot [o] [ e |4] = e I — Select the Y-axis type (linear/logarithmic)
[#|woe ooz || [#] Linear dl 20000 2.0000f i} 100 [} 2.0000| ] 20000 . .
[elenr  ooma || [7] Urear [4] 2.0000 2.0000} [i] 100[|_| 2.0000| | 2.0000 || —— Select the d|5P|ay format of the Y-axis
[lwoe e [ [5] Linear [4] 20000 2.0000] 0 100 [] 20000| O] 20000 ] (normal/exponent)
[elwns  ooms [ [=] Linear ﬂ 2.0000 2.0000f 1} 100] 1 2.0000| O] 2.0000 . L.
[ ooms  [Cf[¥] Linear |4] 20000 20000} [ 100] || Zo000| ] 20000 l —— Maximum/Minimum value of the scale
O on UG YU (oo ooy o olt] | ool —smaesle | isplay zone position
Y = = = = o . . .
E IR = L e™ i [ L Turn ON/OFF the trip point display
e ‘= m 7 & onsrapanean Trip point

Channel display color
1. Click Display to show the Display setup screen.

2. Change the display settings according to the explanation is the figure below.
Set the display for each display group. You can set up to ten display groups.

Initializing, Copying, and Pasting of Settings on the Display Setup Screen

On the Display Setup Screen, you can reset the settings to default or copy and pate the
settings of one or multiple waveforms to the settings of other waveforms. You can copy
and paste according to the procedure below.

Click the copy source waveform number (No. column), choose Copy from the Edit menu,
click the copy destination waveform number, and choose Paste from the Edit menu.

Drag to select the range
Slelect all channels

Channel Vedxis  Format seae zone Trip1 Trip 2 Color
hin Wiax Win e

o000t [2] [ Linesr 4] 20000 20000 i 10 [ 20000 [] 20000 (IR

00002 [ ] Linesr 4] 20000 20000 i 10 [ 20000 ] -2.0000 [

ooo03  [.] [ Linear ﬂ 20000 2.0000 i] 1m0 [ 20000 [] -2.0000

00004 [ ] [ Linear ﬂ 2.0000 2.0000 ] 100 [ 20000 [ -2.0000

00011 [-] [#] Linear ﬂ 2.0000 2.0000 ] 100 [ 20000 [ -2.0000

ooz [ Linesr ﬂ 2.0000 2.0000 i} 100 [] 20000 [] -2.0000

00013 [ [ Linesr 4] 20000 20000 i 10 [ 20000 ] -2.0000 (B

oomd  [.] [ Linear ﬂ 20000 2.0000 i] 1m0 [ 20000 [] -2.0000

0oms [ [ Linear ﬂ 2.0000 2.0000 ] 100 [ 20000 [ -2.0000

00016 [-] [#] Linear ﬂ 2.0000 2.0000 ] 100 [ 20000 [ -2.0000

00017 [2] [7] Linesr 4] 20000 i 10 [ 20000 [] -2.0000 (I
= A - P [

Restore the default setting
Copy first item to rest of selection
Assign channels automatically

All ON or OFF

Do not copy
Select to copy
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2.6 Displaying the Monitor and Setting the Display Procedure

Displaying the Monitor Screen and Settings on the Monitor Screen

1. Click Monitor to show

the Monitor screen.

2. Change the display settings according to the explanation is the figure below.
If the channels of different interval groups or channels of computation groups are assigned

to the same display group, a monitor is displayed for each interval group or computation
group (see the figure below).

@ MX100 Standard
Fie Edt View Acqustion Action Help

Click here

— Switch to waveform, numeric, or

De M|y =06

waveform and numeric display

Add a mark

Monitor 1 |
Record  Stop Pause Wark Felay ACK
Group 1 Grop2 )

(cannot be used when paused)

| somsec @S/ MM MM & Hoo | F| oomse

[13e2 @@/ Iy Hoo|E

Switch the display group
— Switch the Y-axis channel
— Y-axis scale

— Channel number and
measurement unit

— Zoom in or out of the time axis

Switch the display zone

Switch the thickness of the
displayed waveform

— Turn ON/OFF the waveform
display limit (clip)

— Change the grid density

Ready 0 i}

= B == 2008001/31 12:20:38

Change the background darkness

Note

Turn ON/OFF the waveform display

You can switch the screen to waveform display, numerical display, or waveform and numerical

display.

Setting the Status Bar Display on the View Menu

1. Click View to open the View menu.

2. Select the item to be shown or hidden.
ltems that have check marks are shown.
Description of the status bar
(ltreate file Disk space (lzommunication status Current time

& M¥100 Standard

File Edit | View Acquisition Action F

O & |+ channel =

Tag Na.

N J\

(2uuaﬂusn 4091750 )

Tag Comment

Erase Cursar:
Mon_

v Toolar
Gro.  Status Bar

100mze ¥ Current Time
¥ Communication Status
v Disk Space
v Fila

Note

display the remaining space as a
percentage)

Number of data files created

Displays the data rateusing
a bar (Move the cursor here
to display the data rate in

Communication status
=== : Connected
=i%= : Disconnected

bytes/second) Monitor/Record status
Displays the remaining disk space © : Monitoring
using a bar (Move the cursor here to © : Recording

*3 : Data dropout occurred

—Write status

Displays the remaining time until the next & : Writing
file is created using a bar (Move the cursor & : Write error
here to display the remaining time as a value)

If there is a record file that has not been finalized (data writing has not been completed) in
the previous connection, the finalization of the record file is carried out immediately upon
establishing the connection. If this occurs, the progress of the finalization is displayed on
the status bar. The number of remaining data files is indicated between the Communication
performance and Write status. If there are none, the bar is not displayed.
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Explanation

Display Groups and Group Names
On the Monitor screen, the channels are divided into groups and displayed using
waveforms or numerical values. The measured/computed values can be divided into

up to ten groups. Up to thirty-two channels can be registered to a single group. The
channels that can be registered are those where the Monitor check boxes are selected
in the Channel setup screen. When you click a channel selection button on the Display
setup screen, the channel numbers of the channels that can be registered are displayed
(see the figure below).

pelection E

Channel | TagMo. | TegCommert |

Mone
00001 00002 00003 00004
00011 00012 00013 00014
00015 00016 00017 00013
00019 00020 00041 00042
00043 00044

To turn ON/OFF the waveform display on the Monitor screen, click the light-blue button
below the scale bar as shown in the figure below.

Hide the waveform

You can enter a group name using up to thirty characters. By default, group names
Group 01 to Group 10 are assigned. The names of the display groups that have channels
registered are displayed on the Monitor screen.

Group 1 | Group 2 | Group 3 | Group 4 |

oamsee @] QMR MM B oo 8[mmne: BRSHMN"YEHoo|s
___ e ___l

Y-Axis Type
You can select linear or logarithmic scale for the Y-axis when displaying the waveforms.

Linear scale Logarithmic scale

IM MX180-01E
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2.6 Displaying the Monitor and Setting the Display Procedure

Maximum and Minimum Values of the Y-Axis and the Display Format of the
Scale Values

Specify the maximum and minimum values of the Y-axis scale. The scale values can also
be displayed using logarithmic format as shown below.

Min et
-2.0000E3 2.0000E3 —_—

Format

Select the exponential format

Selecting the Display Zone of the Waveform
You can select from the following. In the Zone setting on the Display setup screen,
assume the bottom and top edges of the waveform display area to be 0% and 100%,
respectively, and set the waveform display position by specifying the minimum value (0
to 99%) and the maximum value (1 to 100%).
* User zone
Displays each waveform at the position specified by Zone on the Display setup
screen. A single Y-axis scale of the active waveform can be displayed.

Select user zone
Set the display zone Displays the active Y-axis scale

|
PEC ORI EEEIE

Fone

Indicates the active Y-axis

Click the bar to select the active Y-axis scale

* Edit zone
Like the user zone, each waveform is displayed at the position specified by Zone on
the Display setup screen. However, you can change the zone on the Monitor screen.
A single Y-axis scale of the active waveform can be displayed.

Select edit zone

@ & e I.Im EISEEIE:
@ Drag the knob to change the minimum/maximum
value of the zone separately
0

f

Drag the bar to change the zone position without
changing the zone width

* Full zone
Displays all the waveforms over the full zone of the waveform display area regardless
of the Zone settings on the Display setup screen. A single Y-axis scale of the active
waveform can be displayed.

Select full zone

@@ai m

i Heo s

aveform display area
(Full zone)
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Slide zone

Displays the waveforms by slightly offsetting the display position of each waveform
vertically regardless of the Zone settings on the Display setup screen. A single Y-axis
scale of the active waveform can be displayed.

Select slide zone

@(®E W K M)W & Hoo| s

Slide in this manner

Auto zone

Displays the waveforms by dividing the waveform display area evenly according to the
number of displayed waveforms regardless of the Zone settings on the Display setup
screen.

Select auto zone

|
EE T NCHEEEIE

Divide evenly automatically

Multi-axis zone

All the Y-axes of the displayed waveforms are aligned horizontally. To hide a Y-axis
scale, clear the Y-Axis check box on the Display setup screen. The display zone is set
to the position specified by Zone on the Display setup screen.

Select multi-axes zone

Mo Channel -ods HECEN LN EICISESIE

Wil o000l [ [#] Linear
w2 o000z [(C)Linear
wos o003 [ [[] Linear
wos ooons [ [[] Linear

Indicates the active Y-axis

[SN=NCNSN

Click the bar to move the active

Y-axis to the left end
Turn OFF the

Y-axis of
Ch00002

The scale of Ch00002
is not displayed
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2.6 Displaying the Monitor and Setting the Display Procedure

Trip Point

You can display a trip line to indicate a particular value of interest (trip point) in the
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each
waveform. The trip line of the waveform corresponding to the left-most Y-axis is shown in
the waveform display area.

Trip 1 value  Trip 2 value Trip 2 value

Trip line
/P

Trip Trip e (= ® R MME/im'm e E-c s
OCCo@EHCCmm  —
2 Z 0 2
2 20 2
Turn ON the trip
line display

Trip 1 value

Channel Color
Clicking the channel color displayed in the Color column on the Display setup screen
opens the Color dialog box. You can select the color of each channel using the Color
dialog box. To create custom colors, click the Define Custom Colors button in the Color
dialog box.

2|

Basic colors:

mil_fml | I
Simimicisl 1 1 |
EEEEEE N

C I

Custom colors:
) )
)

Define Custom Colars > |

oK. I Cancel

Clipping of Waveforms

By default (clip OFF), the waveform is not displayed when the measured/computed value
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip
is turned ON, values that are smaller than the minimum value of the scale are displayed
as the minimum value and the values that are larger than the maximum value of the
scale are displayed as the maximum value.

Clip OFF Clip ON

T

Expanding or Reducing the Time Axis on the Waveform Display

On the waveform display, you can click the expand/reduce icon to expand or reduce
the time axis for each waveform display area. The maximum magnification is x20. The
minimum magnification varies depending on the size of the waveform display area.

Time axis expand/reduce icon

Toomess ©|m1 ITETIEEEIE
r

Magnification

2-48

IM MX180-01E



2.6 Displaying the Monitor and Setting the Display Procedure

Adding Marks

You can display marks in the waveform display area (see the figure below). You can
enter a text to be attached to the mark (“Mark” by default) using up to fifteen characters.
Click the Mark button or choose Mark Configuration from the Action menu. You can enter
the text in the dialog box that opens.

Up to 200 marks can be displayed. When 200 is exceeded, the marks are erased from
the oldest ones. However, if the data is being recorded, the marks are saved to the
record file.

Mark setup dialog box Mark Text of the specified mark
Mk £

[are ——— Enter the text to be
[~ Inserts a mark without showing this dialog box displayed as a mark

L If this check box is selected, the mark is placed without
displaying the dialog box when you choose Put a Mark : e e
from the Action menu.

Nofte

Marks cannot be placed when the monitor update is paused.

Numeric Display
You can switch from the waveform display to numeric display as shown below.

Switch the display group
lnjx . .
Fls Edt View A|wistion Acton Hel ——— Switch to waveform, numeric, or

waveform and numeric display

1] L] Q

Pause  Mark Relay ACK

Channel number

L Channel displaycolor

— Level indication with respect to
the scale width

— Numeric display
) Unit

Ready. ] a B == 200801731 140322

Waveform and Numeric Display

Switch the display group
I ol
Fle Edit View Ac|uistion Action Help . .
Ded|y[ee? — Switch to waveform, numeric, or
W Wontor_Dispay _ Channel waveform and numeric display

u 1] L ]

Record  Stop  Pause  Mak  Relay ACK

Monitor

S ] _omwz )

00001

Charnel Value A YaleB  ValeB-

a|

00001 111} 14207 [l 0358 i
Il 10041 Il 0108 v

d

N\

00002

—— Change the display area

When paused, you can drag to change the
display area of the digital and waveform
displays.

& =HoO T W]

Z

Resdy B == 20080131 140518

Numeric display screen Waveform display screen
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2.7 Starting and Stopping the Recording of
Measured/Computed Data

Procedure

Record Start Operation

Click the Record button on the Monitor screen, or choose Record from the Acquisition

menu.

% 1100 Standard -lojx]
File Edit Wiew Acquisition Action Help File Edit Wiew | dcquisition Action
DEH 4 Ee(8 T or

W 000:00:3 Moritor  Displat

Stop

X o I 5 . |
Monitor RE.M S:p o M:k o] Monitol—222)_
. Choose
Ready 1E = P B =os 20030507 16:5%17 |
Click

When recording starts, the display changes as shown in the figure below. To divide the
file during recording, click the Manual Save button or choose Manual Save from the
Acquisition menu.

Changes to red when recording starts

Elapsed time of recording

=

flle  Edit |¥iew Acquisition Action Help File Edit iew | Acquisition Action

== I ILET iR
s
u Workor | Displ y
i [ [ ] 1] ] 3 I
o Sop  Pase  Mark Monitol_f2 ,
Choose
Ready r|E = = Erf@g 20030507 16:53:35 ‘

When dividing files Changes to red when recording starts

Record

or

Channel

While the Start Condition specified on the Acquisition setup screen is not met, the word
“Waiting"appears under the Record button (see figure below).

W MX100 Standard ] 3]
Fle Edt Yiew Acquistion Action Help

SEEIEEE e

W 0000000 Moitor  Display  Channel Acquistion System

B m nN ™ ek

weatng Stop Pause Mark

Monitor

Nofte
Clicking the Record or Stop buttons repetitively at short intervals or clicking the Manual Save
button many times may hinder the measurement operation and file division process.

Record Stop Operation

To stop recording when Stop Condition specified on the Acquisition screen is set to
Manual or before the stop condition is met, click the Stop button on the Monitor screen or
choose Stop from the Acquisition menu.

File Edit Wiew Acquisition Action Help File Edit WView | Acquisition Action
DM EE6] 2 = =

Monitor  Display  Channel Acquistion System

. | | B . |
Mon Itor Msm:\’sava 5:p Palulse M:k JJJ Mon Ito£
Choose

Click
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2.7 Starting and Stopping the Recording of Measured/Computed Data

Explanation

When you click the Stop button on the Monitor screen or choose Stop from the
Acquisition menu, a dialog box shown below opens.

[warning |
) WS5137
. Stop Record?
Cancel

Click OK. When you click OK, the word “Saving”appears below the Stop button until the
recording stops.

Start/Stop Recording

Data is recorded according to the Start condition and Stop condition specified on the
Acquisition setup screen. Recording starts immediately when you click the Record button
only when Start condition is set to On Record. For all other settings, the detection of
whether the start condition is met is started when you click the Record button.

Note

» The creation of the data file starts after the recording is stopped. Therefore, it may take time
for the data save operation to complete.

* You cannot exit the software if the saving of the data is not complete. If you attempt to do
so, a dialog box with the message “Writing data files Currently” opens. At the same time, the
number of remaining record files to be finalized is indicated on the status bar (see section
2.6, “Setting the Status Bar Display on the View Menu.”). The software closes when this
indication clears.

» If the record file cannot be created at the specified destination, the file is created in the Data
folder in the directory where the MX100 Standard Software is installed.

*  You can click the arrow button shown in the figure below to reduce the size of the display
of the Record button and other items and widen the waveform display area. To set the size
back to the original condition, click the arrow button again.

-l

Fle Edt Wiew Acquistion Action Help

S

ml 000226 Monitor — Display — Channel  Acouisit

ior((@)

: B0 L
Mon Itor Recard Stap Pause M:k ’ ’ JJ7 J
T 1 Arrow button
ol
File Edit Wiew Acquisiion Action Help

DEH| LER& 2 ‘

IM MX180-01E
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2.8 Pausing the Updating of the Monitor Display
and Reading Measured/Computed Values
Using Cursors

Procedure

Pausing and Resuming the Updating of the Monitor Display

To pause the monitor display, click the Pause button on the Monitor screen or choose
Pause from the Acquisition menu. When paused, the word “Pause”under the button
toggles between red and black.

To resume the monitor display, click the Pause button on the Monitor screen or choose
Pause release from the Acquisition menu.

File Edit WView Acquisition Action Help Acquisition  Action Acquisition  Action |
Ow M| # P ®|? or || Record 1 Record

1 0000002 Monitor  Display  Channsl  Acsuistion System Connection [4]

Monitor > m " o0

Manual Save — Manual Save
| Stop |

Manual Save  Stop Mark

Click Choose
Nofte

Recording continues even when the updating of the monitor display is stopped.

Reading Measured/Computed Values Using Cursors

2 MX100 Standard

File _Felit Ve frovicitinn

When updating of the monitor display is paused, you can read measured (computed)
values with the cursor. Click the position in the waveform display area where you wish to
read the value. If you wish to read another point simultaneously, drag the mouse. Cursor
A appears at the position where you first clicked; cursor B appears at the position where
you released the mouse button. The measured point is the yellow circle displayed where
the waveform and the cursor cross.

Artinm _Haln

E@ﬂu@a\@m

Waveform display color
— Channel number

= | e = %5 —
Nothitor Record  Stop | Pause M::k RE\E;\;CK Readout value of Cursor A
Readout value of Cursor B
arefp 1 =
Channel Valug & vagB|  ValueB-vale s Time & Time B Tirme B -Time & A| (Value B) - (Value A)
M |[ooom 11 1] = 00093, 200501731 14:56:06 nmﬁ (" onnorn e vacenn ocn) oononnensal )11 Time at Cursor A
) (puooz Wi (ess Il (osesr) | o 0084 2003/01 731 14:56:08.600 l 200501731 14:56:12, aqu lu 00:00:06, 250Jj

[ somsec

14:56:00

Time at Cursor B

— Time between Cursors A and B
— Change the display area

— Cursor movement button

— Cursor A

— Cursor B

— Measurement point

— Scroll button

= Scroll bar

©|QQHEIN [T &E\EDGH{(%@’I‘@@)

(= [T 2 B == 20080131 1516:04
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2.8 Pausing the Updating of the Monitor Display and Reading Measured/Computed Values Using Cursors

Explanation

To clear the cursors, choose Hide Cursor from the View menu.

H: M¥100 Standard

File Edit | View Acquisiion Action He
01 & | v Channel
Tag Mo
Tag Comment

Mot

v Toolar
Grow v Status Bar

1+ Curtent Tie
I ooo ¥ Cemmunication Stabus

v Disk Space
000
u v File
-

Pausing the Updating of the Waveform Display

While monitoring the waveform, you can pause the updating of the waveform display and
check the past waveforms (up to 1800 points).

Pausing the display on the numeric display holds the current values immediately before
the pause operation on display.

Reading Measured/Computed Values Using Cursors

When the updating of the waveform display is paused, you can read values using
cursors. Two cursors can be displayed. Below are the values that can be read using
cursors.

+ Values at the cursors.

- Difference in the value between the cursors.

» The time at the cursor position.

» The time between the cursors.

IM MX180-01E
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2.9 Setting Alarms and Alarm Indications

Procedure

Setting the Alarm

For computation
channels Click here
5. Mx100 Standard B =1alx]
File Edit View Acquisition Action Help
D= 2e &2
W 000:00:00 Monitor
Channel E'
Meas. Channel _I Math Channsl | DOChannel | AOchannel |
Alarm 1 Alarm 2 4l [® Constant &
Recod Type Value Hysteresis Type Value Hysteresis Lakel Walue
[ 99001 | ( 15000) U.SUUqﬁH\gh =) ( room) ( U.suucﬁ 0.0000
[ [9a00z) Ty D200 ow | = TE000 TA000 smor T Alarm 1 type
L] O |I UUUUUI —— Alarm value of alarm 1
[ 199004 oft |- 0.0000
O resoes SIEY |I U”””E'I —— Hysteresis of alarm 1
[ 99008 oft [ |I U.UUUUI y
[ [g9007] off [+ ceen ——— Alarm 2 type
[ o908 Off 0.0000
s v v S T" T‘L_J! ! —— Alarm value of alarm 2
= [ : L Hysteresis of alarm 2
| Action Intervallgzec]  On-period [sec] Off-lwenudlsec] A| .
Timert  off 1 Scroll to the right to
Timerz  Off 4 ‘ display alarms 1 to 4
Timers  Off 4
T — : : v Rate-of-change interval
[T calculats +Over/.Over as the MAXMIN valus of arange.  Interval of rate-of-changs alarmﬁ when the Type is set to
Ready 0El & & == 20080151 154514 rHigh and rLow
1. Click Channel to show the Channel setup screen.
2. Click the Meas. Channel tab or the Math Channel tab.
3. Inthe Type list, select the alarm type for Alarm 1, Alarm 2, Alarm 3, or Alarm 4.
When not using difference input on measurement channels, select OFF, High, or Low. When
using difference input, select OFF, dHigh, or dLow.
On computation channels, select OFF, High, Low, rHigh, or rLow.
4. Click the value box, and enter the alarm value.
5. Click the Hysteresis box, and enter the alarm hysteresis value.
6. If you selected a rate-of-change alarm rHigh or rLow for the alarm type, select the

interval used to detect the rate-of-change from the Interval of rate-ofchange alarm
list box.

Showing/Hiding Alarms

1.
2.

Click Monitor to show the Monitor screen.
Click the Alarm ON/OFF button.

Show/Hide alarm
Q@“ﬂ‘ Rl & Heo %

Switch the active channel

181110

Alarm display area
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2.9 Setting Alarms and Alarm Indications

Explanation

Alarm Types

There are six types of alarms.

When not using difference input on measurement channels, select OFF, High, or Low.
When using difference input, select OFF, dHigh, or dLow.

On computation channels, select OFF, High, Low, rHigh, or rLow.

e Upper limit alarm (High)
An alarm occurs when the measured/computed value exceeds the alarm value.

* Lower limit alarm (Low)
An alarm occurs when the measured/computed value falls below the alarm value.

» Difference input upper limit alarm (dHigh)
An alarm occurs when the difference input (difference between the measured value of
its own channel and that of the reference channel) exceeds the alarm value.

» Difference input lower limit alarm (dLow)
An alarm occurs when the difference input (difference between the measured value of
its own channel and that of the reference channel) falls below the alarm value.

Upper-limit alarm/ Lower-limit alarm/
difference input upper limit alarm difference input lower limit alarm

Alarm occurrence {Alarm value Measured value

Lor computed value
m \ Alarm sy
Alarm reset /\_/ ﬁ
Measured value Alarm value

or computed value Alarm occurrence

» Upper limit on rate-of-change alarm (rHigh)
An alarm occurs if the amount of change in the computed value in the rising direction
exceeds the alarm setting value within the rate-of-change detection interval.

* Lower limit on rate-of-change alarm (rLow)
An alarm occurs if the amount of change in the computed value in the falling direction
exceeds the alarm setting value within the rate-of-change detection interval.

Upper limit on rate-of-change alarm Lower limit on rate-of-change alarm
T /.Change in the T
® -~ computed value
3 ' 2T J
g T S
/. 1 AN Amount of change
K > Amount of change 3 |, A in the setting |T1-T2|
5 P in the setting |T2-T1| 5 S
a T y a S f
§ E '\, Change in the
o o * computed value
t1 t2 Time— t t2 Time—
e———> e————
Interval Interval
t2—t1 t2—t1

The rate-of-change detection interval is equal to measurement interval x measurement
count. Select the measurement count (1 to 15) using the Interval of rate-of-change alarm
box.

IM MX180-01E
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2.9 Setting Alarms and Alarm Indications

Alarm Hysteresis

You can set a width (hysteresis) to the values used to activate and release alarms.
Alarm hysteresis prevents frequent activation and release of alarms when the measured/
computed value is unstable around the alarm value.

Upper limit alarm Lower limit alarm

Measured value Alarm reset

<\or computed value \/
/ \ \ / } Hysteresis

/ﬁjred value Alarm reset /\ t Alarm value

or computed value Alarm occurrence

Alarm occurrence fAlal'm value

Alarm Indication on the Numerical Display
Four alarm signals are displayed above the value (see the figure below). The changes in
the color of these alarm signals indicate the alarm status.

Red: Alarm occurrence Alarm 1 status

Green: Alarm OFF Alarm 2 status

Alarm 3 status
Black: Alarm not set
Alarm 4 status

Group | Gifoup 2 |

00002

00004 |

@ @ ol

e e e
A A, A A A

Py
b A, A, A, A

Mo RS S B A A A A

(0)N0]0]0]0] 0)80]0[0[0] -0.0001 0)80]0[0[0]
00011 \ 00012 [ 00013 H \ 00014 |
Nofte

When using computation channel alarms, do not disconnect the MX100 and the PC software.
Computation channel alarms will not occur because the computation function does not work
when using only the MX100.
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2.10 Digital Output Settings

Setting the Digital Output of Alarms

Alarm reference channel Turn ON/OFF Alarm 1 Select energize/de-energize
Turn ON/OFF Alarm 2 of output relay
Select output or not output Turn ON/OFF Alarm 3 Select hold/non-hold
Select the alarm Turn ON/OFF Alarm 4 of output relay

-——---|E

File Edit Wiew Acc|isition| Action Help

=10l

DeE|sthea)?
ml_

Channel

| meas crannel | [ matt{channel | DoChannel | sochamnel |

=
®

‘ Ref. Ch

From To evel

Action Manual DO

Energize|

! [ 00051 | 2| (®)sarm O manuel () Fail ) Error [ D001 | [00003] ‘@@ @)@\ 1 [ [
| [0052 ] | |®|aem O manual () Fail (7 Error [ 00005 | (00005 ] '‘@|"@| @@
! [ 00053 | 2| |®) alarm O manuel () Fail ) Error [ 99001 | [99002] '‘@)C@/C@)\'@) 1 [

1/ Pe-energize 5) (4 )
Energize  <|[von-haid 4]
|+ Energize  4)(von-hold 4]

Haid
it

1. Click Channel to show the Channel setup screen.
Click the DO Channel tab.
3. Select the Use check boxes for the DO channels you wish to output.
4. Click the Alarm button under Action.
5. Click the First or Last alarm reference channel box under Ref. Ch. and enter the
measurement or computation channel numbers to reference for the alarm output.
6. Click the Level 1, Level 2, Level 3, or Level 4 button under Ref. Ch.
7. Click the Energize box to select an output relay action of Energize or De-energize.
8. Click the Hold box to select an output relay behavior of Hold or Non-hold.

Setting the Digital Output Other Than Alarms

Select output or not output

Select energize/de-energize
of output relay

Select hold/non-hold
of output relay

If Action is set to Manual,

Select the source action click the button from 1 to 4

File Edit Wiew Acc|isition Action Help

=10l

D W s the|a

Channel

TEEE]

ction

| Meas. channel | | methchonnel | DOchfone | Ao Channel |

=
@

A [tion

‘ Ret.Ch

From Ta Lewvel

Zl
Ensryize| H

! [ 00051 | v| () mtarm (@ Manusl () Fail () Ervor
| [ 00052 ] 7| (O mtarm | ) Manusl @ Fail () Ervor
i [ 00053 ] 7| (O mtarm | Manusl () Fail (@ Error

source.

e

Ge-enersize ) 4

I 1 1
1 Energize  4)|donchold <]

4. Click the option button under Action to select the action used as the digital output

5. If you set Action to Manual, click any of the Manual DO buttons 1 to 4.

6. Click the Energize box to select an output relay action of Energize or De-energize.

7. Click the Hold box to select an output relay behavior of Hold or Non-hold.
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2.10 Digital Output Settings

Explanation

Alarm Reference Channel Range

The alarm detection of multiple measurement channels or computation channels can
be assigned to a single DO channel. If an alarm is detected on any one of the assigned
channels, an alarm is output. A range of individual or consecutive channel numbers can
be assigned.

Nofte

If connection with the PC is dropped, the state at the point at which the DO output was dropped
is retained. However, DO output to which measurement channel alarm detection is assigned
functions normally even if the connection with the PC is dropped.

Digital Output Operation Other Than Alarm Output

The digital output can be enabled for the following causes.

* Manual DO
DO channels assigned to the button number output relay contact signals collectively
when the manual DO button on the Monitor screen is clicked.

Manual DO button
Click to switch ON/OFF

: M¥100 Standard

File Edit Wiew Acqusiion Action Help
D@ ¥ B8 7

=lolx|

Record  Stop Pause Mark Retay ACK

Monitor

* FAIL output
Outputs a relay contact signal when an error occurs in the main module CPU.
* Error output
Outputs a relay contact signal when any of the following events occur.
» Adata output request timeout (60 s) occurs while recording data. (except when the
/DS option functions are enabled)
+ A module error occurs.
* An input module detected at power-on that is able to make measurements is
removed.
+ A module breaks down.
+ An unidentifiable module is attached.
When using the energize setting for contact output, the circuit switches from open
to short when the output is enabled. When using the de-energize setting, the circuit
switches from short to open.
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2.10 Digital Output Settings

Energized/De-energized Operation of Output Relays

You can select whether the output relay is energized or de-energized when an output
event (such as an alarm) occurs. If De-energized is selected, the output relay behaves
in the same fashion as when an output event occurs if the power is cut off. The default
setting is Energized.

Energize NO C NO Cc NO C

| N |

De-energize NO C NO C NO C

When power is shut down When alarm is not occurring  When alarm is occurring

NO: Normally Opened, C: Common

Hold/Non-Hold of Output Relays

Select the behavior of the output relay when an output event is released (recovers to a
normal condition). The default setting is Non-hold.

« Turn OFF the output relay with the release of the output event (non-hold).

» Hold the output relay at ON until the Relay ACK button (see below) is clicked.

Relay ACK button
% M%100 Standard ‘1 =lol x|

Flle Edt Wew Acqustion Action Help

DM, ke|& 2

=p “hannel sition ¢ Connection
Monitor @ ® m 9 CETE o] 2 o]
Recard Stap Pause Mark Relay ACK

* When set to non-hold * When set to hold

Output cause

Output cause

occurrence ! | occurrence . —_—
Relay ACK

Relay output ON Relay output ON J

Relay output OFF J L Relay output OFF
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2.11 Analog/PWM Output Settings

Procedure

Analog Output Settings

Selection of output Minimum/Maximum value Select the output
action upon errors of output span action upon startup

Select output | Transmission output Output range| Select the source action | Sets the output value upon
or no output reference channel  selection Click here | Startup or error occurrence

¥ Mx100 Standard|

File Edit View Acc

sisition Action | Help

DEHE| - e &)
w-—--

Channel E'[m E E'[m E'E “m
Meas. Channel | | MathCharnel | | Dochannel | A0 |hannel |
i m m I I I Span il Specifie| Output
ule Action Ref.|ch. Rerlse
Win awer On Erar preset |

[00031 ] ] (@ Trensmit () User Outp\/” [00001] Y#OLT > 10.000 2
[00032] () Transmit 48 User Output WOLT [= 10.000 4
[00033] @ Trensmt () UserOutput| [00001]  |woOLT [+ 10,000 1
[ 00034 ] @ Transmt () UserOutput | [00001]  |woOLT [= 10.000 4
[00035] @ Transmt () UserOutput| [00001]  |woOLT [+ 10,000 1
[ 00038 ] @ Transmt () UserOutput | [00001]  |woOLT [= 10.000 4
[ 00037 ] @ Trensmt () UserOutput| [00001]  |woOLT [+ 10,000 1
[ 00038 ] @ Transmt () User Outout/\_ [ 00001 ] JOLT [+ 10.000 P,

o 3 3 ] ° 8 T

- SSSSS—— o | Ok | S - S

Reay g =l Z o= 20080201 08:25:54

5.

6.
7.

8.

9.

Click Channel to show the Channel setup screen.
Click the AO Channel tab.
Select the Use check boxes for the AO channels you wish to output.

Specify a channel operation of Transmission output or User output. If user output
is specified, you can enter settings in the monitor screen.
Only one of all the AO and PWM channels can be selected for user output.

When transmission output is specified, enter the Reference channel.
The reference channel cannot be entered if the channel operation is user output.

Select a range from the Range list box.

Click the Min box or Max box under Span and enter the minimum or the maximum
value of the span.

Click the Power ON box under Output Action and select Hold previous value or
Preset value.

Click the Error box under Output Action and select Hold previous value or Preset
value.

10. If you select Preset value under Output Action, click Preset value, and enter the

voltage or current.
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2.11 Analog/PWM Output Settings

PWM Output Settings

Select output or no output

Selection of output action upon errors  Sets the output value upon

Selection of output Minimum/Maximum value startup or error occurrence
action upon errors of output span Select the resolution
Transmission output Selection of output of the pulse output
reference channel value upon startup Enter the pulse interval
-—|—_|_!, =le|[x]

File Edit View Acfjuisition | Action Help

ST IR
W-

I T -]

TERITE]

Channel
| ees.Channel || matifnennel | DO Chermel | [m channed
§ Splin Specifi|d Gutput Pulse ‘
I[se Action Ref. ch
Min Max Power On t]or Floset valus  Res|iution  Intervalmsss
{00031 ] @ Tranomt () User Outout)( (000011 0000 100 000Y (ol [ oo (imsse [ <] 10
{00032 ) Transmt @) Ussr Output 0000 100,000 |Hol 4[oia oocf|imess <] 10
100033 ] @ Tranomt () User Outout|| (000011 0.000 100.000Hol (] ooncf|imsss =] 10
1000341 @ Tranemt () User Outout|| (000011 0000 100,000 |Hol 4[oia oocf|imess <] 10
{00035 ] @ Tranomt () User Outout|| (000011 0.000 100.000Hol (] ooncf|imsss =] 10
{00036 ] @ Tranemt () User Outout|| (000011 0000 100,000 |Hol 4[oia oocf|imess <] 10
100037 ] @ Tranomt () User Outout|| (000011 0.000 100.000Hol (] ooncf|imsss =] 10
{00038 ] @ Tranemt () User Outow)|__[00001 ] 0.000 100 000/l ot oonf lmses [+ 10
8 3 2] 2] ) ) 1 1 1
) —m ) — ) = i x Lo L 0k | K
Ready 0El ] g B =cn 200802001 08.35:22

R b=

Click Channel to show the Channel setup screen.
Click the PWM Channel tab.
Select the Use check boxes for the PWM channels you wish to output.

Specify a channel action of Transmission output or User output. If user output is
specified, you can enter settings in the monitor screen.
Only one of all the AO and PWM channels can be selected for user output.

When transmission output is specified, enter the Reference channel.
The reference channel cannot be entered if the channel operation is user output.

Click the Min box or Max box under Span and enter the minimum or the maximum
value of the span.

Click the Power ON box under Output Action and select Hold previous value or
Preset value.

Click the Error box under Output Action and select Hold previous value or Preset
value.

If you select Preset value under Output Action, click Preset value, and enter the
duty.

10. Select 1 msec or 10 msec in the Resolution list box under Pulse.

Click the Interval (msec) box under Pulse, and enter the pulse interval.
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2.11 Analog/PWM Output Settings

Turning Transmission Output ON and OFF Collectively for Analog Output/PWM
Output

1. From the Action menu, choose Transmission output.
Transmission output on all active channels on the AO and PWM channel tabs is started (All
ON).

2. From the Action menu, choose Transmission output again.

Transmission output on all active channels on the AO and PWM channel tabs is stopped (All
OFF).

Explanation

Setting up Output for AO Channels

Transmission Output:  Values measured on the MX100, or computed values
corresponding to computed results set on computation channels
are converted to analog voltages (-10.000 V to 10.000 V) or
analog current (0.000 mA to 22.000 mA) and output.

Nofte
The output range is —11.000 to 11.000 V or 0.000 to 22.000 mA, but the span setting range is
—10.000 to 10.000 V or 0.000 to 20.000 mA.

User Output: You can set the analog voltage or analog current to an arbitrary
value in the monitor screen. The setting ranges are —10.000 to
10.000 V (voltage), or 0.000 to 20.000 mA (current).

Setting the User Output of the Voltage Value

Drag the pointer to set Click the input box, and enter a value

q e

el Acquistion System Connection [#]
1250 === [ 12100 gn 2oy

S MX100 Standard = =101 x|
File Edt wiew Acquisition Action Help

|
Record  Siop  Pause Mark |

Monitor

Setting the User Output of the Current Value
Bl

Fie Edt Yiew Acquisiion Action Help
DEed| 2R 82
® 0000000

i 120001 g 2| 4
Monitor @ ® m ® f— L 20 o B 4

Record Stop Pause Mark

- T

r

K
-

Setting up Output for PWM Channels

Transmission Output:  Outputs a duty pulse waveform corresponding to values
measured on the MX100, or the computed results set on the
computation channels.

User Output: You can set the pulse duty ratio (0.000 to 100.000%) to an
arbitrary value in the monitor screen.

Output width

—

m Duty ratio = Output width x 100 [%]

|<—>| pulse intrvl

Pulse interval
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2.11 Analog/PWM Output Settings

Setting the User Output of the Pulse (PWM Channel)
Drag the pointer to set Click the input box, and enter a value

# SR

8- My 100 Standard L -lof x|
File Edit Wiew Acquistion Action Help

DER|Ee|6?

Wl 000:00:00

Record  Stop Pause Mark

Monitor

Click to switch the display

Overview of Output Action When Setting Holding of Previous Value of

User Output
Value held
Output value T T T
Power ON  Measurement start Measurement stop Measurement restarts
Nofte

If connection with the PC is dropped, the state at the point at which the AO or PWM output was
dropped is retained. However, AO or PWM output to which measurement channel transmission
output is assigned functions normally even if the connection with the PC is dropped.
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2.12 Saving/Loading and Printing Setup Data
(Project)

Procedure

Saving Setup Data (Project)

1. From the File menu, choose Save or Save As.
2. |If you select Save As, enter the file name in the Save As dialog box and then click
the Save button.

If you attempt to save the file using an existing file name, a dialog box appears for you to
confirm whether the file is to be overwritten.

= Mx100 Standard & MX100 Standard
Fle Edt View Acqustion Action H Fle Edit View Acquistion Action H
e Chri+h or New Chrl+M
Open... o Open... Ctrl+0
Save Ctrl+5
Save As...
1
X 2=
Save n: |/l W10 Stangard x| = @k E
Data
work
8] ~latest. mop
8] Project0L.msp
File name: e i) Save I
Save as typer | M3 100 Standard Project Filel* mxp) j Cancel |
3

Loading Setup Data (Project)
1. From the File menu, choose Open.

2. Inthe Open dialog box, select a project file and click the Open button.

= Mx100 Standard
File Edit Wiew Acquisition Action H
Mt Chrl+h
Save Chrl+s
Save As..,
oeen 2| x]
Loak i [ /=3l W10 Stangard x| = @k E
Mame ~ | Size | Type [ Madified
(C1Data File Folder 5/15/2003 5
(T3 work File Folder 5i15/2003 4
~latest.mxp EDKE  MgP File 5/16/2003 8
oject0l.m BOKE M File 5i7j2003 2:1
< | |
File name:  [Project01.map Open |
Files of type: [M34100 Standard Froject Filel” msp] =l Cancel |
A

Nofte
»  When you carry out the procedure above, the current setup data is discarded and changed
to the setup data of the project that is loaded. If you need the current settings, save the
project before loading the setup data.
» Ifthere is a strain module, you can also save or load the initial balance value. Using the
project file, you can save or load multiple initial balance values.
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2.12 Saving/Loading and Printing Setup Data (Project)

Printing Setup Data

1. From the File menu, choose Print.
The Print dialog box opens.

2. In the Print dialog box, select the printer, print range, and the number of copies,

and then click OK. 5
-

Q

Display example of the Print dialog box =

5 Q
P 2 =3
File Edt View Acquistion Action H  Printer []
Mt Chrl+h [ i S
e Ao Name: | \\PSZX5E\Print = ropeities.. =
Save ctri+s Status  Ready o
Save As... Type,  Canon PSIPU Color Laser Copier v52.3 =3
r— —> Where:  \PSZXE5Print 8‘
Irpart Math Expression... Comment: I Piint ta fle -

Import Math Constant...

~Frint rang: Copi

&l Number of copies: |1 =]
PHnt Preview: [§  Pages from: |1 [

15 m 3| ®lcotes
Print Setup...  Selection

Recent File

Exit Carcel

Launch Data Viewer

Print Preview
From the File menu, choose Print Preview.
The print image is displayed.

H: M¥100 Standard

File Edit Wiew Acquisition Action H

New Cr+h
open... O
Save s
Save As...

Import Tag,..

Import Math Expression...
Import Math Constant. ..

Launch Data Yiewer

Print... Chrl+P

Print Setup., .

Recent File

Exit

}

2 MX100 Standard

Print.. | MetPags | FrevPage | TwoPage | Zoomin |[Zoomiut |

Setting Up the Printer

1. From the File menu, choose Print Setup.
The Print Setup dialog box opens.

2. Set the paper size, orientation, and other settings. Then, click OK.

Display example of the Print Setup dialog box

File Edt Wiew Acquisition Action H -

Plewt ChriH

ey Ao Name:  [\\PSZXSEPrint =l ml
Sawe Chrl+s Status: Fleady

e 3 Type:  Canon PS-IPU Calor Laser Copier v52.3

Import Tag, . Where:  \APSZHEE\Print

Irpart Math Expression... Comment:

Import Math Constant...

- Paper QOrientation

Size: Letter = & Portrait
Print... ke
Print Preview Source:  [Automatically Select - © Landscape

Recert: File T Cancel

Exit

Launch Data Viewer
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2.12 Saving/Loading and Printing Setup Data (Project)

Explanation

Save Destination

The default save destination varies depending on the system that is running.

File Name

The extension is .mxp. The default file name is NewProject.mxp.

Creating a New Project
Create a new project when you wish to monitor the measured/computed data using new
settings.

Printed Contents of the Setup Data
The following figure show how the setup data is printed.

W unit
o wom Tenperare
e Ram A WEgETON The
SertlNo. 120222221 Uit ho oo
Witk Woae W cyei wode
M Hetwork Infarmation
MAG Address 00:0054:545193 Dett Gate way oo
wacine Name WX100-No 1 SwetMaTk 255255.255.0
1 Address 182.168.1.1 Portho. 3u3ts
W Acquisiion
stncoum 0 wes charorsin
W File
Foller [p:wxinosEwaniban
Fik Name [ ] O awoae [ Ao Tme
Flke Diuklon N
Comment [
W Module Arrangement
o Type Growp_| Woutor ntenal] Recora nerval
[ MXTIGUN-HOE | Wear | S0msec S0msec
1 WATGUNHD | Mem 2 1w mec] 1w mec]
2 W11SD2FH10_ | Wea 3 Tsec Tsec
El T
[ WAIZEEH0L_ | Wea 3 Tsec Tsec
s W 125-MKC-H1D
wan el 1mmsee 3 Rec. ntersal 1mmsee
W Channel
Span Scak ema
recEino] fworod  wome Raige
[ war use_[oec. ron [ war use | Retcy
ooy | W Vo v Zmon zowo| OJ 0O
o | W Vo v Zmon zowo| O O
mom | W Vo v Zmon zowo| O O
woon | W Vo v Zmon zowo| O O
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2.13 Other Displays and Settings

Displaying the Version Information

1. From the Help menu, choose About.
A dialog box containing version information opens.

100 Standard aboue

File Edit Wiew Acquisition Action | Help —

T =g v el | 6 M100 Standard R3.01

EECIEREEN > | By R
Copyright (C) 2003-2008 Yokogawa Electric Corporation

Software Japan
This product iz licensed to
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Chapter 3  Viewer

3.1 Loading Data Files

1. Start the Viewer.

2. From the File menu, choose Open. n
You can also click the @ button on the toolbar.

The Open dialog box opens. <

©
o : -
open 21x| )
| File Wiew Help =

Look i [ 4 Data = & ® e E-
—> _
PHnt Sebup ... [#] data-0514-0954.mxd [eidata-0515-1654, mxd

Recent File

Exit

i8] data-0514-0959.mxd

4 »
File name:  [datar0515-1654 DOpen |
Files of type:  [Mix/Synchronized Data File [%med “mss) = Caneel

File Infarmation

File Recovery Mone End Condition End Point

Sync-Process Mone Start Time 2003/05M15 16:54:26.384
Creatar M=100 Standard Logoer End Time 20030515 16:95:26.160
File Ma. a Channel Nurm, 18

Start Condition Start Point

| 4
I

File information
This information is also printed when the display data is printed

3. Select the file you wish to load and click Open.
The waveform display window opens.

When loading data files recorded using the MX100 Standard Software’s
Integration Monitor

Before the waveform display screen appears, the message, “This file is not synchronized.
OK to synchronize?” is displayed to confirm whether or not to perform the synchronization.
To synchronize the data file, click Yes, otherwise, click No.

=

M3110
This file is nat synchronized.

Synchronize data file?

I

Displays the waveform display window

Ready I T

The graphs for each monitor interval specified in the Acquisition Conditions :
of the Integration Monitor and the graph of computation channels are display
separately even within the same group.
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3.1 Loading Data Files

Explanation

Nofte
If you open a file (file created by recording the data of multiple units (MX100s)) created using
MXLOGGER (software sold separately), a confirmation dialog box opens with a message “This

file is not synchronized. Synchronize data file?” If you click No, a Select Unit No. dialog box
opens. Click the desired unit number button to display the measured data of the corresponding
unit and the computed data of MXLOGGER.

When Loading Data Files Divided on the MX100

If there are any files that can be joined a dialog box opens with the message, “Combining
with related files?” before the waveform display window appears. Click the Yes button to join
the files or the No button to display only the specified file.

=
i ma124
Cormbining with related fles?

Displays the waveform display window

The graphs for each monitor interval specified in the Acquisition Conditions screen
of the Integration Monitor are displayed separately even within the same group.

Loadable Files

Data files recorded using the Integration Monitor of the MX100 Standard Software or
MXLOGGER (sold separately) (.mxd extension).

Data files saved after performing synchronization using the Viewer (.mxs extension).
Data backup files saved to the CF card using the MX100 (.MXD extension).

Display Range, File Size, and Number of Data Points of the Loadable Data

50 groups

Maximum channels per group: 32
File size: 2 GB

Data points: 5 million

Note

*  When loading files with approximately 5 million data points, the error message “Insufficient
memory. Please exit immediately.” may appear. If this happens, set the paging file size of
the system virtual memory to 2 GB or more. To change the paging file size of the system
virtual memory in Windows XP: In the control panel, double-click the System icon, click the
Advanced tab, then click the Settings button under Performance. In the performance options
dialog box, click the Advanced tab, then click the Change button under Virtual memory and
make the desired changes.

*  Whenever possible, avoid loading more than one file containing approximately 5 million data
points because doing so can dramatically reduce the PC’s performance.

3-2
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3.1 Loading Data Files

Synchronization

The Integration Monitor of the MX100 Standard Software sends PC’s time information to
the MX100 at measurement intervals. The PC’s time information is received along with
the measured data when the data is received from the MX100. When measured data is
recorded, the PC time information is also recorded.

—=5=0
—
e ||| <
Packet lo g
e S s
v Packet v v
PC Time | Measured data
MX100 - . MX100 MX100
PC Time | Measured data

On the other hand, each MX100 makes measurements based on the main module
clock. Therefore, the PC’s time that is recorded with the measured data and the PC’s
time when measurements were made may be offset. When loading the data, the Viewer
can process the time information to match the PC’s time that was present at time of
measurement. This process is called synchronization (for details, see Note on the next
page).

The measured data and computed data recorded using the Integration Monitor have
time stamps attached by the MX100 main module (see section 1.2, “Main Module
Functions” in the MX7100 Data Acquisition Unit User’s Manual (IM MX100-01E)). When
synchronization is performed, the time stamps are changed using those of the PC as a
reference. The file created by synchronization takes on the same file name with the .mxs
extension.

When synchronizing, if the backup file is placed in the same folder, data dropout from
the recording file is embedded from the backup file (data saved to the CF card), and
synchronization of channel data is performed. Also, the between-channel delay in the
medium speed modules is compensated during synchronization.

Synchronized files created by the synchronization process are created in the same
directory as the data file normally displayed. The file name is “the name of the file being
displayed (excluding the .mxd extension)” + “mxs extension” However, if the destination
storage medium is write-protected, the file is created in the temporary file directory. The
temporary file directory is displayed in an error message dialog box.

When divided files are loaded, they are joined by the synchronization process. If a

file that can be joined to the displayed data exists and you synchronize the data, the
existing synchronized file is overwritten. If the existing synchronized file cannot be
overwritten (set to read-only attribute, for example), a new synchronized file is created.
A sequence number is added to the name of the new synchronized file (“the name of the
file being displayed”+ “sequence number’+ “mxs extension” For example, if the existing
synchronized file name is “data-0000-1.mxs” the new file name is “data-0000-2.mxs”
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3.1 Loading Data Files

The following limitations exist in the joining of files through synchronization.

If any of the divided files are missing, the files after (or before) the missing file are not
joined.

If the total number of measured data points in the divided files exceeds 5 million, only
files that would not cause the total number of displayed data points to exceed 5 million
are joined.

When synchronizing files that exceed the 5 million point range, a specified file is used
as the start file and succeeding files are joined. If 5 million points is not exceeded
when the last file is joined, files before the start file are searched for in order, and files
that would not cause 5 million points to be exceeded are also joined. In this case,
because the files before the start file are also joined to the previous synchronized file,
two synchronized files for this file would exist. If you open a file before the start file and
perform synchronization, the viewer displays the first file the OS finds (either of the
two existing synchronized files). In such cases, it is recommended that the files you
wish to join are selected so that the limit is not exceeded, copied to the user’s working
folder, and synchronized there.

Divided files can be joined up to the point in which the size of the joined file reaches 2
GB.

Note

* Details of Synchronization

Given M recorded data points of a given channel of a data file that has not been

synchronized, synchronization (linear interpolation) is carried out as follows:

1. From the record start/stop time and record interval, determine N, the number of data
points that will result after synchronization of the relevant channel.

2. From the record start time and record interval, determine Stn (n=0, ... , N-1), the PC time
after synchronization of each data point.

3. From the record start/stop time and the PC millisecond clock counter values at record
start/stop, determine PCcntPerms, the clock counter value per millisecond.

4. From the PC millisecond clock counter values recorded with the data before
synchronization and PCcntPerms, determine Rtm (m=0, ..., M—1), the PC time of the
data before synchronization.

5. Determine m such that the expression Rtm—1 < Stn < Rtm is satisfied and retrieve the
data values before synchronization VRtm-1 and VRtm at the PC time of Rtm—1 and Rtm.

6. Determine the data values after synchronization from the expression VStn = (Stn — Rtm-1)
x (VRtm - VRtm-1)/(Rtm — Rtm-1) + VRtm—1 where (n=0, ... , N-1 and m=0, ..., M-1).

7. Determine the data values after synchronization for N data points, and then write them to
the synchronized file.

Data value

VRtm
VStn

VRtm-1

VRtm+
VRtm-2 pzor”

Rtm-2 Rtm-1 Stn Rtm Rtm+1 PC time

*  When loading a data file saved by the MX100 to the CF card, synchronization is not possible
because the PC time information needed in the data synchronization is not present.

» With the /DS option, when loading a data file saved by the MX100 to the CF card,
synchronization is not possible because the PC time information needed in the data
synchronization is not present.

» Synchronization may take time depending on the number of data points in the divided files.

» Itis recommended that synchronization be performed on a hard disk with adequate free
space.
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3.1 Loading Data Files

« Even when synchronization is performed, the files before synchronization (.mxd extension)
are not deleted.

» If you change the PC'’s time while data is being monitored on the Integration Monitor of the
MX100 Standard Software, the error in the clock counter value per millisecond of the PC
used in the synchronization process will become large. If the error in this value is greater
than or equal to 2% when synchronizing the data file created at the time PC’s time was
changed, the clock counter value of 1 millisecond is considered to be 1 for the purpose of
synchronization.

* If communication is disrupted temporarily due to power failure or network failure during the
recording operation, the PC time of the data measured by the MX100 while communication
is disrupted (see “Details of Synchronization” above) is recorded as the old PC time before

S
o
g
o
o

communication was disrupted in the file created immediately after communication recovers.
If you attempt to synchronize this file, a dialog box with the message “Some channels do
not have enough information to synchronize.” appears. In this case, synchronization is
performed with the premise that the MX100 measured the data using the logical (estimated)
record interval.

Joining
You can join data saved in the MX100’s CF card.

File groups with

This becomes the unit of joining
files numbered 0

*Max number of files

| _
I I
| |
[File 0] 1 | [File1] [File 2] [File N¥]
Measurement I'| Start condition: I Start condition: Start condition: Start condition:
| start divide divide divide
Group 1 | | Stop condition: I | Stop condition: Stop condition: Stop condition:
| divide | divide divide exit
1| [File 0] I [File 1] [File 2] [File N¥]
Measurement | Start condition: | | Start condition: Start condition: Start condition:
Group 2 M start | divide divide divide
|| Stop condition: Stop condition: Stop condition: Stop condition:
| divide | divide divide exit
|
I'[ [File 0] [File 1] [File 2] [File N¥]
Measurement | | Start condition: I'| Start condition: Start condition: Start condition:
Group 3 start | divide divide divide
I Stop condition: | Stop condition: Stop condition: Stop condition:
| divide divide divide exit
—————— _time
Recording start Recording stop

+ Files from multiple measurement groups having the same file number are joined into
file groups.

» The number of files contained in a file group must equal the number of measurement
groups specified (for example, if 3 measurement groups are set, each file group
contains 3 files). If one or more files are missing, file grouping stops.

» The resulting files that are created are limited to five million points or 2 GB. If the
limit is not exceeded from the file group of the specified file number to the file group
of the record stop file number, the software searches for file groups of file numbers
preceding the file group of the specified file number and joins as many of them as
possible without exceeding the limit.

» The extension for joined files is .mxc.

Nofte
» Copy CF card data to the PC hard disk before processing it.
» Joining may take time depending on the number of data points in the divided files.

» Even when joining is performed, files prior to the joining (with extension .MXD) are not
deleted.
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3.2 Display Settings

Changing the Display on the Waveform Display Window

Change the display settings according to the explanation is the figure below.

Alarm display ON/OFF ) Switch the grid display
- Loone Switch the Clip display ON/OFF
Switch the active waveform display zone
Switch the displ . Move the cursor to the
witch the display group Zoom in or out point where the alarm
of the time axis changed
L | =l =1olx|
@ File 4t wiew Window Convert Information Help =lEl x|
= BB 20| @ oo e e @ EE 6 E
[Gmu 1 \ Group 2 |
@)| @, LI R 1 W |

Change the grid density—-(]
Zone display area ON/OFF - gmm71

Change the background —
darkness

I T

Ready

—— Turn ON/OFF the channel Scale
Channel number and measurement unit

Changing the Display Using the Toolbar

Change the display settings according to the explanation is the figure below.

Show the General Display Settings window

Adding marks

Move cursor A to the left mark

Move cursor A to the right mark

Move cursor B to the left mark

Move cursor B to the right mark

Channel number display

Tag number display

Tag comment display

Switching between Absolute and Relative time

Show the waveform display window

Show the numeric display window
Alarm/Mark List
Show the window for displaying cursor values

Show the window for displaying statistical
computation over an area

EEIDEIEE L EEE ==
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3.2 Display Settings

Changing the Display Using the Menu

Choose appropriate commands from the Edit, View, and Window menus to change the

display.
[Edic view Window Corvert teow Windan Covert Information g ow the computation result display window
Copy i+ General Display Settings... T
Select Al Cirkta Apply Display Settings in Data Fls —— Change the data file display
Erass Cursor — Clear the Cursor y——— .
o bl — Switch between channel number, tag number,
m} AAdd/delete a mark Tag Comment and tag comment
| (i3 i . . .
o v poute Tine > Switch between absolute and relative time* <
¥ Tool Bar —— Turn ON/OFF the toolbar o
v Status Bar —| . E
J— Turn ON/OFF the status bar S
window Conwert Information A the ds |a wmdow . 3 . . -
Cascar frange Isplay * Displays also the Format item during numeric
Tie } (select cascade or tile) display

_Areneetens  —— Arrange window icons
Graph

sheet _— Show the waveform display window
Geshisremk s 2~ Show the numeric display window
AlarmfMark . . .
p— Select how to arrange the display area from auto, horizontal, and vertical
e (\N_ Alarm/Mark detailed list display
1 Graph[data-0006, mxs] . . .
P v —— Show the window for displaying cursor values

Show the computation result display window
Switch the display window

Changing the Display Using the Display Setup Window
See the explanation in the figure below. Change the display settings and click OK.
Set the display for each display group.

Switch to another display group

Display ON/OFF  Group name Turn ON/OFF the trip point display ~ Channel display color
N

General Display Settings x|
| 02 03 04 05 05 OF ne{ 0910 11 12 13 14 15 16 17 |18 19 20 21§ 23\34 25|26 27 |28 29 @ 4 B
oup Name
Scals Zone A
Mo Channel Na. ¥ axs  Form - - Trip Trip2 Color
Min M Min.  Max

()t CHOoOO1 N (20 RYSEEL.Y e (-
[ mz CHOOO0Z -30000.0 30000 .0f o ool ] 2ol ]
o CHOOO03 -30000.0 30000 .0f o oof] 2ol ]
o It CHOOO0S -30000.0 30000 .0f o oof] 3ol
o CHOOO 1 -0.2000 02000 o oof] 0zo00 |
I |wme CHOOO1 2 -30000.0 30000 .0f o oof] 300000 |
i CHOOO1 3 -30000.0 30000 .0f o oof] 300000 |
I |wma CHOOO1 4 -30000.0 30000 .0f o oof] 300000 |
I |wma CHOOO15 an 30| o oof] 20|
o CHOOO16 3 3 o oof] 2]
R CHOOO17 30000 30000 o oof] 2 noo0 |
iz CHOOO16 30000 30000 o oof] 2 noo0 |
s CHOOO18 30000 30000 o oof] 2 noo0 |
I ES CHOOOZ0 30000 30000 o ool ] 2 noo0 |
A= hinnas hqnnn nn annon 0 an o

w % _!_94 \!__!_ﬂ g g

= = 3 " 3 kv

oK Cancdl Schle Calc. Copy
| b
Select the Y-axis Trip point value
display format Display zone position
Maximum and minimum
values of the scale

Select the Y-axis type (linear/logarithmic)

Turn Y-axis ON/OFF when displaying multi-axes zone
Select channels (displays the channel selection dialog box)
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3.2 Display Settings

Explanation

Display Groups and Group Names

The values of each channel that are loaded are divided into groups that were used during
recording and displayed using waveforms or numeric values. The measured/computed
values can be divided into up to fifty groups. Up to thirty-two channels can be registered
to a single group. If you click the channel selection button on the General Display
Settings window, the Channel No. dialog box opens (see the figure below). The labels
used to identify the waveforms can be set to tag numbers or tag comments in addition

to channel number on the View menu. The selected label type (channel number, tag
number, or tag comment) is used in the Channel No. dialog box. Select <None>, if you
are not assigning a channel.

CHI9003 CHI9004

=hones

To turn ON/OFF the waveform display on the waveform display window, click the button
below the scale bar as shown in the figure below.

Hide the waveform

The name assigned to each group can be changed using up to thirty characters.
The names of the display groups that have channels registered are displayed on the
waveform display window or numeric display window.

Y-Axis Type
You can select linear or logarithmic Y-axis for displaying the waveforms.

Linear scale Logarithmic scale
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3.2 Display Settings

Maximum and Minimum Values of the Y-Axis and the Display Format of the

Y-Axis Values

The maximum and minimum values of the scale on the waveform display can be
changed. If you click the Scale Calc. button on the General Display Settings window, the
maximum and minimum values of the Y-axes on the selected channels are calculated
automatically according to the maximum and minimum values of the data.

The scale values can also be displayed using logarithmic format as shown below.

Scale
Min Max —_—

W1 CHoooot Linear{] ? _2.0E0 2.0E0

Mo, Channel Mo, Y Axis  Form

S
(]
2
o
=

Select the exponential format

Selecting the Display Zone of the Waveform
You can select from the following. In the Zone setting on the General Display Settings
window, assume the bottom and top edges of the waveform display area to be 0% and
100%, respectively, and set the waveform display position by specifying the minimum
value (0 to 99%) and the maximum value (1 to 100%).
* User zone
Displays each waveform at the position specified by Zone on the General Display
Settings window. A single Y-axis active channel waveform can be displayed.

Set the display zone Select user zone
Fone ©\QQ®W
Min M.
10 T —— I
32 :EE Indicates the —®
bar for the active
B channel Displays the Y-axis
of the active channel
Click the bar to specify the active channel
* Edit zone

Like the user zone, each waveform is displayed at the position specified by Zone
on the General Display Settings window. However, you can change the zone on
the waveform display window. A single Y-axis scale of the active channel can be

displayed.
Select edit zone
Group 1 | Group E
YOI
Drag the knob to change

the minimum/maximum

lue of th tel
vale ofthe zone separately Drag the bar to change the zone position

without changing the zone width
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3.2 Display Settings

* Full zone
Displays all the waveforms over the full zone of the waveform display area regardless
of the Zone settings on the General Display Settings window. A single Y-axis scale of
the active channel can be displayed.

Select full zone

@ B[ lﬂéﬂ)lll Yy B |

Waveform display area (full zone)

» Slide zone
Displays the waveforms by slightly offsetting the display position of each waveform
vertically regardless of the Zone settings on the General Display Settings window. A
single Y-axis scale of the active channel can be displayed.

Select slide zone

@|®, G Wl B Illé'lu bt |

Slide in this manner

* Auto zone
Displays the waveforms by dividing the waveform display area evenly according to
the number of displayed waveforms regardless of the Zone settings on the General
Display Settings window.

Select auto zone

FIECIENT luﬁ

Divide evenly automatically
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3.2 Display Settings

* Multi-axes zone
All the specified Y-axis of the displayed waveforms are aligned horizontally. To hide
a Y-axis, clear the Y-axes check box on the General Display Settings window. The
display position is set using Zone on the General Display Settings window. Dragging
the channel bar to the waveform display area shows the Y-axis of the corresponding
channel. Dragging the Y-axis to the zone display area hides the Y-axis of the
corresponding channel.

Indicates the
specified Y-axis Select multi-axes zone

FECIITT '-.(05
L]

Ho. Channel Mo Vs
Wi CHODO Linear<]
W2 CHOOOO2 inear{]
WG CHONONG $ Linear] —_—
Turn OFF the Y-axis
display of Ch00002

The Y-axis of Ch00002 is not displayed.
Click the bar to move the specified Y-axis to the right end

Grid Display
Select the grid type.

When this is selected When this is selected When this is selected

A00msec

100msss ©|QQ_L@ BT M BERREE(C ] » ] 100msec

CHODOOT [v]
=
2
3

=
R L e
=
(=]

——— == sSs=—
15:48:35 15:48:35 15:48:35
@l Absolute Time [hmes] @I Abnlute Time [hem:s] @l Absolute Time [hmes]
al | al L v | b1 al I
Trip Point

You can display a trip line to indicate a particular value of interest (trip point) in the
waveform display area. Two trip points (trip 1 is red, trip 2 is blue) can be set on each
waveform using the Trip 1 and Trip 2 settings on the General Display Settings window.
The trip line of the waveform corresponding to the right-most Y-axis bar is shown in the
waveform display area.

Trip 1 value
Trip 2 value Trip line
., " FECEI L] |D@é\ Ta»]  tommser
- . 010 —
0.0%- 7 1 .
2= —Trip 1 value*

CHOOO1 [v]
=
]

4
! CT5—Trip 2 value*

* Can be moved

———© .
1514535 by dragging

Eomaimy]  Absolit Time ]

al P
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3.2 Display Settings

Channel Color

Clicking the channel color displayed in the Color column on the Display setup screen
opens the Color dialog box. You can select the color of each channel using the Color
dialog box. To create custom colors, click the Define Custom Colors button in the Color
dialog box.

Basic colors:

NN EE
il ||
EfEEEE N

AN EN
C I

Custom colors:
) )
)

Define Custom Colars > |

oK. I Cancel

Clipping of Waveforms

By default (clip OFF), the waveform is not displayed when the measured/computed value
exceeds the minimum/maximum value of the scale (see the lower left figure). When clip
is turned ON, values that are smaller than the minimum value of the scale are displayed
as the minimum value and the values that are larger than the maximum value of the
scale are displayed as the maximum value.

Clip OFF Clip ON

\ / \ FEE IR = ;|@|<nnu<sau_.\—/—\

Expanding or Reducing the Time Axis on the Waveform Display
On the waveform display window, you can click the zoom in/out icons to zoom in or out
on the time axis in the range of 20 to 1/1000 times for each waveform display area.

Time axis expand/reduce icon

005

{ 0.0313]

154835 154840
[ondr 170 et o (o) &zD— Magnlflcatlon
all e v
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3.2 Display Settings

Adding Marks

In addition to the marks placed using other programs such as the Integration Monitor,
you can add marks at the positions where you click (displays a cursor) on the waveform
display area. You can enter a text to be attached to the mark (“Mark”by default) using up
to fifteen characters. You can also select Left, Center (default), Right, or Flag (small mark
without text) for the Type. For types other than Flag, the specified string and the relative
or absolute time at the mark position are displayed.

You can set the string and type in the Mark dialog box that opens when you click the
Append Mark icon (or choose Append Mark from the Edit menu). In the Mark dialog box,
you can select whether to add the mark to the waveforms of all groups (default) or only
the waveforms of the displayed group.

To delete specific displayed marks, select the range using cursors, and then choose
Delete Mark from the Edit menu. To delete all the marks added using the Viewer, choose
Reset Mark from the Edit menu.

<
(]
g
(]
=

Display the cursor Aidd mark icon Left end Flag Center
| |
— — [ 3| p— TN N TR s e
ikl
or @ Al Group " Group on Display
CEREID (L Marks added on the Viewer are green,
H BB o e Conter E and marks added on other programs
- oy Chri+C
= Selz.:t Al Chri+a are orange.
Group Er i
©‘@7@E [ o | cancal |
Delete Mark.
(et s Double-click the mark to change the settings

Switching between Absolute and Relative Time
By default, the time axis is displayed using absolute time. The time axis can also be
displayed using time relative to the first data position.

Absolute Time Relative time
& W[ B[ @ M o e e e |(©) 1S W = = BRI e

Group 1 Group 1

PEC LI R [ I4n A |18 BK AECCET i)

|14 A 148 BY

L Switch absolute/relative time

On the numeric display, you can select the display format of the absolute or relative time
and turn ON/OFF the data numbers using Format on the View menu.

_ o _ 1y
v Absalute Time Absolute Time:
Relative Time v Relative Time
w veveco SRS
MM{DD —|
v Todl Bar ! v Tool Bar H1/y2D
Days v Days
v Status Bar v Status Bar
e hone Mone
20030507 19014 1000 —————————— 0 00:00:00.500(00000005]
20030507 19:01:41.200[0 ¥ HH:MM:55.555 0 00:00:00 600[00000005] | ¥ HH:MM:S5.555
20030507 19:01:41 300m  HH:MM:SS 0000000 7o0oo0oooay]  HHEMMESS
2003/05/07 19:01:41 400/ H:MM 0000000 A00[000ogons)  H:MM

In the alarm/mark list, the time is always displayed using absolute time.
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3.2 Display Settings

Showing/Hiding Alarms
You can hide the alarm display area that indicates the status of alarm occurrence. The
alarms are displayed in the same fashion as the alarms displayed in the waveform

display area of the Integration Monitor.

Show/Hide the alarms

No alarm display

EOERCIIEY

| 214 A 148 BH

Alarm display area

Alarm/Mark List Display
Displays a detailed list of alarms and marks.
From the Window menu, choose Alarm/Mark List.

100msec

You can also click the & button on the toolbar.

e Alarm List

Sorted according to the clicked item
Currently sorted to the item indicated by this mark

@@, S, R I " &[]

|14 AW 148 BY

{3, Data Yiewer - [Alarm/Mark List[data-0008.mxs]] =1ol x|
File Edit Viels Window Convert Information Help =lEl x|
BE B e ey aea o HEEMEE SR
Alarm List | Mark List |
(__chemnel Level Type Alarm ON Alarm OFF a
CHas0o1 1 Lov 4 200411101 15:48:31 200 200411101 15:48:31 200
CHas0o1 H Hizh 1 200411101 15:48:31 400 200411101 15:48:31 500
CHas0o1 1 Lov 4 2004/11J01 15:48:32.100 200411401 15:48:32.100
CHas0o1 H Hizh 1 200411101 15:48:32.400 200411101 15:48:32.600
CHas0o1 1 Lov 4 2004/11J01 15:48:33.000 200411401 15:48:33.000
CHas0o1 H Hizh 1 200411101 15:48:33.300 200411101 15:48:33.500
CHas0o1 1 Lov 4 200411101 15:45:34.000 200411101 15:45:34.000
CHas0o1 H Hizh 1 200411101 154834300 200411101 15:48:34.700
CHas0o1 1 Lov 4 200411101 15:45:34.900 200411101 15:45:34.900
CHas0o1 H Hizh 1 200411101 154835200 200411101 15:48:35.200
CHas0o1 1 Lov & 200411101 15:48:35.400 200411101 154835500
CHa30m 2 Hizh 2004111101 15:48:36 100 2004111101 15:48:36 100
CHas0o1 1 Low & 200411101 154835300 200411101 154835500
~unones 2 Hizh 4 A AT a0 Ana i gy ann T
Ready |

e Mark List

Sorted according to the clicked item

{3, Data Viewer - [Alarm/Mark List{data-0011.mxs]]
Fle Edt View Window

Conwert Information  Help

Currently sorted to the item indicated by this mark

o]
T

=& B @ RA

Al e )i | @ @ @ | @ | 1/ i B

0 &R

Alarm List | Mark List

C

Absolute Time

Mark

Group

=3
g
2

200411101 1
200411101 1
200411101 1
200411101 1
200411101 1
200411101 1
200411101 1
200441101 1
200411101 1
200411101 1
200411101 1
200411101 1
200411101 1

6:31:07 020
6:31:07 120
6:31:07 220
6:31:07 300
6:31:07 320
6:31:07 420
6:31:07 520
6:31:07 GO0
6:31:07 770
6:31:07 400
6:31:07 420
6:31:08 020
6:31:08120

mark
mark
mark
Mark
mark
mark
mark
Mark
Mark
Mark
mark
mark

mark

(T:Group 01

1:Group 01

/

1 L E 0 0 D 0 D

/

Mark added in computation
channels of the Integration
software’s channel screen

T~ Mark added by

Viewer software
Mark added in the

kid

Integration software’s
Monitor screen

Ready

! T T

Names of groups with marks
If the groups have no names, all groups are marked
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3.2 Display Settings

The alarm/mark list display’s cursors are linked with those of the waveform display and
numeric display layout screens. Alarms or marks selected with the cursor in the alarm/
mark list display can be copied to the clipboard using the Edit > Copy command.

The alarm/mark list can be converted to ASCII, Excel, or Lotus format (see section 3.7).

Alarm display limitation: One file can display a maximum of 10000 alarms.

Left-to-Right Alarm Search (Waveform Display Screen Only)

Move cursor A to the next alarm change point on the left
Move cursor A to the next alarm change point on the right

Move cursor B to the next alarm change point on the left
Move cursor B to the next alarm change point on the right

T HARWHBBY  00meec

B | Alarm display
(] . ‘ & [fumes i
A B
CursorA  Cursor B

Select the active channel

Left-to-Right Mark Search (Waveform Display Screen Only)
In the waveform display screen, move cursor A and B to the right or left side of the mark.
From the Edit menu, choose Mark Search. Or click the corresponding toolbar button.

Edit Wiew ‘Window Convert Information Help

Copy [T ] ‘@ &| @
Selact Al s —————

Erase Cursor

Right Move Cursor &
Left Move Cursor A

Right Move Cursor B
Left Move Cursor B

Append Mark ... Ctri
Delete Mark
Reset Mark

Move cursor A to the left mark
Move cursor A to the right mark

Move cursor B to the left mark
I\{Iove cursor B to the right mark

IR EE I R R
(@], S, [0 B 0 10 " E |65 0| 14 A f4m ol

Mark

The marks added in the Integration
software’s Monitor screen are orange,
marks added in the computation
channels are yellow, and those

added in the Viewer software are green.

IM MX180-01E
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3.2 Display Settings

Numeric Display

Numeric display can be shown along with the waveform display window. When a group
contain channels with different measurement intervals, the screen is divided accordingly.
The display group, active channel, and mark display are synchronized to the waveform

display.

If cursors are displayed on the waveform display window, the data values between the
cursors are displayed in red. Also, the data column corresponding to the cursor position

is displayed in gray.

Switch the display Active channel (Y-axis displayed Display per record interval
group on the waveform display) Channel display color
sheetiaemosmsl N =g
[M File Edit [fiew Window Convert Information Hefp 18 x|
B Bk e mE o\EEEB IS ?
Group 1 | Group 2 ) s J N\
\
[ — CHOOO0 CHOOOnZ ] (B CHES002 al
Ahsalute Timelto] 1v] AR ') I e | Absolute Time{No.]
2008/0123 15:45:14 10000000021 J1I -1.3303 | -1.2457 EOUGRITTES 1590 19590 -3.2481
J00A/01 723 15:45:14 200[00000022] 14084 | 12629 2008i01/23 15:45:13.60 34187
I? 2006/01 723 15:45:14 A00[00000023] 14265 -i.2781 2008i01/23 15:45:13 80 35670
2006/01 723 15:45:14 400[00000024] 14417 | 2318 2008i01/23 15:45:14.00 36837
200810123 15:45:14 500[00000025] -1ases 1000 -1.3035 2008AT1/23 15:45:14.20/| 0000001 1 37898
2006/01 123 15:45:14 HO0[00000026] 14657 | 4334 ) 2008i01/23 15:45:14.40 |0 36847
2008/0123 15:45:14 700[00000027] 14745 [0 13213 2008123 15:45:14 60 | OF 38470
2008/01423 15:45:14 800o00000ze] | [II ez [0 -1.3274 200811/23 15:45:14 60 38712
I 0N P 4 54514 niNnN00028] 1 4860 1336 20080 /23 154515 00)\Q0N0n 5, -4 0030 V‘
)M! b
Read;\ | T mm[
|
. Mark Data number Value
Horizontal scroll S )
indication Date/Time Alarm

Nofte

* If you open the numeric display window when two cursors are shown on the waveform

display window, the data in the interval between the cursors is displayed in red. If you
choose Copy from the Edit menu (press the Ctrl + C key) in this condition, the data in the

interval is copied to the clipboard as text data.

* Up to 1000 lines can be copied. (Copy on the Edit menu is not available if the number of

lines specified by the cursors is above 1000.)
» |f data of multiple measurement intervals is displayed, the data in the interval between the
cursors on the data sheet with the active measurement interval is copied. (The newest line
is displayed in light blue on the data sheet with the active measurement interval. The newest
line and the newest column are displayed using the same color on non-active sheets. You
can activate a sheet by clicking the sheet.)
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3.2 Display Settings

Initializing, Copying, and Pasting of Settings on the General Display

Settings Window

On the General Display Settings window, you can reset the settings to default or copy
and pate the settings of one or multiple waveforms to the settings of other waveforms.
You can copy and paste according to the procedure below.

Drag the copy source waveform numbers (No. column), click the Copy button, drag the
copy destination waveform numbers, and click the Paste button.

Drag to select a range <
Click to select all the channels g
(]
| Genedbl Display Settings x| =
m| \2|Uﬁ|04|US|UE|U?|UB|UB|WU|M |12|13|14|15|1s|17|1a|19|2u|21 |22|23|24|25|2s|27|2a|29|3u|3'4| B
ro|s e :
O ) Scale Zone &
Ho Channel Mo W Axis  Form Tript Trip2 Color
Min. Maz. Min.  Max.
) CHODDO1 Linear{] =20 20 o 10 a0 10
Wiz CHOOODZ Linear] -30000.0 30000.0 0o 10 200 =0 [
|| IFfins CHODDOZE Linear{] . 300000 30000.0 o 10[d 200 20
[ s CHODDDA Linear{] 300000 30000.0 o 10 [d 20 0 30
W05 CHODO11 Linear{] -0.2000 0.2000 o 10 -nz2000 [ 0.2000
[ woe CHODDM 2 Linear{] 300000 300000 o 10 300000 [ 300000
w7 CHODDM 3 Linear{] 300000 300000 o 10 300000 [ 300000 [T
w0z CHODD1 4 Linear{] 300000 300000 o 10 300000 [ 300000
(] CHODD S Linear{] =30 30 0
o CHODDME Linear{] 3 3 0
w1 CHOOO 7 Linear4] -3.0000 30000 0 I A .
iz CHODDM & Linear{] -3.0000 3.0000 0 Click this button
iz CHODD9 Linear{] -3.0000 3.0000 0 to reset to
H w1.4 CH?Uuzu Llnearg ) -3.0000 3.0000 0 default settings
@q =®, 7 |® 2 <=gonn wmon 0
¥ g L5 3 x
‘ oK | ‘ Cancel | ﬂ Seals Calc )
T
To set the scale to match ~ To copy To not copy/paste the item,
the maximum and minimum  the settings click to hide the flag

values of the data
Click this button to enter the same settings
as the first channel in the selected range

Click this button to automatically assign the channels To copylpaste the item,
in order click to show the flag.

Click this button to turn ON/OFF the channels collectively

To paste the copied settings

Applying Data File Display Conditions
Group display conditions set using Viewer (including group data display conditons
reflecting the use of templates or the display conditions setting file) are cleared, and the
channel display returns to the data file display settings.
The settings configured using the tool buttons in the upper part of the waveform display
screen for each group (alarm display ON/OFF, time axis zoom in/out, display zone
switching, grid display switching, and grid display ON/OFF), and the grid color and
waveform background color settings are restored to their default settings.
Alarm display ON/OFF

Zoom in or out of the time axis

Switch the display zone

Switch the grid display
Clip display ON/OFF

Ii Move the cursor to the point where the alarm changed

Goup 1 | Groupz

1
@) S T D 4R A 4B B 100mses
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3.3 Reading Values Using Cursors

Procedure

1.

2.

On the waveform display window, click the tag of the group from which you wish
to read the value using cursors.

Click the position of the desired data in the waveform display area of the
waveform display window.

If you wish to read another point simultaneously, drag the cursor. Cursor A appears at the
position where you first clicked; Cursor B appears at the position where you released the
mouse button. A yellow circle is displayed where the waveform and the cursor cross.

You can move the waveform that is displayed in the waveform display area using the scroll
buttons or scroll bar.

Group selection tab

T-“Ms\n ey mEa e BEEEBH ST

Group1 | Group 2

@|®, C, I Bl EE | F[l4{4 B]  100meec) @GS TR Y EE |

Cursor B Measurement point

Cursor A

From the Window menu, choose Control.

Window Convert  Information
Cascade
Tile
Arrangs Icons

Graph

Sheet

Graph/Shest Layout »
Alarm/Mark.

v 1 Graph[data-0007.mxs]

The Cursor Value window opens.
Time at Cursor A
Data number at Cursor A
Time at Cursor B
Data number at Cursor B

Time between Cursors A and B

Move Move Difference in the data number
CursorA[ | CursorB | petween Cursors A and B
L l|_ L] l|_ -|— o
Cur:| Curse| E| Differe|ce ‘ Cursor & Cursor B Difference
Dt Mo ﬂa © Dt Mo 13 §| 43 §| 30
—\— {
Absolute Time é:ufzfg ijO 000008 000 Absolute Time: 1?1'] :f; gzgo éuff'f; TDSO 000008, 000
Channel Yalue B Value B - Valus & Channel Walue & “alue B YWalue B - Valus &
CHOOOD [] J CHaaNM N 26937 50596
CHOODO2{Y] CHesoz() - | 3.8209 TATES
CHOOOO3[] CHag|o3) Ml -1os44ss [0 11778 221 2375
CHOOO04[Y]
Alarm Channel display color
indication Readout value of Cursor B - Readout value of Cursor A
Channel number and Readout value of Cursor B
measurement unit - Readout value of Cursor A
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3.3 Reading Values Using Cursors

Clearing the Cursor
From the Edit menu, choose Erase Cursor.
The cursors are cleared as well as the cursor values displayed in the Cursor Value dialog
box.

Explanation

Reading Measured/Computed Values Using Cursors

Two cursors can be displayed. The following values can be read on the Cursor Value
window.

» Values at the cursors.

+ Difference in the value between the cursors.

* Absolute time and data number at the cursor position.

» Time between the cursors and the difference between the data numbers.

» Alarm status of the value at the cursor.

S
o
3
o
o

Nofte

* The cursors used to display cursor values and those used to specify the interval for
statistical computation over an area are the same.

* The Cursor Value window and the Statistics window can be displayed simultaneously.

« If you click the tab of another group on the waveform display window while the Cursor Value
window is open, the cursor values of the selected group are displayed on the Cursor Value
window.

* You can change the cursor positions on the waveform display window while the Cursor
Value window is open.

* If you choose Select All from the Edit menu, Cursor A is displayed at the first data position
and Cursor B is displayed at the last data position.
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3.4 Statistical Computation over an Area of
Measured/Computed Data

Procedure

1. On the waveform display window, click the tab of the group on which you wish to
perform statistical computation over an area.

2. Click the start position of the computation area in the waveform display area.
A light-blue cursor appears in the waveform display area. If multiple waveform display areas
are displayed, the cursor is displayed at the time position each waveform display area.

3. Drag the cursor to the end position of the computation area.
Another light-blue cursor appears at the position where the cursor was dragged.

Group selection tab

B e =

Group 1 | Group 2

PECCI R = IR e e C L e Fli(ar]  ooomse

i3 e

Cursor (the end of the statistical computation over an area)
Cursor (the start of the statistical computation over an area)

4. From the Window menu, choose Statistics.

window Convert Information
Cascade
Tile
Arrangs Icons

Graph

Shest

GraphyShest Layout 3
AlarmfMark

v 1 Graph[data-D007.mxs]

The Statistics window opens.

Data number at the start position

of the statistical computation Maximum value - Minimum value

: over an area .
Channel display color Minimum value RMS value
| Channel Start Data N|1. | End Deta Mo, y
(Crnnnnt) 13
N CHULUUZ| Y| 1 13
CHOO0O3(W] 13
CHOOOO4[Y] 13
CHI9001(] 7
CHI9002(] 7
CHBB% 7
( )
Channel number and Maximum Value Average value
measurement unit Data number at the end position of the

statistical computation over an area
Copy data to the clipboard
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3.4 Statistical Computation over an Area of Measured/Computed Data

Explanation

Statistical Computation over an Area

Specify using two cursors the interval over which computation is to be performed.

If the cursors are not displayed, all the data are used in the statistical computation.
The statistical parameters are the minimum value, the maximum value, the P-P value
(maximum — minimum), the average value, and the rms value.

Copying Data to the Clipboard

If you click the Copy button, the results of statistical computation over an area are copied
to the clipboard as text data. You can press Ctrl + C when the statistical computation
over and area window is active to copy the displayed results as text data to the clipboard.

S
@
=
(]
=

Nofte
* To redo the computation after changing the computation area, you must select the “statistics
calculated over an area display window” button (see “Procedure” in section 3.2) or the menu
command again.
» The cursors used to specify the interval for statistical computation over an area and those
used to read values are the same.
¢ The Statistics window and the Cursor Value window can be displayed simultaneously.
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3.5 Saving the Display Settings

Procedure

1. From the File menu, choose Save Display Setting File.

You can also click the E button on the toolbar.
The display setting file is created in the same folder as the data files.

Fle Edt Visw Window Convel
open... O
Close

Save Template
Use Template:

Sync-Frocess...

Pt Chri+F
Preview

Print Sethings ...

Print Setup...

1 data-0011.mxs

Exit

When Closing the Viewer
If you open a file and change the display settings, the dialog box below opens when you
attempt to close the Viewer. To save the changed display settings, click Yes.

Explanation

x

& Save changes to data-0507-1804.mxs?

Yes Mo | Cancel |

Display Settings That Are Saved

Information about the group whose waveform or numeric display is open.

Settings entered using the tool buttons at the top section of the waveform display area
of each group.

Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
Cursor position (absolute time).

General Display Settings on the View menu.

Channel No., Tag ID, and Tag comment settings on the View menu.

Absolute Time or Relative Time setting on the View menu.

Graph/Sheet Layout setting on the Window menu.

Check box items in the File Information dialog box on the Information menu.

The items are used as headers when the data is printed.

Print setting on the File menu.

Range, Color, Print Groups, and Comment.

Marks created on the Viewer.

Position of the display screen.

Display Setting File

The display setting file (with the .mxv extension) is created in the folder containing the
data files. If the data file name is data.mxs, the display setting file name is data.mxs.mxv.
The next time the data file is opened, the display opens according to the information in
the display setting file.

If the display setting file is deleted or moved to another folder, the display opens
according to the display settings used when the data file was created.

Nofte

You cannot open a file containing the data you wish to view by selecting a file with .mxv
extension.
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3.6 Saving the Display Template

Saving Templates

1. From the File menu, choose Save Template.
The currently displayed settings are saved as a template file to the same folder as the
displayed data.

[Fie Edt view Window Convel
Open... Ctri+O
Close
Save Display Setting Ch+5

S
o
3
o
o

Save Template

Use Template:

Using Templates

1. From the File menu, choose Use Template.
If the currently displayed data is not in the display conditions file, it is displayed according to
the setting information of the template file residing in the same folder.
If the currently displayed data is in the display conditions file, it is displayed according to the
setting information of the display conditions file.

Explanation

The template file is saved with the name default.mxt in the folder of the currently
displayed data.
When using a template file, the template file residing in the same folder as the displayed
data is used.
The setting information saved to the template file is as follows.
 Information about the group whose waveform or numeric display is open.
» Settings entered using the tool buttons at the top section of the waveform display area
of each group.
Alarm display ON/OFF, magnification, scale, clip ON/OFF of the waveform display.
» General Display Settings on the View menu.
» Channel No., Tag ID, and Tag comment settings on the View menu.
» Absolute Time or Relative Time setting on the View menu.
* Graph/Sheet Layout setting on the Window menu.
» Check box items in the File Information dialog box on the Information menu.
The items are used as headers when the data is printed.
» Print setting on the File menu.
Range, Color, Print Groups, and Comment.
+ Position of the display screen.
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3.7 Converting Data Formats

Procedure

Select whether to set the rang T ——
to be converted using groups \ i
or channels e 1)

Select the record interval —

Only the channels with the selected
record interval are converted.

From the Convert menu, choose To ASCII, To Excel, or To Lotus.

Convert  Informati
i ToASCIL..
© ToEsxel..
! Tolotus...

After entering various settings in the dialog box that opens, click OK. The file is
created at the specified destination.

Waveform, Numeric, or Waveform/Numeric Display

Enter the range of group numbers to be converted

Enter the data range to be
converted

Can be specified using cursors
before opening this dialog box.

Explanation

x|

NCranre ( chooom - cheaos ) Select the range of channels to be

Interval = Tdomeet T 200msac converted
& & Click to open the selection dialog box.

~ Select Data No.
start [ EEEEE:E :E :zzs Displays the time of the specified data
51671 5 157 H
C T G, Step when saving data at certain intervals
Save a

(F”e CLTAE TSI TS eSS ) File ‘

0l I Cancel |

Displays the save destination =~ When changing the save destination or file name
and file name Click to open the save destination and file name
setup dialog box.

Alarm/Mark List Display

Alarm List Conversion

X

Save as
’7 File: (CE._\data-0008 myxs Alarm bt ) File.... "

oK | Cancel |

When changing the save destination or file name

Displays the save destination and file name Click to open the save destination and file name setup
dialog box.

B
Save a
{ B e @‘

QK | Cancel |

Data Formats for Conversion
« ASCII

Text data with each data point separated by a comma. The extension is .txt.
» Excel

Data that can be opened using Microsoft’'s spreadsheet application Excel version 4.0
or later. The extension is .xIs.

* Lotus
Data that can be read using IBM’s Lotus 1-2-3 spreadsheet program version 2.0 or
later. The extension is .wj2.
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3.7 Converting Data Formats

Converted Data
Specify the range using group numbers or channel numbers. You can select the channel
number by clicking in the dialog box as shown below.

51
CHOO001 CHOO002 CHOO0O3 CHOOOO4
CHOOO11 CHOOO12 CHOOD13 CHOOO14
CHOOD1S CHOODME CHOODMT CHOOD18
CHOO0M19 CHOO020 CHOO021 CHOO022
CHOO023 CHOOO24 CHOO025 CHOO02E
CHOOO27 CHOOO28 CHOO029 CHOO030

Cancel

If multiple record intervals exist in the data to be converted, select the recording interval.
Only the data of the channels having the selected recording interval is converted.

Conversion Range and Step

You can specify the range using data numbers or by using cursors. For information on
specifying the range by using cursors, see “Procedure” in section 3.4. By specifying the
step, you can save data sampled at certain intervals rather than converting all the data in
the range (when step is set to 1).

Display Example of the Converted Data

a [ 8 [ ¢ [ o T & T 7 T e [ w [ 1 T o T w T ¢ 3
| 1 MX100 Standard R3.01 -
| 2 |Data Viewsr R3.01
3|
4
[ 5 |File Name data-0007.mxs
| 6 |File Recovery Mone
| 7 Creatar Data Viswer
| 8 |Sync—Process Done
| 9 |Start Conditian Start Paint
[ 10 |End Condition End Point
| 11 |Start Time 2008/01 /2151440 0500
| 12 |End Time 2008/M /2152115 0600
[ 13 |File Message
[ 14 |File No 0
[ 15 |Num. of Ch 17
[ 16 |Mum of Ref. File 1 =
[17 |Ref File No 0- 0
[ 18 |Recard Interval 0100 Second
[ 18 |Converted Step 1
[ 20 |Num. of Comverted CH 15
| 21 |Num of Comuerted D= 83
[ 22 Camerted Group 1- 2
| 23 Ch CHOOO0! CHOO002 CHOOO03 CHOO004 CHOOO0I1 (GHOOOIZ CHOO013 CHOOO14
| 24 Tag Mo Tag00001 Tag00002 Tag0003 Tagi0004 TagdOoi1 Tag00012 Tag00013 TaglO01£
[ 25 | Tag Comrmi TagGomme TagGomme T agGomme TagComme TagComme TagCommeTagGamme TagCornm
[ 26 |Mark Dats Tims Second W
| 27 | 2008/01 /21514:40 0600, -1.3884 12441 -11015 08592 00011 —0.0078 00507 -0047
| 26 | 2008/01/21514:40 0700 14078 12615 11170 -08726 -00032 -00075 00524 0047
| 28 | 2008/01/21514:40 0800, 14253 12771 -11307 —08B46 00035 -00076 00539 -0048
| 30| 2008/01/21514:40 0800 -1.4406 -1.2008 -1.1428 -08853 -00037 -0.0076 00352 -0048
[ 31 ] 2008/01/21514:4 0000, —1.4542 13030 -11538 10047 -00055 -00073 00569 -0045

a9 ON0RSON /E1514-01 0100 —1 46RF 13132 -1 1627 -1 025 —0 0059 —00071 OOSA0 —0 080

Notes When Converting Data

There is a limit in the number of data points that Excel and Lotus 1-2-3 can handle.

Before conversion, set the data to be converted, the conversion range, and steps such

that the number of data points is appropriate. In addition, if there is little free memory

in the PC, Excel or Lotus 1-2-3 may not be able to load the data.

» If conversion conditions are specified that exceed the limitations of Excel or Lotus
1-2-3, the data is automatically divided before conversion. Therefore, multiple files are
created. The file names are assigned automatically with sequential numbering. (For
example, when converting the file “data.mxs” to Excel format, if the data is divided
into n number of files, they are named data.mxs.0000.xls, data.mxs.0001.xls, ..., data.
mxs.000n.xIs).

» Up to 65510 data and 252 channels are saved to a single conversion file (when
columns are channels and rows are data).

» If you set the save destination to a storage medium that has slow access such as a
floppy disk, the saving of the data may take an extended time. It is recommended that
such storage medium not be selected for the save destination.

» Select a save destination with adequate free space.

» The measured data during a burnout or measured data that exceeds the upper/lower
limit of the measurement range are indicated as “OVER”or “OVER”

+ Ifinvalid data exists in the converted data (measured value of a channel without input
or computed value when the data used in the equation does not exist), the data is
indicated as “INVALID”

IM MX180-01E
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3.8

Printing the Data

Setting the Contents to Be Printed

1. From the File menu, choose Print Settings.

2.

File Edit iew Window Convel

Open... Crl+O
Close

Save Display Setting Ctrl+S
save Template

Use Template

Sync-Process. .

Print... Chrl+P

In the Print Setting dialog box, set Range, Color, and Print Group, and then click

OK.

Enter a comment in the Comment box as necessary.

When printing numeric values, only a print range need be selected.

Select to print all or print only the range specified by cursors

Printout Sett ng

Graph Prift |Sheeanm|

Switch to settings for numeric values

Select the group to be printed

rRang Color

= Al s Cursn' ( Blackiihite ¢ Color

[ Print Group

((‘ On Display Only & All Groups  Selected Groups) ( Gelect.. }

Comment I

[ o< ]]

Cancel

Settings for numeric values

Enter the comment to be printed

Printout Setting

Graph Print  Sheet Print |
Range

@ Al  Gursor

Cancel

Select monochrome or color print

Select the groups when Selected
Groups is selected

Click to open the group selection
dialog box
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3.8 Printing the Data

Executing the Print Operation

1. From the File menu, choose Print.

2.

Print Preview

Setting Up the Printer
1.

2.

The Print dialog box opens.

In the Print dialog box, select the printer, print range, and the number of copies,

and then click OK.

When printing waveforms, you cannot set the print range.

Display example of the Print dialog box

Open... CtrHO ~Frinter
close
Save Display Setting CtrHs Name: | \PSZEEPrint x| Propetes..
Save Template Status Fisady
Use Template
Type:  Canon PS-IPU Color Laser Copier v52.3
Syne-Process... - Where:  \\PSZHEE\Print
Frint... ChrHF Comment I~ Prit to file
Preview
Print Settings ... - Print rana Capi
Frint Setup.... = Al Number of copies: |1 H:
© Pages fiom o
J¥# | Coflat=
) Selection

From the File menu, choose Print Preview.

The print image is displayed

File Edt View Window Conver
Cpen... ctrto

Close

Save Display Setting CtrHS

Save Template

Use Template

Sync-Process...

Prink. CtrP

Print Settings ...
Prink Setup. .

\

Frint... Iexi Page | Frey Page | | Two Page

Zoom Qut Close

From the File menu, choose Print Setup.
The Print Setup dialog box opens.

Set the paper size, orientation, and other settings. Then, click OK.

CFle Edt Wew Window Conver T
Open... Cti+0 .
Close
Save Display Setting Chri+5 HName:  [\\PSZRE5 Frint =] Propeties
Save Template S Gl
alloeiy > Type:  CanonPSHPU Color Laser Capier v52.3
Sync-Process. . Where:  \WPSZXEE\Print
P kP e
Preview
Print Settings ... - Praper Orientation

Display example of the Print Setup dialog box

Size: Letter -
Source: [ Automatically Select -

& Porrait

Network.

Cancel

IM MX180-01E
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3.8 Printing the Data

Explanation

Printed Items
To print waveforms, open the waveform display window; to print numeric values, open
the numeric display window; to print alarm or mark lists, open the alarm/mark list display
window. If multiple waveform display windows or numeric display windows are open, click
the window you wish to print.
Also, to print alarm/mark lists, cursor values, or statistics calculated over and area along
with waveforms, display those windows as well.

Print Range

If you wish to print only a specified range of the waveform, specify the range using
cursors. For information on specifying the range by using cursors, see “Procedure” in

section 3.4.

Printed Colors of Waveforms

You can select to print in black and white or in color.

Print Groups

» On Display Only
Only the groups whose waveforms are displayed are printed.

» All Groups

All groups that can be displayed on the waveform display window are printed.
» Selected Groups
Groups selected in the dialog box that opens (see the figure below) when the Select
button is clicked are printed.
select Growps

¥ Group 1

¥ Group &

¥ GROUP1H
¥ GROUPTE
¥ GROUFZ]
7| GROUPZE
¥ GROURS]
¥ GROUR3E
I¥| GROUR4

¥ GROUR4E

¥ Group 2 ¥ Group 3

W Group 7 I Graup 8

F GROURIZ ¥ GROUP{Z
F GROUPIT ¥ GROUPTE
¥ GROUPZZ ¥ GROUF33
FF GROUF2T ¥ GROUPZE
F GROURAZ ¥ GROUP3Z
¥ GROUFET ¥ GROUF3E
¥ GROUPAZ ¥ GROUF42
F GROURAT ¥ GROUP4E

x|

¥ Group 4 ¥ Group &

¥ Group 8 W | Group 0.

¥ GROUP{4 F GROUP1S
¥ GROUPTE F GROUPZ0
¥ GROUFZ4 ¥ GROUPZ5
¥ GROUPZI FF GROUF20
¥ GROUP34 F GROUR3S
¥ GROUF39 F GROUF40
¥ GROUF44 ¥ GROUP45
¥ GROUP4Y ¥ GROURSD

GCancel

Printing a Comment
You can enter a comment using up to 127 characters. The comment is printed in the Print
Comment column.

Printing File Information
When you print data, the file information is also printed. You can check the file information
in the dialog box that appears when choosing File Information from the Information

menu. You can also select the items to b

x|

W File Name
¥ File Recovery
W Syne-Process
W Creatar

¥ File Na

¥ File Message

¥ Ref. File Mum.
¥ Ref File No.

W Print Comment

data-0507-1804 mxd W StartTime 2003M05/07 18:04:15.470
Naone ¥ End Time 2003/06/07 18:04:33 536
Hone [ Start Condition Start Faint

M100 Standard Logger ¥ End Condition Divided Point

0 ¥ Channel Murn 18

o |

Cancel

e printed using the check boxes.
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3.8 Printing the Data

Print Example
*  When only the waveforms are printed

File information

S
]
g
(]
=

|
|
|

» When cursor values, values of statistical computation over an area, and waveforms

are printed

I— File information

Statistical
computation
over an area

Cursor values

BT
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3.8 Printing the Data

*  When printing an alarm list

Alarm List [ test take-0831-1511.mis | W7
Chame | Level T Alarm 4 Alarm OFF
CHOOOO1 L1 L W0A/08431 15211248000 W0A/08431 15211248 400
CHOOOO1 L1 L M04/08431 15:11:49. 000 W0A/08431 15:11:49_ 200
CHOOOOT L1 L 2004/0%421 15211250000 2004/08421 15211250 200
CHOOOO 1 L1 L 004/0843 15:11:51.000 004/0843 15:11:51. 400
CHOOOO 1 L1 L 004/0843 15:11:52.000 W04/0843 15:11:52. 200
CHOOOO1 L1 L 0408431 15211253000 M04/08431 15211253200
CHOOOO1 L1 L M04/08431 15211254000 A04/08431 15211254200
CHOOOOT L1 L 2004708421 15211255000 2004/08421 15211255200
CHOOOO 1 L1 L 004/0843 15:11:96.000 004/0843 15:11:96.200
CHOOOO 1 L1 L 004/0843 15:11:57.000 W04/0843 15:11:57.200
CHOOOO1 L1 L 0408431 15:11:58. 000 M0A/08431 15211258200
CHOOOO1 L1 L M0A/08431 15211258900 M04/08431 15211259200
CHOOOOT L1 L 2004/08431 15211259900 2004/08431 152122000200
CHOOOO 1 L1 L 004/0843 15:12:00. 900 004/0843 15:12:01.200
CHOOOO 1 L1 L W004/0843 15:12:01.900 004/0843 19:12:02. 200
*  When printing a mark list
Mark List [ test_take-0331-1511.mws 1 il
Absolute Time Mark & oup Rind
2004/08¢31 15:11:48 400 Mt kD Wiemer
2004/08¢31 15:11:49 600 Mark Mo itor
20040831 13211252 470 Mark Monitor
2004/08/31 15:11:95. 900 Mar ki 1:Group 01 Wiewer
200440843 15:11:59.420 Mark Monitor
2004/08¢31 15:12:04 320 Mark Mo itor
2004/08¢31 15112206 780 Mark Mo itor
2004/08/%1 13212210600 bark2 1:Grove 01 Viewer
200808/3 15:12:14 350 Mark Monitor
20040843 15212217800 Mark3 1:Group 01 Wiewer
2004408431 15212219170 Mark Mo itor
2004/08/31 15112126330 Mark Mo itor
2004/08/%1 13212228 600 Mark Viewer
200440843 15:12:31. 440 Mark Monitor
200008/3 15112136550 Mark Monitor
*  When printing a list of numeric values
Data List [ dats-0007 .mees ] vEa
s ST |G| G| e
Absoitt Tme Plo] 1] [ [0l M

ez 1914 0 g “awo s oores

T ALY AN NES) I T

ez v EE=T e

iz 1914 o zwpomon BT EE o

Sz g [T s

oz 14 BT EE

iz 14 o rpomm EE

ez g [T —

0z 1 v soogoEmg EEE

iz 14 2 zpomg EEC

Sz g [T ——

iz 14 2 pomea

Sz i g [ —— =

o EXED

e v ERET

iz 1914 o zepomen s

Sz g [ ——

ez v s

S 1 g s

iz 14 o g oms

Swowzs 1 rgo [ e

0z 1 v soogoEg <o

iz 1914 gy EIED

AT T s

oz 1 vk g oz

oz 1 g e

iz 14w rpomia

o i g i

oz 51 vk soogoEmg E¥Er

i v <5

iz 14 5 zpomn

AL Ee T

e 1 g

oz e gD

iz 14 5 Tpomen o

S G g o

o i s
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Chapter 4  Calibrator

41 Connecting the MX100

Procedure

Notes before Using the Calibrator

+ If the MX100 is connected using the Integration Monitor, drop the connection before
connecting the MX100 using the Calibrator.

+ If you change the module configuration before connecting with the Calibrator, use the
Integration Monitor to reconfigure the system (see section 2.2).

1. Start the Calibrator.
The Unit Information window opens.

2. Inthe IP Address/Host Name box, enter the IP address or host name of the
MX100 to be calibrated.

3. Click Connect.

Enter the IP address or host name of the
MX100 to be calibrated.

I = 3|

Edcalibrator
Fle View Help

Unit Infarmation

P Address /Host Name (19216811 ) EomecHpd s L Exacute connection

Minclel

Serial Mo,
MAC Address

“ersion

Supply Frequency

Ready

IM MX180-01E
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4.1 Connecting the MX100

When the connection is established, information about the unit's module
configuration is displayed.

To disconnect the connected MX100

To illuminate the 7-segment LED of the
connected MX100 to see which MX100 is

Information about the connected MX100 connected

=i

File View Help

Uit Information

P Address /Host Nahe 19206811 | [comnent]

Minclel ME100

Serial Mo, 222223221

MAC Address 00:00:64:54:81:73
“ersion R3M

Supply Fraquency S0Hz

— Modules attached to the
connected MX100

Ready

If the specified IP address or host name is not correct, or the MX100 is connected
by another software program, the following dialog box opens.

warnina

Wa700
"\ Conmection failre,

Check the IP AddressiHost Name ar Calibration mode.

Nofte
¢ You cannot change the MX100 network settings using the Calibrator. Use the Integration
Monitor (MX100 Standard Software) to change the IP address and other settings.
¢ If you change the module configuration before connecting with the Calibrator or if modules
that are not operating properly exist, X marks are displayed on the modules as shown
below.If you change the module configuration, use the Integration Monitor to reconfigure the
system.

*  When using Windows XP or Windows Vista with the firewall enabled, recognition is
sometimes not successful even when clicking the Search button. To solve the problem,
see appendix 1. (The same problem may also occur if your anti-virus software is using a
firewall.)

IM MX180-01E



4.1 Connecting the MX100

Setting a Password for Startup
You can use the following procedure to set up the Calibrator so that it prompts the user
to enter a password upon startup.

Explanation

1.

Nofte
To set up the Calibrator so that no password dialog box is displayed, open the password setting
dialog box, make sure the entry boxes are blank, and click OK There is no other way to cancel
the password, so make sure you do not forget the password once it is set.

From the File menu, click Set Password.
The password setting dialog box opens.

File View Help
Write. Mew Password
—

Mew Password(reenter)
0K I Cancel |

Click the New Password box, and enter a password.
There are no restrictions on the characters that can be used in the password. However, the

number of characters used must be no more than thirty.

Enter the same password in the Confirm New Password box, then click OK.
When the Calibrator is restarted, the password confirmation dialog box below appears.

If an incorrect password is entered and the OK button is clicked, the message, “Incorrect
Password” is dipslayed in a dialog box. Click OK to exit the Calibrator.

x
Passward |

Checking the Connected MX100
When the connection is established, the Unit Information window shows the serial

number, MAC address, and input/output modules of the connected MX100. If you click
the Check button, the 7-segment LED on the main module of the connected MX100
shows the text “--CALL--" flowing from right to left.

IM MX180-01E
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4.2 Calibration Procedure

Notes on Calibration
» Do not perform other operations during calibration. Take extra care because if you
perform another operation while calibration is in progress, the module may suffer a

break down.

* When connecting the plate with screw terminals (model 772080) to the 10-CH,
Medium-Speed Universal Input module, note that the terminal arrangement is different
than when connecting clamped terminals.
With the calibration software, modules to which plates with screw terminals are
connected are recognized as clamp terminals, meaning that the wiring diagrams show
the wiring for the clamp terminals.
Therefore when wiring and calibrating, refer to the text describing the terminal function
and terminal symbols that show the type of signals input to each terminal that are
printed on the back of the terminal cover of the 10-CH, plate with screw terminals.

; CHe ; CH1
2 CHT : Ch2
: CHe : CH3
; CH9 ; CH4
190 CH10 1% CHS

FA11 RTD @11 RTD

Procedure

Note: The b terminals are common to all channels.
They are connected internally.

1. Click the illustration of the input/output module that you wish to calibrate.

Edcalibrator [

File View Hlp

IP Address fHost Mame
Minclel

Serial Mo,

MAC Address

“ersion

Supply Fraquency

Ready

Unit Infarmation

19216811

| [correct | pissonnect| | check

MO0

122222221

00:00:64:54:81:73

RIM

50Hz

=1o1x]

— Moving the pointer over
an module that can be
calibrated shows the word
“Calibrate”
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4.2 Calibration Procedure

2. On the calibration detail setup screen that appears, select the channel and range
to be calibrated and click the >> button.

The figure below is an example of the 4-CH, High-Speed Universal Input Module.

Edlcalibrator

File View Help

Module: o

Serial No 120123456

Calibrate time Ch.1 1970/0101 090000
Ch2 1870/0101 09:00:00
Ch.3 1970/0101 09.00.00

Chd 1870/0101 09:00:00

Channel Cha -~
Range 20 mY Range
Ready

]

o/

Range
20 mY Range

60 m Range

200 m Range

1V Range

2V Range

6 Range

20V Range

2
2
=
=

Items to be calibrated
You can also click to select

e
RTD(1 mA)200 mY Range
RTD(1 mAJ00 mY Range
RTD(1 m&) ¥ Range
RTD(2 mA)60 my Range
RTD(2 mA)200 mY Range
RTD(2 mAJ00 mY Range
RTD(2 mA) ¥ Range

oo i

L o

OO00O00O0O0mOoOooOonoo
o o

¥
v
-

Select the channel and the
measurement range to be
calibrated from the list

— To move to the calibration
execution screen 1

The figure below is an example of the 10-CH, Medium-Speed Universal Input
Module. Channels are not selected.

Edcalibrator

File View Hlp

Module 1 Range
Serial No. 12123456 20 m Range: @'
i 60 m Range 1
Calbrate time 20030240 16:2205
200 m¥ Range 1
Range 20 mY Range B T o
2 Range 1
6 Range 1
20 Range 1
100  Range 1
RTD(1 m&)60 mY Range [
RTD(1 m&)200 m Renge [
RTD( ma)600 m Range [l
(I
Ready

I = 3|

|_~Items to be calibrated
1

You can also click to select

Select the measurement
range to be calibrated
from the list

— To move to the calibration

execution screen 1

The figure below is an example of the 30-CH, Medium-Speed DCV/TC/DI Input
Module. Channels are not selected.

EJcalibrator

File View Hep

hodule 0
Serial Mo, 120123456
Caillrste time: 20030113 18:51:04
Range (|20 mv Range
[ =

Ready

3
¥

I ] o3

Ranoe |_~ Items to be calibrated
20mY Range @/ You can also click to select
60 my Range
200 mY Range [
VR T Select the measurement
. E range to be calibrated

ange .

R 0 from the list
100 Range O

— To move to the calibration
execution screen 1

IM MX180-01E
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4.2 Calibration Procedure

The figure below is an example of the 6-CH, Medium-Speed, Four-Wire RTD
Resistance Input Module. Channels are not selected.

i
File View Help
Mocluls 1 Renge |_~Items to be calibrated
Seriel o, 12¢123458 2 Range 9/ You can also click to select
' §0 mY Range
Calbrate time 200410715 22:40:47
200 m¥ Range 1
Fenge (XTI T T Select the measurement
2V Range S range to be calibrated
£V Range .
20 Frange 0 from the list
100  Range 1
RTO( ma)20 my Range 1
RTD( maJE0 mY Range 1
RTO( ma)200 my Range 1
RTO( maJE00 my Range 1
RTD0.25 mAYE00 mY Range [
RTD(0.25 mAJ1 W Range 1
(L= )7 To move to the calibration
Ready execution screen 1

The figure below is an example of the 4-CH, Medium-Speed Strain Input Module.
Channels are not selected.

_[o ]
File View Help
Module: 2 Range I
/Items to be calibrated
Serial o 126123456 2000LSTR Range You can also click to select
20000uSTR Range
Calibrate time 20040711 114211
200000uSTR Range O
Eancs (omosrereree 1) —— Select the measurement
range to be calibrated
from the list
(____ )7 To move to the calibration
Ready execution screen 1

The figure below is an example of the 8-CH, Medium-Speed Analog Output
Module. A range is not selected.

o 5

File Wiew Help

Mociule 3 Range Ch.1 Ch2 Ch3 Ch4 Ch& ChE Ch? Cha
Serial No 120123456 10 Y Output Range: —Items to be calibrated
Callorate time Ch4 2004007107 15:27:53 You can also click to select

Ch2 20040707 192538
Ch3 20040707 19:26:03
Chd4 20040707 192625
Ch5 20040707 192653
ChE 20040707 19.29.38
Ch7 20040707 19:36:03

Ch.g 20040707 19:46:25
Chare (EX El Select the measurement

range to be calibrated
from the list

n
k3
3
¥

— To move to the calibration
Ready execution screen 1
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4.2 Calibration Procedure

3. After making the connections according to the explanation given on the calibration

execution screen 1, click the Calibrate button.

For the 8-CH Medium Speed Analog Output module, after entering settings
according to the explanation given on the calibration execution screen 1, click the
Calibrate button.

The figure below is an example of the 4-CH, High-Speed Universal Input Module.

Exp. Calibration execution screen 1
I

File View Hlp

MHTT0-URNY-HO4 (21

Explanation
Lets' start calibrating 1 ch

20 mY Range of module No.0
This range requires twa steps
First, input 0 ¥ (short)ta 1 ch
Then sslect the Calisrate button
Calibration is started

0 (short)

() () (_cairst= }—Start calibration

Ready

Return to the previous screen
Return to the Unit Information screen

The figure below is an example of the 8-CH, Medium-Speed Analog Output
Module.

Exp. Calibration execution screen 1

Edcalibrator

o

Fils View Help

Explanation
Let's start caliorating 1 ch

10 Output Range of moduls No.3.

This range requires two steps

In orcer for 0 ta bs output from 1 ch.,
adjust counter valus

When t can output 0V, select the Callbrate
btton.

Callbration is started

IIXIIIIIIIIIILN

e
M
Iel
M
1el
i
e
9]
-
1a!
I
o
M
e
jn

L)
E
=1

countervae | 2085 AW
({0t information ) a (Ceawr== H—Start calibration

Ready

Return to the previous screen
Return to the Unit Information screen

Click the Calibrate button.
The message, “Calibrating. Please wait and do not perform any other operation.” appears.
When the calibration completes successfully, the calibration execution screen 2 appears.

IM MX180-01E
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4.2 Calibration Procedure

If the calibration fails, a message “Failed to calibrate.”appears.

CETrm—
We702
Failed to calibrate.

Note

For a description of the accuracy of the connected input module, the calibration accuracy,
and the environmental conditions for calibration, see the MX100 Data Acquisition Unit User’s
Manual (IM MX100-01E).

4-8 IM MX180-01E



4.2 Calibration Procedure

4. After making the connections according to the explanation given on the calibration
execution screen 2, click the Calibrate button.

The figure below is an example of the 4-CH, High-Speed Universal Input Module.

Exp. Calibration execution screen 2

JRI=ET

File View Help

M1 O-URY-HO4 (20'm

Explanation
Mext, input 20 m to 1 ch

Then select the Caliarste buttan.
Calibration is started.

[unit information]| | moswe | [ < (__catrt=__}4— Start calibration

Ready

The figure below is an example of the 8-CH, Medium-Speed Analog Output
Module.

Exp. Calibration execution screen 2
e
File View Help

Ut Rangesnz)

Explanation
Mext, output 10Y from 1 ch
Then sslect the Calisrate button
Calibration is startedt

B .

H M
18] o
1] L]
W n
M o
M ]
W s
M ]

M
H H
H .
H ol
H ol
sl o

AL
-
—1
[ ewlalv
Unit nformation| | Module | | == ([ cotorate ) Start calibration

Ready

Click the Calibrate button.
The message, “Calibrating. Please wait and do not perform any other operation.” appears.

5. Repeat steps 1 to 4 until all calibrations are completed.
6. From the File menu, choose Write.

The calibration values are written to the input module.

Edlcalibrator
File View Help

Exit.

Note

During calibration, do not perform any other operations (especially turning the MX100 OFF or
dropping communications). Doing so may cause the MX100 main unit to stop working.

IM MX180-01E 4-9
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4.2 Calibration Procedure

Explanation

Calibrated Parameters

4-CH, High-Speed Universal Input Module (MX110-UNV-H04)

Calibration is carried out on a channel-by-channel basis.

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV 20 mV
60 mV 0mV 60 mV
200 mV 0mV 200 mV
1V oV 1V

2V oV 2V

6V oV 6V
20V oV 20V
100 V oV 100 V
RTD(1 mA)200 mV 0Q 200 Q
RTD(1 mA)600 mV 0Q 300 Q
RTD(1 mA)1 V 0Q 500 Q
RTD(2 mA)60 mV 00Q 30Q
RTD(2 mA)200 mV 00Q 100 Q
RTD(2 mA)600 mV 00 300 Q
RTD(2 mA)1 V 00 250 Q

10-CH, Medium-Speed Universal Input Module (MX110-UNV-M10)

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1V 0V on CH1 1V on CH2
2V 0V on CH1 2V on CH2
6V 0V on CH1 6V on CH2
20V 0V on CH1 20 V on CH2
100 V 0V on CH1 100 V on CH2
RTD(1 mA)60 mV 0 Q on CH3 60 Q on CH6
RTD(1 mA)200 mV 0 Q on CH3 200 Q on CH4
RTD(1 mA)600 mV 0 Qon CH3 300 Q on CH5

30-CH, Medium-Speed DCV/TC/DI Input Module (MX110-VTD-L30)

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1V 0V on CH1 1V on CH2
2V 0V on CH1 2V on CH2
6V 0V on CH1 6V on CH2
20V 0V on CH1 20 V on CH2
100 V 0V on CH1 100 V on CH2

4-10
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4.2 Calibration Procedure

6-CH, Medium-Speed Four-Wire RTD Resistance Input Module (MX110-V4R-MO06)

Measurement Range to Be Calibrated Input Value 1 Input Value 2
20 mV 0 mV on CH1 20 mV on CH2
60 mV 0 mV on CH1 60 mV on CH2
200 mV 0 mV on CH1 200 mV on CH2
1V 0V on CH1 1V on CH2
2V 0V on CH1 2V on CH2
6V 0V on CH1 6V on CH2
20V 0V on CH1 20 V on CH2
100 V 0V on CH1 100 V on CH2
RTD(1 mA)20 mV 0 Q on CH3 20 Q on CH4
RTD(1 mA)60 mV 0 Q on CH3 60 Q on CH5
RTD(1 mA)200 mV 0 Qon CH3 200 Q on CH6
RTD(1 mA)600 mV 0 Q on CH3 300 Q on CH4
RTD(0.25 mA)600 mV 0 Qon CH3 2400 Q on CH5
RTD(0.25 mA)1 V 0 Qon CH3 3000 Q on CH6

4-CH, Medium-Speed Strain Input Module (MX112-B12-M04, MX112-B35-M04,
MX112-NDI-M04)

Measurement Range to Connection 1 Connection 2
Be Calibrated (Zero Calibration) (Full Calibration)
. 120.000 Q on R1 to R3 of CH2
2000 pSTR (strain) 120.000 Q on R1 to R4 of CH2 and 117154 O on R4
. 120.000 Q on R1 to R3 of CH2
20000 pSTR (strain) 120.000 Q on R1 to R4 of CH2 and 113.010 O on R4
200000 STR (strain) 120.000 Q on R1 to R4 of CH2  120-000 @ on R1 fo R3 of CH2

and 80,000 Q on R4

Use a 4-gauge method connection when performing calibration. For information on
this connection, see section 2.4 of the MX100 Data Acquisition Unit User’s Manual (IM
MX100-01E).

8-CH, Medium-Speed Analog Output Module (MX120-VAO-MO08)
Adjust so that all channels output 0 V and 10 V. This differs from other input modules.

Range to Be Calibrated Output Value 1 Output Value 2
10V oV 10V
Nofte

For a description of the measurement range and accuracy of each input module, see
chapter 4 in the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

» For a description of the calibration procedure and wiring, see section 3.3 of the MX700 Data
Acquisition Unit User’s Manual (IM MX100-01E).

IM MX180-01E
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Chapter 5 Troubleshooting

5.1

Troubleshooting

If servicing is necessary, or if the instrument is not operating correctly after performing
the corrective actions below, contact your nearest YOKOGAWA dealer for repairs.

The 7-segment LED does not illuminate.

Message Corrective Action Reference
Page
The power switch is not ON. Turn ON the power switch. *
The supply voltage is too low. Check whether the voltage is within the supply voltage rating *
range.
The fuse is blown. Servicing required. -
The power supply is broken. Servicing required. -
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
The 7-segment LED blinks repeatedly.
Probable Cause Corrective Action Reference
Page
The power supply is shorted inside the input/ Remove the module one by one and determine which module -
output module. is broken. (Servicing required.)
The power supply is shorted inside the main Replace the main module. *
module. (Servicing required.)
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
After power up, the 7-segment LED displays something other than ,'_—,’,'_—f (when the unit number is 00).
Probable Cause Corrective Action Reference
Page
The display is b* (* is any character other than F). Turn OFF the power, remove the CF card, turn ON all dip *
The dipswitch settings are not correct. switches, and power up again. If the situation does not
change, servicing is required.
The display is bF. Powering up in setup reset mode. Turn OFF the power, turn 2-7,*
The dipswitch settings are not correct. ON all dip switches, and power up again.
Since all settings such as the IP address are initialized,
reconfiguration is necessary.
The display is F* (where * is any character). Servicing required. -
Hardware error on the main module.
The display is E* (where * is any character). The slot number is indicated by * in the n* display following the  *
Hardware error on the input/output module. E* display.
Remove the relevant module and power up again.
The relevant module must be serviced.
The display is PO. Do not manipulate the CF card while it is being accessed. *
CF card operation error.
The display is P1. Reformat the CF card or replace the CF card. 2-11,*
CF card error.
The display is P2. Check whether the CF card is inserted correctly. Then, reformat  2-11, *

CF card format error.

the CF card or replace the card.

The display is P3.
CF card insufficient free space

Delete the files on the CF card to free up some space.

The display is P4.
CF card number of files over the limit.

The number of created files exceeded the allowed amount.

Stop the recording, replace the CF card or delete files and
restart.

The display is P5.
Overwrite error in the data storage buffer.

The time needed to store the file must be reduced.

Delete unneeded data to increase the free space, or format the
CF card.

The display is C1.
Multiple TCP connections.

Turn OFF the power and reconnect.

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

IM MX180-01E
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5.1 Troubleshooting

The MX100 cannot be detected from the PC or cannot be detected with the Search button.

Message Corrective Action Reference
Page
The LINK LED does not turn ON. Replace the Ethernet cable. *
The cable is broken.
The LINK LED does not turn ON. Check the hub’s power supply. If it still does not work, replace *
There is a problem with the hub. the hub and check the hub’s operation. Also, try to connect the
MX100 using the 10-Mbps fixed mode.
The LINK LED does not turn ON. Check whether the PC can connect to the network. *
There is a problem with the PC. Replace the PC’s NIC.
The ACT LED does not turn ON. Check the hub’s power supply. If it still does not work, replace *
There is a problem in the connection between the hub and check the hub’s operation.
the hub and the MX100. Also, try to connect the MX100 using the 10-Mbps fixed mode.
The ACT LED does not turn ON. Check whether the PC can connect to the network. *
There is a problem with the PC. Replace the PC’s NIC.
There is a problem in the network configuration.  Check that the IP address, subnet mask, and default gateway = 2-7
The settings are not correct. settings of the PC correspond to the MX100 settings.
There is a problem in the network configuration. ~ Turn OFF the power to the PC and the MX100, and carry out 2-5,*
The setting changes have not taken effect. reconnection.

PC and the MX100 are not in the same segment. Connect the PC and the MX100 in the same network segment.  2-7
If the PC and the MX100 are connected as shown in the
following figure, the Search button cannot be used to detect
the MX100. However, you can make a connection manually by
specifying the IP address.

When using Windows XP or Windows Vista, check the firewall ~ 2-1, App-1
function.
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).

The MX100 is detected by clicking the Search button, but connection cannot be made.

Message Corrective Action Reference
Page
The IP address is set to the default value. Enter the correct IP address. 2-7
The default value cannot be used to make the
connection.

There is a problem in the network configuration.  Check that the IP address, subnet mask, and default gateway 2-7
settings of the PC and the MX100 settings are correct.
The PC software, main module style number, Check the release number of the PC software and the main >
and release number do not conform to the rule. module style number, then upgrade the style.
[PC software release no.] = [main module style no.]
** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).

MX100 cannot be connected using the Calibrator

Message Corrective Action Reference
Page

Attempting to make multiple connections. Exit all other software programs. -

Another software program is already connected.

The main module and input/output module style ~ Check the release number of the PC software and the main **

numbers do not conform to the rule. module style number, then upgrade the style.

[PC software release no.] = [main module style no.] 2
[input/output module style no.]
** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).
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5.1 Troubleshooting

The connected input/output module is not detected.

Message Corrective Action Reference
Page
Module connection or module startup error. Turn OFF the power. Detach the input/output module once and  *
Attached the module while the power was ON. attach it again.
The PC software, main module, and input/output  Check the release number of the PC software and the main *
module style and release numbers do not module style number, then upgrade the style.
conform to the rule. [PC software release no.] = [main module style no.] =
[input/output module style no.]
Carried out an incorrect calibration. Recalibrate. 4-4
Connecting the 10-CH, Pulse Input Module The 10-CH Pulse Input Module cannot be used with the *
(MX114-PLS-M10). MX100. Use this module with the MW100.
* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
** See the MX100 Data Acquisition Unit Operation Guide (IM MX100-02E).
Alarms are not output.
Message Corrective Action Reference
Page
There is a problem in the alarm setting. Make the alarm and numerical output (relay) settings 2-54 to 2-59
appropriate.
Both the alarm and numerical output (relay) must be set.
Current is not output from the analog output module, and no output comes from the PWM output module.
Message Corrective Action Reference
Page
External power supply required. Connect an external power supply. *
*  See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
Transmission output is not output from the analog output module, nor from the PWM output module.
Message Corrective Action Reference
Page
“Transmission output execution” not enabled. Enable it. 2-62
No output from the PWM output module
Message Corrective Action Reference
Page
The output current limit (1 A) has been Turn OFF the power. Check the load, then turn ON the power -
exceeded. Once the limit is exceeded the again.
protection circuit activates and will not recover
until you turn OFF the external power.
The fuse is blown. (4 A/module limit has been Servicing required. -
exceeded)
The CF card is not detected.
Message Corrective Action Reference
Page
There is a problem with the CF card. Replace the CF card. *

Eject and format the CF card, then insert it again.

*  See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
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5.1 Troubleshooting

The measured value is not correct.

Message Corrective Action/Description ll::;t:rence

The input wiring is not correct. Check the input wiring. *

The measured value indicates +Over or —Over. Change to an appropriate setting. *
The measurement range setting and input
range do not match.

The temperature error is large or is unstable. Change to the correct setting. *
The TC type setting and the type actually
connected are different.

The temperature error is large or is unstable. Change to the correct setting. *
The RJC setting is not correct.

The temperature error is large or is unstable. Block the wind from hitting the terminals. -
The wind is hitting the terminals.

The temperature error is large or is unstable. Suppress changes in the ambient temperature such as by -
The ambient temperature change is drastic. placing the MX100 in a box.

The temperature error is large or is unstable. Match the thickness and length of the three input wires. *
There is an error in the wiring resistance (in
the case of an RTD).

The measurement error is large or is unstable. Take measures against noise. *
Noise effects.

The measurement error is large or is unstable. Reduce the signal source resistance such as by inserting a -

Effects from the signal source resistance. converter.

The temperature error is large or is unstable. Stop parallel connections. -
Effects from parallel connections. Do not use the burnout setting.

Measured value from strain gauge type sensor When using a sensor without a remote sensing wire, use the *

not correct. DV450-001 (conversion cable).

On the strain module (-B12, -B35), the gauge Enter the correct settings. *

method dipswitch settings are not correct.

On the strain module (-B12, -B35), the gauge Use a module that supports the resistance value of the strain *

resistance and internal bridge resistance values gauge (for 120 Q, -B12, and for 350 Q, -B35.)

are different.

On the strain module, scaling corresponding to Displayed with 1 gauge method conversion. *

the gauge method is not set Set scaling appropriately depending on the gauge method.

(for 2 gauge, 4 gauge methods, the amount of

strain is doubled or quadrupled).

On the strain module (-NDI), a strain gauge type ~ When using a sensor without a remote sensing wire, use the

sensor without a remote sensing wire is being DV450-001 (conversion cable).

used.

*  See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
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5.2

Error Messages and Their Corrective Actions

Error Messages on the Integration Monitor

Error Code Message Corrective Action/Description s:;::rence
IP address is invalid. Enter the correct IP address. 2-7
Subnet mask is invalid. Enter the correct subnet mask. 2-7
Default gateway is invalid. Enter the correct gateway address. 2-7
Failed to update. Attempted to change the IP address while the connection is -
established, or the MX100 you wish to configure is connected
by another software program. Disconnect the MX100.
Search MX100s nearby again. Click the Search button again on the Connection screen, and 2-1,2-5
change the settings.
Broken modules exist. Remove the input/output modules one by one and determine *
the broken module, then replace it.
Some modules are not calibrated Recalibrate. 4-4
correctly.
Undetermined directory. The save destination of the record file cannot be found. Check  2-16
whether the save destination exists.
Write error The record file cannot be created. Check whether free space -
on the destination drive exists, whether write permissions have
been granted, whether the disk is damaged, and whetherthe
file system is corrupt.
E5102 Failed to format CompactFlash.  Check whether communication with the MX100 is being 2-7
performed.
Insert a CF card correctly. *
E5103 Invalid serial number. Please Enter the correct serial number. 1-5
reinstall the software.
E5104 Failed to create folder. The directory of the folder to create is not correct. Check the 2-16
file save destination.
E5105 Invalid folder name. Please enter Entered folder name is incorrect. Enter a correct folder name. -
a new name.
E5106 Cannot contain any of the Entered folder name includes illegal characters. Enter a correct -
following characters: folder name.
\/:,;*?"<>]CONPRNAUX
CLOCK$ NUL COM1-9 LPT1-9
E5107 Compact Flash slot is empty. Insert a CF card correctly. *
W5131 Update the display settings. The display setup is initialized according to the measurement 2-43
and computation channel settings.
W5132 Writing data files Currently. During finalization, do not close MX100 Standard. 2-51
W5133 Cancel the current settings and  Settings are discarded and the MX100 Standard is restored to ~ 2-6
create a new project? its default state.
W5134 The current channel setup Click No and change the settings of the improper channels. To  2-25 to 2-27
contains invalid use of reference  disable the channels with improper settings, click Yes.
channels.
W5135 In order to balance the strain Click No and change the settings of improper channels. To 2-25 to 2-27
channels, it's necessary for disable the channels with improper settings, click Yes.
channels to be set up correctly.
The current channel setup
contains invalid use of reference
channels.
W5136 Format Compact Flash? The CF card is formatted. 2-11
W5137 Stop Record? Data saving stops. 2-51
W5138 Module settings which do not If you click Yes, settings of modules that differ between the 2-10
match the current software MX100 module configuration and the configuration recognized
configuration will be initialized. by MX100 Standard will be initialized. To not reconfigure, click
No.
W5139 Some detected modules do Click Yes reconfigure. To not reconfigure, click No. 2-9

not match the current software
configuration. Rebuild based on
the current MX hardware setup?

* See the MX100 Data Acquisition Unit User’s Manual (IM MX100-01E).
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5.2 Error Messages and Their Corrective Actions

Error Messages on the Viewer

Error Code Message Corrective Action/Description ll::;t:rence
E0004 File write error. The file cannot be created for some reason. -
E0212 Can't read file. Target files cannot be loaded, or are deleted. 3-2
E3111 Channels of the specified Channels with the specified measurement interval do not exist ~ 3-24
recording interval do not exist. in the conversion of the data format.
Change to the correct setting.
E3114 Sampling data number is over Attempting to load a file containing 5 million or more data 3-2
the Viewer display limit of 5 M. points.
E3120 Not a data file. Target files cannot be loaded, or are damaged. 3-2
E3153 File open error. File not created because allowable number of files in the CF 3-5
card will be exceeded. Delete files to reduce the total number.
W3115 Exceeded the range of the Excel Change the range to be converted so that it is within the 3-25
sheet. Convert to Excel? allowed range of Excel.
W3116 Exceeded the range of the Change the range to be converted so that it is within the 3-25
Lotus 1-2-3 sheet. Convert to allowed range of Lotus 1-2-3
Lotus?
Error Messages on the Calibrator
Error Code Message Corrective Action/Description s:;eerence
W4700 Connection failure. Check To change the network settings such as the IP address, start 2-5
the IP Address/Host Name or the Integration Monitor.
Calibration mode. The MX100 has no Calibration mode.
W4701 Failed to write the calibrated Recalibrate. If the message is still displayed, service required.  4-4 to 4-9
value.
W4702 Failed to calibrate. Recalibrate. If the message is still displayed, service required.  4-4 to 4-9
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Appendix

Appendix 1

Windows XP SP1

Configuring/Removing the Firewall

Check the following before attempting to configure or remove a firewall.

» Check the internet connection status using the ping command. If the ping fails, check
the cables, hub, IP address settings, and other factors to determine the cause.

» Check that procedures performed on the software are correct.

If the problem cannot be solved after taking the above measures, it is likely that there will

be problems with the firewall settings. Configure or remove the firewall according to the

following procedure.

Note that the following procedure describes the MX100 Standard, but it applies to the

MX100 Calibration Software as well.

1. From the Start menu, choose Control Panel.
The control panel window appears.

ch Printers and Faxes

9) Help and Suppart.
) search

All Programs D i T

off (@] shut pown

2. Click Network Connections.
The Network Connections dialog box opens.

B Control Panel
File Edt Wiew Favortes Tooks  Help

Qo - @ - (¥ Pseach [ roer | [

acddress | B Control Panel

-E-" Control Panel G' g ﬁ'ﬁj :}9

Accessibiity  Add Hardware Add or Administrative Date and Time

g

G Swikch ko Category Wiew Options Remaov... Tools
Y B e P =
See Alsa " e
Folder Options  Fonts Game Intsrnst Keyboard
@ Windows Update Controllers  Options

&

@) Help and Support i [5m) 0
! = =

Moden ... Faxes  Language ...

S 9 § @ @A

Tasks Audio Devices Start Menu

xipuaddy

FEX
>
v B
&
|®)

Phone and  Power Options  Printers and  Regional and  Scanners and
Cameras

82

Scheduled  Soundsand  Spesch System  Taskbarand User Accounts

3. Right-click Local Area Connections and choose Properties.

The Local Area Connections Properties dialog box opens.

" Network Connections

File Edit Wiew Favorites Tools Advanced  Help

@eack = () (T Dsearch [ roders [T

fddrecs [ Network Cannections

“/| LAN or High-Speed Internet
Network Tasks &

[l create anew T
connection e

@ Disable this network J Status
device Regair

&, Repair this connection

=i Rename this connection

) View status of this Create Shortcut
connection Delsts

Change settings of this Rename
connection |

Bridge Connections
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Appendix 1 Configuring/Removing the Firewall

4. Click the Advanced tab.

General | Authentication | Advanced

Connect using:

‘ 8 Reslek ATLA133 Famiy PCI Fast Ethernet NIC |

This connection uses the fallowing items:

@

431 Fils and Printer Sharing for Micrasoft Networks
421 005 Packet Scheduler
%~ Intemet Pratacal (TCPAP)

[ nsal. | [ Uninstal | [ Froperties

Desciiption

Allows your computer to access resouces on & Micrasaft
netwark,

[ Show icon in notification area when connected

To activate the firewall settings

Local Area Connection Properties

| General | Authentication | Advanced |

Intemet Connection Firesal

Protsct my computer and network by imiting of preventing
access to this computer fiom the Intemet

Leain more about Internet Connection Firewal.

6. Click the Add button.
The Service Settings dialog box opens.

Advanced Settings [E‘El

Services | Security Logging | ICMP |

Select the services running on your network that Intemet users can
access.

Sarvices

[ Intemet Mai Access Protocol Version 3 [IMAP3]
O Internet Mail Access Pratacol Version 4 [IMAP4)
[ Intemet Mail Server (SMTF)

O Post-Oifice Protocal Version 3 (POP3)

O Remote Desktop

O Secure web Server (HTTPS)

O Telret Server

[ Web Server HTTF)

5. Select the “Internet Connection Firewall” check box and click the Settings button.
The Advanced Settings dialog box opens.

App-2
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Appendix 1 Configuring/Removing the Firewall

7. Fillin the boxes as necessary, and click the OK button.

Service Settings

Deescription of service:
‘Add-SeM:e |

Name or IP address [for example 192.168.0012] of the
computer hosting this service on your network:

Extemal Foit number for this service:

| e ouwe

Internal Port number for this service:

\ |

8. Check that the items added to the Services tab of the Advanced Settings dialog
box are displayed, then click OK.

Advanced Settings

Services I Security Logging | CMP

Select the servicas running on your network that Intsmet users can
access.

[ Intemet Mai Access Protocol Version 3 (IMAP3) >
[ Intemet Mail Access Protocol Version 4 (IMAP4] g
1 Intemet Mai Server (SMTF) )
O Postffice Protocel Version 3 POP3) =1
[0 Remote Desktop o
[0 SecureWweh Server [HTTPS] ;
O Telnet Server

O Web Server [HTTP)

[ AddService
[ Add ] [ Edt ] Delete

To deactivate the firewall settings

5. Clear the “Internet Connection Firewall” check box and click the OK button.

- Local Area Connection Properties

General | Authentication | Advanced |

Intemet Connection Firewal

[ Protect my computer and ratwork by limiting or preventing
access to this computer fiom the Intemet

Leain more about Internet Connection Firewal.
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Appendix 1 Configuring/Removing the Firewall

Windows XP SP2

From the Start menu, click Control Panel.

The control panel opens.

&2 Netwark Connections
Search H =

2 Printers and Faxes

Help and Support (e Taskbar and Start Menu

Run...

Log Off nsdoc..,

Windows XP Professiona

Turn OF Computer ..

,lf_jstart QQ@@E&

Double-click Windows firewall.

The Windows firewall dialog box appears.

| Fle Edt WView Favortes Tools Help

ntrol Panel

J'J S | ) search || Folders |

| address [T control Panel

&, Accessibiity Options

S Add Hardware

‘LyAdd or Remove Programs
8 Adinistr ative Tools

ﬂ“ Contral Panel

[ switch to Categary View

B automatic Updates
= Date and Time
See Also ES S Display
(ZFolder Opi
% windows Update GfiFolder Options
EFants

@) fielp and Support ‘& Game Contrallers

ER1ntel(R) Extreme Graphics
“Pinternet Options

&y Java Plug-in
EmKeyboard

T)Mouse

& Network Connections

%3 Netwark Setup izard

1 Phone and Modem Options
42 Power Options

. yPrinters and Faxes
Regional and Language Options
=3 Scanners and Cameras
() scheduled Tasks

W Security Center

. sigmaTel Audio

. sounds and Audio Devices
4¢ speech

4 Asystem

it Taskbar and Start Menu
8 User Accounts

i Wireless Network Setup Wizard

If Off is selected, click Cancel to exit.

If On is selected, clear the Don’t allow exceptions check box.

General | Exceptions | Advanced |

“windows Firewall helps protect your computer by preventing unauthorized users
from gaining access to your computer thiough the Irtemet o a network

@ ' On [recommended)

X

‘wihat else should | know about ‘Windows Firevall?

This setting blacks all autsids sources from cannecting ta this
camputer, with the exception of thase selected on the Exceptions tab

I~ Don't allow exceptions
Select this when you connect to public networks in less secure
Iozatiorss, such as simarts. You wil not be notified vhen ‘windows

Firewsall blocks programs. Selections on the Exceptions tab will be
ignored.

" Off (not recommended)

Avoid using this ssiting. Turning off Windaws Firewall may make this
camputer mare vuherable 1o vivses and infuders.

Cancel

App-4

IM MX180-01E



Appendix 1 Configuring/Removing the Firewall

4. Click the Exceptions tab, then click the Add Program button.
The Add program dialog box is displayed.

indows Firewall L x|

General Evcsplions | Advanced |

Windows Firewal is blocking incoming network connections, except for the
programs and services selected below. Adding exceptions allows some programs
to work better but might increase your secuity risk

Progiams and Services,

GateControl
GATEEYE

GaleMODEUS Module

Gateh/Mw/

GateW'T Madule

MLMonitorSrvr

MLMonitorSr

M, Emulatar =

Add Program. Add Port.. Edt.. Dekte |

IV Display a natffication when Windows Firewall blacks a program

‘What are the rsks of allowing exceptions?

Cancel

5. Select MX100 Standard, then click the OK button.

Add a Program x|

To allow cammuricatiorrs with a program by adding it ta the Exceptions fist,
select the program, or olick Brawse to ssarch for ane that s not listed,

xipuaddy

Programs:
oo M<100 Calibrator -]

(5, MK100 Viewer
i@ DfficeScan Client
EAOPC Client

M) Panel

) Panel

@ Pirbal

Flemote Cantroller
L Remate Moritar
%Hemule Manitor

Path: [DWEXT00 Standard MXStandaick. eve Erowse..

Change scope Cancel

6. Click the Exceptions tab. Confirm that the MX100 Standard item was added, then
select the MX100 Standard check box and click the OK button.

B i x|

General  Exeeplions | Advanced |

Windows Firewall is blacking incoming network connections, except for the
programs and sarvices selected below. Adding exceptions allows some programs
1o work befter but might increase your secuit sk

Progiams and Servicas

Name
File and Frinter Sharing

Flemote Assistance
[ Remate Desktop
I PP Framewark

Add Program Add Patt Edt | Delte |

¥ Display & notification when Windows Firswall blocks  program

‘wihat are the risks of allowing exceptions?

oK Cancel
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Appendix 1 Configuring/Removing the Firewall

Windows Vista

1. From the Start menu, choose Control Panel.
The control panel opens.

Network
Connect To

rol Panel

Default Programs

Help and Support

2. Click Allow a program through Windows Firewall.
The User account control dialog box appears.

r :.EI@

OU + Control Panel » 4] 2l
* Control Panel Home .
e System and Maintenance User Accounts
eView Get started with Windows # Add or remove user accounts

Back up your computer

= SR Appearance and

[ Iy 3 Personalization
Check for updates

Change desktop background

Check this computer's security status

Customize colors
Allow a program through Windows

Firewall Adjust sereen resolution
Network and Internet [ Clock, Language, and Region
Connect to the Intemet Ak Change keyboards or other input

TS View network status and tasks e methods

Set up file sharing 3
r Ease of Access

./ Hardware and Sound ;Etw‘"duw“ﬂges‘“m‘"gs
%‘ Play CDs or other media automatically plavize Vil spby;

Printer o y
Mouse Additional Options
= Programs
ht Uninstall a program
Change startup programs

3. Click Continue.
The Windows firewall settings dialog box is displayed.

- —
i =

n to continue

If you started this action, continue.
ﬂ Windows Firewall Settings
Microsoft Windows

User Account Control helps stop unauthorized changes to your computer,
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Appendix 1 Configuring/Removing the Firewall

4. Click the General tab.
If Off is selected, click Cancel to exit.
If On is selected, clear the Block all incoming connections check box.

@ Windows Firewall Settings =
General | Exceptions | Advanced

Windows Firewall can help prevent hackers or malicious software from gaining
access to your computer through the Internet or a network.

This setting blocks all eutside sources from connecting ta this
computer, except for those unblacked an the Exceptions tab.

[7] Block all incoming connections
Select this option when you connect to less secure networks. Al

exceptions will be ignered and you wil not be notified when
Windows Firewall blocks programs.

@ ) Off (not recommended)

Avoid using this setting. Turning off Windows Firewall will make this
computer more vulnerable to hackers or malidous software.

Tell me more about these settings

o]

Apply

5. Click the Exceptions tab, then click the Add Program button.
The Add a program dialog box is displayed.

xipuaddy

@ Windows Firewall Settings =5
General | Exceplions | Advanced

Exceptions contrel how programs communicate through Windows Firewall. Add @
program or port exception to allow communications through the frewall

Windows Firewall is currently using settings for the public network location.
What are the risks of unblocking & program?*

To enable an exception, select its check box:

Program or port &
LBITS Peercaching

[ Connect to a Network Projector

M Core Networking

[pistributed Transaction Coordinator
LJFile and Printer Sharing

[iscsl service

L[Key Management Service
[Network Discovery

[Performance Logs and Alerts
[CIRemote Admiristration

[IRemote Assistance

[JRemote Desktop

MIRcmats Euont 1 an

[ Add program... | [ Addport.. | [ Propertes | Delete

6. Select MX100 Standard, then click the OK button.

Add a Program =

Select the program you want to add, er dick Browse to find ane that is not
listed, and then dick OK.

Programs:
#ZE0MX 100 Calibrator -
. 0 Standard
&, Mx 100 Viewer
B problem Reports and Solutions
&7, windows Anytime Upgrade

[ Windows Calendar

[E]Windows Contacts

B Windows Defender

5 Windows Fax and Scan =

(&) Windows Mail

Windows Meeting Space

I

Path: D: VX100 Standard\MXStandardE. exe
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Appendix 1 Configuring/Removing the Firewall

i Windows Firewall Settings

(o

General | Exceptions | Advanced

Exceptions control how programs communicate through Windows Firewal, Add &
program or port exception to allow commurications through the firewall

Windows Firewall s currently using settings for the public network location.
What are the risks of unbloding o program?

To enable an exception, select its check box:

Program or port
[IBITS Peercaching

[ Connect to a Network Projector

[ Core Networking

[ pistributed Transaction Coordinator
[IFile and Printer Sharing —
[liscsl Service

[IKey Management Service

Omxengine exe

[Network Discovery

[drerformance Logs and Alerts

[IRemote Administration

o P

i

[Add program... | [ addport.. || Propertes | [ Dekete

[¥] Notify me when Windows Firewall blocks & new program

7. Click the Exceptions tab. Confirm that the MX100 Standard item was added, then
select the MX100 Standard check box and click the OK button.

App-8

IM MX180-01E



Index

Index

Symbols E
FOVEITANGE...ce it eeieee ettt ettt 2-33  edit ZONE ....eiiiiiie
energize....
A EQUALION .t
A/D integration time .........cccocoiiiiiiiii 240 STOTMESSAGES. ovvvwrrss oo 55
ACQUISTHION. ... 2.14 ~ Sfrormessageson the Callbratpr ; e 56
aarm... . 2.54 error messages on the In_tegrat|on Monitor........ccoecveriiennnne 5-5
alarm/mark list display .. 3.14 error messages on the Viewer...........ccccooiiiiiicciieee 5-6
alarm hysteresis ............ 256 error outpu.t .........................................................................
QIAMN TS ..o 3.14  eventfunctions
ANAI0G OULPUL. ...ttt 2-60 Z);;icr:]un?hneesrcr)cf)t:/vare v 1-8
applying data file display conditions ..... 3-17 9 INE SOMWATE.ovvvvvvsssssrrrsssvsrsss s
arithmetic functions...................co e 2-37
arrOW BULtON. ... 2-51 F
AULO ZONE.. .ot 2-47, 3-10 FAIL OUEPUL ... 2-58
file information ... 3-28
B firewall
first-order lag filter.........cooviiiiiii 2-20
BUMNOUE. oo 220 MM oo 2-11
C FUIT ZONE L 2-46, 3-10
CAlDIALION ... 44 G
CFoard o TR T OGP 1
changing the display settings ........... GrOUP NAMIES.....oeiiiiiiieiiiee et s et e e 2-45
changing the network configuration
channel color..........ocvevieiinniciies H
channel NUMDETS ..........ccoiiiiiii e HIGh 2-55
clearing the CUrSOr..........ooiiii i NOIA. .. 2-59
clipping .....oovveeiiiiiiien, NYSTEIESIS ... 2-56
compact flash information..
computation channels........... |
oo USEIS - D T MWK OO 22
connecting to an MX100 !nput mgde ..........................................................................
CONSEANTS ... e |nstallat!on """" e
CUISOTS ..ottt ettt et e e Integration Monitor.
IP address ........ooiiiiiiiiiiici e
D J
data formats..........ccooiiiii .
data formats for conversion JOINING c e 3-5
AE-ENEIGIZE. ...t
default gateway .........oooiiiiiiii L
AHIGN s left-to-right mark search...........cc.ccooieiiiiiii e, 3-15
difference iNPUL ..o loading data files..........ccooiiiiiiiin

difference input lower limit alarm....
difference input upper limit alarm
digital OUIPUL ......eiiiiiiieee e
disconnecting the MX100 ..
display groups .........cccceevveeens
displaying the monitor screen..
displaying the settings ...,
display setting file .........cccoiiiiiiii
display setup window..
display zone...

loading setup data.

IM MX180-01E

Index-1

e E



Index

M S
SAVE .ttt
saving templates..........oooiiiiiii
SCAIING ettt
SCaling SEHINGS ...cc.vviiiiiiiie e
selecting the display zone of the waveform.. .
measurement channels ............ccccoiiiiii e 2-19  Serial ID .o
measurement coNditionS ..........ccceriiiieriiii e 2-19  setthe initial balance.........cccccoooiieiiiiiii e
measurement range setting the A/D integral time....
measurement span..... setting the computation span..............
MENU...cceiiiiraiiieaanneen. setting the write mode of the CF card.
gL e =] SRR PTPRTN
module arrangement ............oooiiiiiiiee e 2-12
MONItOr.......ceeeeeeennee. 2-43
monitor interval. e 2-14
MUII-AXES ZONE ...t 3-11
MUIIAXIS ZONE......ieiieeiiiee e 2-47
starting the recording...........ccoveiii i 2-50
N starting the software v 1-8
network information ... 2-12 statist.ical computati.on """"""""""""""""""""""""""""""""""" 3-20
. stopping the recording .........ccoeiiiiiiiieeee e 2-50
new project ;
non-hold. ... ) strain gauge type SeNSOr .........coccovviiiiie i 2-28
NUMENIC CONSTANES ......oecveeeeecee e 234 SWIBMUMDET . orrvrcrirsirs s 28
NUMENIC AISPIAY..cv.veceveeeeeeeeeeeeee e 249,36  Subnetmask e e 2T
’ switching between absolute and relative time.................... 3-13
SYNChroNIZatioN..........ccooiiiiiiiii e
o syntax error...............
operators ....... system requirements
output relays
T
P tag NUMDETS.......eeiiiee e 2-21, 2-32, 2-34
PAramMEtErs .........oociiiiiii e 2-38  time constant 2-20
password time functions .. 2-38
PAUSE...coeeiiiiiiieeeeene timer.....ccocoeeeeins .. 2-33
predefined constants timer level operation .. . 2-39
PIINE e BIMIEIS e 2-39
printing setup data..........cccceiiiiiiiii 2-65  TLOG fUNCHON ..ot 2-36
printing the data....... 3-26  transmission OULPUL ..........ceiiiiiiiiiicce e 2-62
Print OPEration........ccccvviiiieei e 3-27 trip point................. ... 2-48, 3-11
project............... 2-6,2-64  troubleshOOtiNg..........coiiiiiiiiiiiiieie e 5-1
PWM OUEPUL.......ooiiiiiiiiiie e 2-61 turning transmission output ON and OFF ...................c....... 2-62
R U
reading measured/computed values ............ccccceeeeeniieene 2-52 UNIE SELUP et 2-12
reconfiguring the system ... 2-9  updating................. 2-52
TECOTd filE.. i 2-16  upper limitalarm.........cccccoceiennen. .. 2-55
record interval..........ccooiiiiiiiii e 2-14,2-15  upper limit on rate-of-change alarm............cccccccoeiiiennenn. 2-55
record start operation ...........ccccveiii i 2-50 user-defined constant............cccceeeiiieiiic e 2-31
record stop operation user-defined constants .... 2-32, 2-34
reference channel....... USET OUEPUL. ettt 2-62
reference functions..... user zone............ .. 2-46, 39
TEIAY ACK ...t USING teMPIAES .....oiiiiiiiii 3-23
release NUMDET........oi i i
\'
FESPONSE ChECK ..o 2-11 version 0.8
FEVISION NUMDET ...ttt 2-8 L T ——m—m
version information ..o 2-67
VIBWET ..ottt 1-2, 1-3, 3-1
w
waveform display.........ccoeviiiiiii 3-6
WIIE MOAE ...t 2-11
Y
Yo8XIS 1ttt 2-45, 2-46, 3-8, 3-11

Index-2

IM MX180-01E



	Terms and Conditions of the Software License
	Contents
	Chapter 1	Before Using the Software
	1.1	Functional Explanation of the MX100 Standard Software
	1.2	System Requirements
	1.3	Setup Procedures of the MX100 Standard Software
	1.4	Starting and Exiting Software Programs

	Chapter 2	Integration Monitor
	2.1	Connecting and Disconnecting the MX100
	2.2	Configuring the System, Setting the Write Mode of the CF Card, and Formatting the CF Card
	2.3	Setting the Acquisition Conditions of the Measured/Computed Data
	2.4	Setting the Measurement Conditions (Setting the Measurement Channels)
	2.5	Setting Computations (Setting the Computation Channels)
	2.6	Displaying the Monitor and Setting the Display Procedure
	2.7	Starting and Stopping the Recording of Measured/Computed Data
	2.8	Pausing the Updating of the Monitor Display and Reading Measured/Computed Values Using Cursors
	2.9	Setting Alarms and Alarm Indications
	2.10	Digital Output Settings
	2.11	Analog/PWM Output Settings
	2.12	Saving/Loading and Printing Setup Data (Project)
	2.13	Other Displays and Settings

	Chapter 3	Viewer
	3.1	Loading Data Files
	3.2	Display Settings
	3.3	Reading Values Using Cursors
	3.4	Statistical Computation over an Area of Measured/Computed Data
	3.5	Saving the Display Settings
	3.6	Saving the Display Template
	3.7	Converting Data Formats
	3.8	Printing the Data

	Chapter 4	Calibrator
	4.1	Connecting the MX100
	4.2	Calibration Procedure

	Chapter 5	Troubleshooting
	5.1	Troubleshooting
	5.2	Error Messages and Their Corrective Actions

	Appendix
	Appendix 1	Configuring/Removing the Firewall

	Index

